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V  posledních několika letech se 
v  oblasti studia kosterních nálezů  
a lidského těla, známé jako biologic-
ká antropologie, začalo formovat nové 
zaměření spojující v sobě prvky tradič-
ního zájmu o původ a rozdíly mezi lidmi  
a lidskými populacemi s metodikou využí-
vající výhradně počítačovou podporu. 
Protože se vědecký výzkum přenáší plně 
do virtuálního prostředí počítače, ustálilo 
se nazývat nově vzniklý směr virtuální 
antropologie. 

Virtuální antropologie, ačkoliv 
oblast nová a odkrývající nové možnosti, 
nevznikla bez předchozích základů. 
Navázala na bohatou tradici využití RTG 
vyšetření při výzkumu kosterních nálezů 
a mumifikovaných těl, dříve označova-
nou jako paleoradiologie. Mezi nejzná-
mější využití patří rentgenová vyšetření 
egyptských a jihoamerických mumií 
umožňující zobrazit nálezy bez nutnosti 
porušit kartonáže, obalové vrstvy nebo 
vlastní tělo mumie. Důkazy přítomnos-
ti předmětů u těla, zachovalost vnitřních 
orgánů, přítomnost nádorů a zlomenin 
nebo poškození lebky mumie mumifikač-
ními technikami jsou jen některá základní 
uplatnění radiologických metod. Význam-
nost těchto záznamových a vyšetřovacích 
postupů dokládá i skutečnost, že první 
vyšetření mumifikovaného těla proběhlo 
záhy (několik měsíců) po objevení paprsků 
X Wilhelmem Conradem Roentgenem 
v  roce 1895. V průběhu 20. století se 
klasická radiologie stala nedílnou součástí 
vyšetření kosterních nálezů, kde slouží 
k odhadu dožitého věku, diagnostice 
zranění nebo patologií kosterní soustavy  
jako jsou nádory nebo infekční onemoc-
nění. 

Formování virtuální antropolo-
gie v  poslední dekádě 20. století bylo 
výsledkem plynulého rozvoje zobrazova-
cích a informačních technologií v technicky 
a klinicky orientovaných oborech. Vývoj 
de facto reagoval na snadnější dostupnost 
a ochotu radiologických pracovišť vyšet-
řovat antropologické nálezy a především 

odrážel masivní rozmach 3D skenovacích 
technologií. Dnes představuje virtuální 
antropologie propojení záznamu lidského 
těla (povrchu těla, měkkých tkání, orgánů 
i kostí) s vizualizačními prvky 3D grafiky a 
analytickými nástroji v prostředí počítače. 
Získané 3D virtuální modely se stávají 
počítačovými replikami nálezů, které 
v reálném světě podléhají neodkladnému 
rozkladu, mohou být opotřebovány nebo 
nenávratně poškozeny manipulací, trans-
portem nebo odběrem vzorků na genetic-
kou či chemickou analýzu. V  prostředí 
počítače jsou volně ovladatelné, kombi-
novatelné a umožňují studium bez toho, 
abychom byli omezeni fyzikálními zákony. 

Ve své podstatě poskytuje virtuální 
antropologie neinvazivní a bezkontakt-
ní studium biologie člověka. Těmito 
možnostmi úzce navazuje na prapůvodní 
záměry, které vedly k formování virtuální 
reality. Snahou bylo vytvořit takové 
prostředí, jež bude kopírovat reálný svět, 
nicméně bude interaktivně ovládatelné, 
libovolně přizpůsobitelné a pozměnitelné 
podle nejaktuálnějších potřeb. Na rozdíl 
od technických a uměleckých oborů není 
pro virtuální antropologii typické, aby 
vytvářela virtuální svět úplně od základu. 
Cílem je co nejvěrněji převést konkrétní 
vlastnosti z  reálného světa do prostředí 
počítače. Virtuální antropologické objekty 
(např. lidské tělo) jsou nejčastěji virtuální-
mi replikami objektů, které již v  reálném 
světě existují, a do virtuálního světa jsou 
přesunuty pouze pro účely jejich studia. 
Záleží pak na míře věrohodnosti převodu, 
jaké vlastnosti budou ve virtuální replice 
zachovány. Dnes se technická úroveň 3D 
postupů rozvinula natolik, že dovoluje 
vytvořit virtuální repliky, které jsou na 
první pohled k nerozeznání od originální-
ho objektu. Přesnost převodu dosahuje 
obdivuhodných kvalit a nabývají přesnosti 
setin milimetru. Lze je demonstrovat 
například na záznamu detailů středouš-
ních kůstek o celkové velikosti pouze 
několika milimetrů (Obr. 1). 

Využití 3D modelů ve virtuální antropo-
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logii je podmíněno zachováním původních 
nezkreslených proporcí objektu – jeho 
morfologie. Morfologie nálezů je zazna-
menána ve formě oblaku bodů, které 
jsou vzájemně propojeny a tvoří malé 
plošky neboli polygony. Odtud pochází 
obecný název pro virtuální modely – sítě 
nebo polygonální modely. Vedle tvaru  
a velikosti je však každý objekt definován 
také texturou. Texturu je možné chápat 
jako kombinaci barevného odstínu, lesku 
a jasu povrchu studovaného objektu. 
Například při snímání povrchu lidského 
těla můžeme texturu chápat jako věrnost 
záznamu zbarvení pokožky. U virtuální-
ho polygonálního modelu tvoří textura 
digitální obrazový potah, který je nanesený 
na polygonální model. 

V  současnosti dostupné techno-
logie virtuální antropologie můžeme 
rozdělit do dvou skupin. První skupina se 
váže na radiodiagnostická a radiologic-
ká pracoviště klinického nebo technické-
ho zaměření a je přímým pokračovate-
lem již zmíněné paleoradiologie. Vůdčí 
technologií v  této oblasti je počítačová 
tomografie (CT-computed tomography). 
Tento postup nabízí možnosti zobrazit 
vedle povrchu vyšetřovaného objektu 
také vnitřní strukturu a její prostoro-
vé souvislosti. Tato skutečnost přináší 
značné výhody u vyšetření oblastí, které 

jsou skryty lidskému oku, například dutiny 
kostí, hluboké vrstvy měkkých tkání či 
ochranných obalů. Nejvýznamnější využití 
této technologie našla antropologie při 
výzkumu již zmíněných mumifikovaných 
těl. Pečlivou virtuální preparací lze oddělit 
a samostatně zobrazit zachované vrstvy 
těla – od kůže, přes kost, až po zbytky 
mozku nebo jiných vnitřních orgánů. Také 
u křehkých nálezů vyzvednutých v  bloku 
s  okolním sedimentem je možné nález 
preparovat bez toho, aby se nerozpadl. 
Postupné odkrývání vrstev měkkých tkání 
a vyšetření zachovaných tělních orgánů 
bez použití skalpelu patří do oblasti známé 
také jako virtuální pitvy neboli virtopsie, 
jež se vedle oblasti historické antropolo-
gie uplatňují také ve  forenzních vědách  
a soudním lékařství. 

Druhou skupinu technických novinek 
ve virtuální antropologii zastupují 
skenovací zařízení, kde je nosičem 
informace o morfologii objektu laserový 
nebo světelný paprsek. V  případě lasero-
vých skenerů je prioritou maximální 
přesnost záznamu. Laserový paprsek je 
vysílán ze zdroje směrem k objektu, od něj 
se odráží a na zpáteční cestě je zachycován 
čidlem. Plynulý posun paprsku po povrchu 
objektu umožňuje zaznamenat jeho 
celkový tvar. Podle typu přístroje se buď 
skenovaný objekt otáčí tak, aby paprsek 

Obr. 1. Přesnost záznamu dosahuje přesnosti setin milimetru. Na snímku jsou zobrazeny 3D virtuální modely 
nejmenších kostěných struktur lidské kostry – sluchové kůstky – kladívko (zeleně), kovadlinka (oranžově)  
a třmínek (modře) o rozměrech několika milimetrů a kostěný labyrint vnitřního ucha člověka. 
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nebo paprsky dopadaly vždy na nové 
místo na povrchu nebo v případě ručních 
skenerů lze zdrojem laserového paprsku 
pohybovat okolo fixovaného předmětu, 
na kterém jsou umístěny referenční body, 
které ukotvují polohu skeneru v prostoru. 

Na druhé straně spektra dostupných 
skenovacích zařízení najdeme optické 
skenery. Tyto přístroje pracují na principu 
fotogrammetrie a samotný záznam je 
identický s  principem digitálního fotoa-
parátu. Párová optická zařízení – dvojice 
fotoaparátů, jsou konstruována tak, aby 
zachycovala předmět v  konstantní vzdále-
nosti pod přesně stanoveným úhlem. 
Tvar povrchu objetu je rekonstruován na 
základě geometrických pravidel ze  známé 
vzdálenosti, pozice a úhlu kamer vůči 
objektu. Rychlost záznamu, která je srovna-
telná s fotografováním, a záznam textury 
snímaného objektu jsou hlavní přednost-
mi optických skenerů. Nevýhodou je pak 
relativně vysoká pořizovací cena. Pokud 
však není prioritou maximální přesnost 
záznamu nebo objekt je rozměrů, u kterých 
nehrají roli milimetrové odchylky, je možné 
drahé přístroje se složitým softwarem 
nahradit jedním fotoaparátem a vhodnou 
počítačovou aplikací. Mnohé z  nich jsou 
dnes k  dispozici také volně na internetu 
nebo jako dále upravitelné open source 
zdroje. 

Využití optických skenerů se záznamem 

vnější textury našlo uplatnění v záznamu 
tvaru objektů, u kterých má rychlost 
záznamu vyšší prioritu než celková 
přesnost výsledné digitální reprodukce. Ve 
výzkumu biologických vlastností člověka 
je to záznam obličeje nebo celého těla. 
Během několika málo sekund je zachycen 
kompletní tvar těla, což urychluje 
čas vyšetření i zátěž na vyšetřované-
ho. Nahrazuje se tím zdlouhavé tradiční 
měření antropometrickými měřidly nebo 
nutnost opakovaných návštěv pro účely 
vyšetření. Nekontaktní záznam lidského 
těla se prosazuje také v takových oblastech 
průmyslu, kde je zapotřebí přizpůsobit 
výrobek pohodlí uživatele, jako je oděvní, 
nábytkářský nebo automobilový průmysl. 

V  rutinním zpracování kosterních 
nálezů, pohřebišť i izolovaných kostí, se 
postupy virtuální antropologie uplatňují 
především při rekonstrukci a restaura-
ci fragmentárních a jinak poškozených 
kostí. Zlomky kostí jsou v tradičním pojetí 
restaurovány nanesením vrstvy lepidla 
nebo jiného pojiva mezi navazující úlomky. 
Chybějící části jsou dále doplněny sádrou 
nebo polymerem (pryskyřicí). Výsledek je 
kombinací předchozích zkušenosti restau-
rátora, jeho vizuální paměti a celkové 
zachovalosti nálezu. 

Při použití virtuálních postupů začíná 
restaurace převodem každého zlomku kosti 
do virtuálního prostoru. Poté nastupuje 

Obr. 2. Virtuální 3D modely jihoamerických mumií z muzejních sbírek Náprstkova muzea v Praze a Kriminalis-
tického ústava Praha. 
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fáze, při které jsou fragmenty skládány  
a upravovány v prostředí počítače tak, aby 
byla opětovně nastolena původní celist-
vost nálezu. Výhodou je volnost, se kterou 
lze se zlomky manipulovat. Každou z částí 
je možné libovolně přesunovat, otáčet, 
přikládat bez ohledu na její celkovou 
velikost, původní křehkost nebo zachova-
lost okolních částí. Fragmenty mohou být 
zavěšeny v prostoru, aniž by se vzájemně 
dotýkaly, nebo se mohou naopak 
překrývat, protože neprostupnost modelů 
v  počítači je pouze zdánlivá. Současně je 
možné chybějící části v  počítači domode-
lovat nebo využít zrcadlové souměrnos-
ti lidské kostry a doplnit mezery ze zacho-
vaných částí. Další inovací je možnost 
vytvářet různé scénáře pro výsledky 
restaurace. Ačkoliv se to může zdát jako 
snadná zábava, podobně jako tradiční 
restaurace může být i virtuální „skládačka“ 
poměrně pracná zkušenost, především 
pro začátečníky a nezkušené.

Výsledné restaurované nálezy jsou 
vhodným podkladem pro virtuální rekon-
strukce podoby jedince. Lebka člověka, 
virtuální i skutečná, především její 
obličejová část, je základním stavebním 
prvkem vnější podoby obličeje člověka. 
Představuje pevnou konstrukci, která 
tvoří základní podklad individuálních 
rozdílů, na který se vrství další detail-
nější a lokálnější nuance. Podobně se 
postupuje také při rekonstrukci podoby. 

Na virtuální lebku jsou modelovány vrstvy 
obličejových svalů a kůže. Doplněním 
o tvar očí, nosu, rtů a uší a zbarvením 
textury s  ohledem na známé souvislosti 
nebo historické záznamy vzniká přibližná 
podoba. Hlavní využití mají rekonstrukč-
ní postupy při rekonstrukci podoby histo-
rických osobností nebo v  kriminalistice 
při určování identity neznámých koster-
ních nálezů, kde se vytvořená podoba 
obličeje oběti, i když jen přibližná, zveřej-
ňuje v  médiích nebo v  tisku za účelem 
rozpoznání. Dalším využitím zrestauro-
vaných nálezů je převod modelu zpět do 
fyzického prostoru metodami 3D tisku 
(známé také pod názvy rapid prototyping 
nebo stereolitografie). 

 Virtuální antropologie je novým 
technologickým impulsem do studia 
zákonitostí, které člověka obklopují  
a současně se ho týkají. Využití virtuálních 
modelů tak zasahuje do mnoha oblastí 
vědy i společnosti. Virtuální modely 
usnadňují výměnu informací a poznatků 
v  oboru a přispívají k  popularizaci vědy 
v  kontaktu s laickou veřejností. Virtuální 
sbírky významných antropologických 
nálezů napomáhají chránit naše kulturní 
dědictví. A v  neposlední řadě poznatky 
získané studiem modelů odkrývají také 
nové obzory pro průmyslové, bezpečnost-
ní i zábavní využití. 

Tato publikace představuje nové trendy 
a techniky v  oblasti biologické antropo-

Obr. 3. Záznam objektů na laserovém skeneru i s pomocí počítačového tomografu.
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logie, které vycházejí a jsou vázány na 
tradiční (fotografie, rentgen) i pokročilá 
záznamová zařízení (tomografie, digitální 
rentgen, 3D laserové skenery, fotogram-
metrie). Našim cílem je čtenáře seznámit 
s  možnostmi dnes již relativně dostup-
ných postupů, přístrojů a technologií, 

ukázat široké spektrum možných aplikací, 
které přesahuje rámec biologické antro-
pologie, v našem pojetí virtuální antro-
pologie, a současně poskytnout ucelený 
návod základních obecných zákonitostí 
práce s digitálními záznamy a 3D virtuál-
ními modely. 

Obr. 4 Virtuální restaurace lebky a dolní čelisti člověka ze zachovaných úlomků kostí. 

Obr. 5 Virtuální rekonstrukce podoby egyptské mumie Hereret vytvořená ve spolupráci Laboratoře morfolo-
gie a forenzní antropologie s Katedrou počítačové grafiky a designu a Muzeem v Moravské Třebové (autorka 
rekonstrukce: Helena Lukášová) a s Univerzitou v Sao Paulo, Brazílie (autor rekonstrukce: Cícero André da 
Costa Moraes). 
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Povrchové modely

Mikoláš Jurda
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Povrchové skenování je proces 
záznamu vnější podoby reálně existu-
jících předmětů do formy digitálních 
dat, která mohou být využita pro tvorbu 
trojrozměrných modelů, zobrazitelných  
a analyzovatelných ve virtuálním prostředí 
počítače. Metody povrchového skenování 
pracují na principu fyzického kontaktu 
skeneru se snímaným předmětem nebo 
pracují se světlem odraženým od povrchu 
skenovaného předmětu. Protože se 
získaná data omezují pouze na povrch 
snímaného objektu, neobsahují žádnou 
informaci o jeho vnitřní struktuře, 
hovoříme o tzv. povrchových datech.

Výhodou povrchového skenování je 
věrné zachycení tvaru snímaného objektu 
ve vysokém rozlišení. Některé metody 
využívají digitální kamery k  záznamu 
barvy snímaného objektu a produkují 
tak modely opatřené barevnou texturou. 
Metody objemového skenování nejsou 
schopny barevnou informaci zazname-
nat! Na rozdíl od objemových metod se 
při povrchovém skenování nepoužívá 
pronikající záření, skenování tak 
nepůsobí destrukčně na strukturu kosti 
a její složení (např. uloženou DNA) a při 
dodržení bezpečnostních pokynů není 
jeho použití omezeno na živé objekty. 
Vybavení nutné pro záznam povrchových 
dat je také zpravidla finančně dostupněj-
ší než vybavení pro objemové skenování,  
a mobilnější.

1. Povrchové 3D modely 

1.1. Metody záznamu 
povrchových dat

Podle techniky záznamu rozlišujeme 
dotykové a bezdotykové skenování. 

Dotykové skenery zaznamenávají 
vnější tvar objektu na základě fyzického 
kontaktu. Součástí dotykového skeneru 
je vždy hrot (sonda), který je přikládán 
na povrch skenovaného objektu. Skener 
sleduje přesnou polohu hrotu v prostoru 
a zaznamenává ji v  podobě kartézských 
souřadnic. 

Obr. 6 Záznam 3D souřadnic bodů za pomoci dotyko-
vého digitizéru 

Povrchová data se zaznamenáva-
jí širokou škálou metod, které se zásadně 
liší v základních principech měření tvaru 
a použitých technologiích. Metody 
poskytují různou přesnost, kvalitu  
a kvantitu dat. V kontextu antropolo-
gie a přírodních věd obecně je zásadní 
rozdělení metod na metody, které jsou 
vhodné pro záznam stabilních objektům, 
a metody určené pro záznam živých, 

pohyblivých objektů. I když se tyto dvě 
kategorie technologicky výrazně překrý-
vají, jde o tak odlišné oblasti využití, že 
se jimi budeme zabývat v samostatných 
podkapitolách. Téměř všechny metody 
mohou být použity pro kvalitní nasnímání 
stabilních objektů. Základní výčet metod 
povrchového skenování a popis využitých 
principů proto uvedeme v podkapitole 
zaměřené na snímání stabilních objektů. 
Další podkapitolu pak věnujeme výhradně 
metodám, které jsou vhodné pro snímání 
živých objektů.

1.1.1. Záznam povrchu stabilních 
objektů
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Laboratoř morfologie a fyzické antro-
pologie je vybavena dotykovými skenery 
firmy MicroScribe. Tyto skenery pracující 
na principu mechanického kloubového 
ramena, které spojuje pevně ukotvenou 
základnu skeneru s  pohyblivým hrotem. 
Díky soustavě čidel v kloubech zná skener 
přesnou polohu hrotu. 

Kontaktní skenery jsou vhodné pro 
rychlý a přesný záznam trojrozměrných 
souřadnic bodů a křivek, tedy diskrétních 
prvků. Některé typy kontaktních skenerů 
umožňují věrný záznam úplné povrchové 
morfologie, zpravidla jsou však pro tyto 
účely používány bezdotykové metody 
povrchového skenování, na které se 
v dalším textu omezíme.

Bezdotykové metody (angl. contact 
free surface scanning) pracují s viditelným 
světlem odraženým od povrchu skenova-
ného objektu. Podle toho, jestli je snímání 
založeno na pasivním záznamu podoby 
předmětu, nebo na základě odrazu světla 
aktivně promítaného skenerem, rozlišuje-
me pasivní a aktivní metody záznamu 3D 
povrchových dat.  

Pasivní metodou povrchového 
skenování je fotogrammetrické modelo-
vání (nebo také blízká fotogrammetrie, 
angl. Close-range photogrammetry), při 
kterém jsou povrchová data generována 
ze série fotografií, zachycujících modelo-
vaný předmět z různých úhlů. Na principu 
fotogrammetrie pracují optické skenery, 
které jsou soustavou pevně spojených 
digitálních fotoaparátů. Modelovaný 

předmět je skenerem vyfotografován 
z více úhlů zároveň a na základě snímků je 
vytvořen jeho 3D povrchový model. Díky 
rychlosti záznamu jsou optické skenery 
vhodné k záznamu podoby živých objektů. 
Alternativou k optickým skenerům jsou 
fotogrammetrické aplikace vytvářející 
trojrozměrné modely ze snímků poříze-
ných běžnými digitálními fotoaparáty (viz 
kap. 1.6. Digitalizace stabilních objektů...). 

Aktivní povrchové skenování je 
prováděno povrchovými skenery, které 
podle principu záznamu 3D dat rozlišuje-
me na Time-of-flight skenery a triangulač-
ní skenery. 

Time-of-flight (TOF) skenery generují 
prostorová data na základě času, který 
laserový paprsek potřebuje na cestu ke 
snímanému povrchu a zpět. Vzhledem 
k poskytované přesnosti, pohybující se 
v řádu milimetrů až centimetrů, jsou TOF 
skenery využívány ke skenování objektů 
větších rozměrů, např. budov nebo arche-
ologických nalezišť. 

V  kontextu věd zabývajících se 
biologií člověka se více uplatňují skenery 
pracující na principu triangulace, které 
jsou určené pro skenování předmětů do 
velikosti ca pěti metrů a poskytují řádově 
větší přesnost. Triangulační skenery 
promítají na snímaný povrch vzor, např. 
pruh světla nebo světelnou mřížku,  
a zároveň tento povrch snímají digitální 
kamerou, umístěnou mimo osu promítání. 
Povrchová 3D data jsou generová-
na na základě deformace světelného 

Obr. 7 Povrchové 3D modely neobsahují informaci o vnitřní struktuře modelovaného objektu. Jde o jednovrs-
tvé duté schránky.
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vzoru při dopadu na skenovaný povrch. 
Podle typu využitého záření rozlišujeme 
laserové skenery a skenery se struktu-
rovaným, bílým nebo modrým, světlem. 
Laserové skenery promítají jednu či více 
linek, kterými postupně přejíždějí po 
skenovaném povrchu. Skenery se struk-
turovaným světlem promítají na celou 
oblast zorného pole snímače strukturo-
vaný obrazec, nejčastěji soustavu světlých  
a tmavých pruhů nebo mřížku, na stejném 
principu jako dataprojektory, zorné 
pole tak snímají najednou, za kratší čas 
než laserové skenery. Vysoká přesnost, 
schopnost nasnímat předměty o velikosti 
několika milimetrů a využití zdraví neohro-
žujícího světla jsou hlavními výhodyami 
skenerů se strukturovaným světlem ve 
srovnání se skenery využívajícími laser. 
Nevýhodou ve srovnání s  laserovými 
skenery je vyšší cena.

V následujících kapitolách probereme 
především dvě metody povrchového 
skenování, používané v Laboratoři morfo-
logie a forenzní antropologie, laserové 
skenery a fotogrammetrické modelování 
za použití snímků pořízených digitálními 
fotoaparáty. 

Pro záznam povrchu lidského těla 
mohou být použity všechny výše popsané 
metody. Digitalizace živých osob klade 
nároky především na rychlost záznamu 
a zdravotní nezávadnost použitých 
technologií. Pro všechny bezkontakt-
ní metody představuje problém tělesné 
ochlupení. Chlupy a vlasy jsou často pod 
rozlišovací schopnost metod a negativně 
ovlivňují výpočet morfologie v zasažených 
oblastech. Místa souvisle pokrytá ochlu-
pením, např. kštice, jsou často modelová-
na velmi přibližně nebo vůbec, za vzniku 
děr ve výsledném modelu. Také řídký 
pokryv a ojedinělé chlupy mohou být 
zdrojem artefaktů, které podstatně ovlivní 
přesnost výsledného modelu.

První modely povrchu lidského těla 

1.1.2. Záznam povrchu živých 
objektů

byly vytvářeny laserovými triangulační-
mi skenery (skener CyberWare 3030RGB/
PS Scanner – technologie patentová-
na 1985). Výhodou laserových skenerů 
je spolehlivost a přesnost záznamu. Kvůli 
dlouhému času snímání však laserové 
skenery nepředstavují příliš vhodnou 
technologii pro záznam živých osob. I když 
některé ze skenerů dokážou nasnímat 
celý povrch těla během několika sekund, 
snímání je stále příliš pomalé na to, aby 
byl úplně eliminován vznik chyb modelu v 
důsledku dýchání, mrkání a mimovolných 
pohybů probanda. Přesto byla vyvinuta 
řada laserových skenerů, určených jak 
pro snímání celého těla (např. Vitus 3D 
Body Scanner), tak různých oblastí – horní 
poloviny trupu a hlavy (např. CyberWare 
Fullhead Scanner) nebo například nohou 
(skener YETITM). 

Více se v oblasti záznamu povrchu 
těla uplatnily skenery se strukturovaným 
světlem (např. celotělový skener Mega3p 
nebo skener BodyScan 3D), jejichž 
výhodou je krátký snímací snímací čas 
(např. 0,15 s u BodyScan 3D) a zdravotní 
nezávadnost promítaného bílého světla. 
Nevýhodou skenerů se strukturovaným 
světlem je nutnost kontroly podmínek 
snímání, především osvětlení. 

Pravděpodobně nejvíce se při digita-
lizaci lidského těla uplatňují optické 
skenery, pracující na principu fotogram-
metrického zpracování snímků pořízených 
synchronizovanými fotoaparáty. Velkou 
výhodou optických skenerů je velmi 
krátký čas expozice, v řádu milisekund, 
který téměř úplně eliminuje negativní 
vliv pohybu snímané osoby na kvalitu 
výsledného modelu. Další výhodou této 
metody je velmi kvalitní záznam barev-
nosti snímaných objektů, umožňující 
tvorbu modelů opatřených fotorealistic-
kou texturou. 

Pro vytvoření trojrozměrného modelu 
musí být objekt nasnímán minimálně ze 
dvou pohledů. Nejjednodušší skenery 
sestávají ze dvou synchronizovaných 
kamer nebo z jedné kamery, snímající 
objekt zároveň z více pohledů díky 
rozdělené optické cestě. Specializova-
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né skenery, určené pro využití v oblasti 
dermatologie, poskytují velmi detailní 
záznam povrchu kůže v rozsahu nepře-
kračujícím několik centimetrů čtverečních. 
Velké množství skenerů poskytuje zorné 
pole odpovídající velikosti obličeji, nebo je 
na snímání lidského obličeje přímo desig-
nováno, včetně příslušných úprav ovláda-
cího softwaru. Vedle stolních optických 
skenerů (Vectra M1) jsou dostupné  
i vysoce mobilní systémy, poskytující flexi-
bilitu srovnatelnou s fotoaparáty (ruční 
skenery Fuel3D a Vectra H1). Skenery  
s větším zorným polem, umožňující 
polo-tělové a celo-tělové snímání, jsou 
zpravidla sestaveny z většího množství 
snímačů. Extrémem jsou v této oblasti 
soustavy desítek synchronizovaných fotoa-
parátů, umožňující nasnímat celé tělo ze 
všech stran najednou (skenovací systémy 

Ten 24 antics, DI3D). Fotogrammetrické 
zpracování snímků pořízených postupně, 
jedním digitálním fotoaparátem je pro 
snímání živých objektů nevhodné kvůli 
dlouhému času, nutnému pro nasnímání 
probanda.

Samostatnou kapitolu představují 
skenery využívající rádiové vlny a ionizu-
jící záření, tzv. TSA Scanners, umožňují-
cí záznam povrchu těla přes oblečení, bez 
přímého vizuálního kontaktu. Tyto skenery 
se uplatňují v oděvnictví a v bezpečnost-
ním průmyslu a poskytují pouze hrubé, 
málo detailní modely.

Ve výbavě Laboratoře morfologie  
a forenzní antropologie jsou dva optické 
skenery firmy Vectra (Canfield Scientific 
Inc.). Vlastnostem těchto skenerů a jejich 
praktickému použití je věnována kapitola 
1.5. Laserové triangulační skenery.
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1.2. Povrchová data – typy  
a formáty

Výstupem povrchového skenování 
jsou tzv. povrchová data, informace  
o vnější podobě skenovaného předmětu. 

Nejjednodušší formou povrchových 
dat je tzv. bodový mrak (angl. point cloud). 
Bodový mrak je množina diskrétních bodů, 
umístěných v  jednom trojrozměrném 
prostoru v přesně daných pozicích, defino-
vaných hodnotami (x,y,z) kartézských 
souřadnic. Bodový mrak je primárním 

výstupem povrchového skenování, body 
mraku jsou považovány za body povrchu 
modelovaného předmětu. 

V  nejjednodušší formě může být 
bodový mrak zaznamenán pouze jako 
seznam souřadnic, body však mohou 
být charakterizované také kvalitou, např. 
informací o barvě bodu. Bodový mrak 
může být vizualizován a použit k základním 
měřením, pro složitější analýzy a prezen-
taci se však převádí do formy polygonální 
sítě (mesh), případně NURBS modelů.

Polygonální síť (mesh) je soustavou 
jednotlivých vrcholů (bodů, vertices), 

Obr. 8 Typy povrchových dat
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hran spojujících tyto vrcholy (edges)  
a jimi vymezených plošek, polygonů (facet, 
faces). Na rozdíl od bodového mraku 
se jedná o spojitý útvar, mnohostěn, 
který má jednolitou plochu a může být 
kompletně uzavřen. Polygonální sítě mají 
oproti bodovým mrakům řadu výhod. 
Zobrazení uzavřené sítě je mnohem 
intuitivnější a více odpovídá skuteč-
nému pohledu na modelovaný objekt. 
Uzavření objektu umožňuje také složi-
tější analýzy modelu (např. rovinné řezy 
nebo měření objemu) a připojení barevné 
povrchové textury. Nevýhodou polygonál-
ních modelů je větší výpočetní náročnost 
jejich zobrazení a složitější editování, 
v porovnání s bodovými mraky.

K převodu z mraku bodů na polygonál-
ní síť (surface reconstruction, polygonizati-
on atd.) dochází zpravidla ještě v průběhu 
tvorby a editace modelu v  ovládacím 
rozhraní skeneru, případně v prostředí 
fotogrammetrických aplikací, zároveň 
však můžeme model ve většině případů 
uložit také v základní formě mraku bodů 
a polygonální síť vytvořit v  některém 
z editačních programů třetích stran.

Povrchové 3D modely mohou být 
uloženy do souborů různých formátů. 
Jednotlivé formáty se liší především 

v  informaci, kterou jsou schopny nést. 
Soubor 3D polygonální sítě zpravidla 
obsahuje informaci o 1) poloze vrcholů, 
ke kterým může být připojena např. 
informace o barvě; 2) propojení vrcholů 
hranami; 3) uspořádání polygonů,  
u kterých je specifikováno směřování rubu 
a líce (normála), případně další vlastnosti 
jako průhlednost nebo lesklost. 

V  tomto manuálu se omezíme na tři 
základní formáty obj, stl a ply. 

STL je formát určený primárně pro 
využití v  trojrozměrném tisku – STereoLi-
tografii. Soubor obsahuje pouze souřadni-
ce vrcholů polygonů a normály, neuchová-
vá žádnou informaci o barvě. Soubory stl 
mohou být typu ASCII a Binary, při ukládání 
do formátu STL aplikace zpravidla vyžadují 
specifikaci typu souboru. Soubory typu 
ASCII mají uspořádanější strukturu, ale 
jsou větší. Protože modely určené pro 3D 
tisk musejí být uzavřené, hlásí v  případě 
ukládání neuzavřených polygonálních sítí 
některé programy chybu.

OBJ je univerzální formát, který může 
být importován a exportován téměř všemi 
aplikacemi pro editaci 3D dat. Formát obj 
může obsahovat informaci o umístění 
textury na povrchu modelu, tzv. souřad-
nice textury (Texture coordinates).

Obr. 9 Textura
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PLY formát může kromě geometrie 
sítě obsahovat také informaci  
o barevnosti vrcholů a facet. Formát .ply 
může být propojen se souborem textury. 
V některých programech (např. MeshLab) 
zobrazení textury nemusí fungovat.

Textura je obrázek, uložený jako 
samostatný soubor propojený se 
souborem modelu. Při zobrazování ve 
virtuálním prostředí je tento obrázek 

„nabalen“ na virtuální model a dodává mu 
reálný, barevný vzhled. Jak jsme uvedli, 
také jednotlivé body a facety mohou být 
opatřeny informací o barvě, její detail-
nost je však omezena rozlišením polygo-
nální sítě a podoba modelu tak nedosa-
huje kvality, které je dosaženo při použití 
textury. 

Digitalizací je tvar povrchu fyzicky 
existujícího objektu převeden do digitální 
formy. Protože jde o převod kontinuálního 
signálu do podoby nespojité posloupnos-
ti celých čísel, je tento proces vždy spojen 

1.3. Rozlišení digitálních modelů

se ztrátou informace. Každý digitální 
signál je omezen svým rozlišením. Stejně 
jako jsou digitální fotografie omezeny 
počtem pixelů, je rozlišení polygonálních 
sítí omezeno počtem vrcholů a polygonů. 
V  praxi používanými mírami rozlišení 
polygonálních modelů jsou: počet vrcholů 
na jednotku plochy (podle provenience 
programu a nastavení počet vrcholů/cm2 
nebo in2) a vzdálenost vrcholů, respektive 
délka hrany polygonů. 

U modelů získaných skenováním je 
množství informace nesené modelem 
omezeno rozlišením poskytovaným 
skenovací metodou. Podle technické 
specifikace jsou skenery MicroScan  
a MicroScribe schopny generovat modely 
o velmi vysokém rozlišení v  řádu tisíců 
vrcholů na čtvereční palec. Také fotogram-
metrické aplikace jsou schopny vytvářet 
modely o velmi vysokém rozlišení. 

Rozlišení, tj. vlastnost generované 
sítě, nesmí být zaměňována s  přesností 
metody, tedy shody morfologie modelu 
se skenovaným objektem, a její citlivostí, 
schopností metody zachytit detaily.

Obr. 10 Různé úrovně rozlišení polygonální sítě nastavitelné při skenování přístrojem NextEngine v režimu 
Wide, v tis. bodů na palec čtvereční.
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Obr. 11 Různé úrovně rozlišení polygonální sítě nastavitelné při skenování přístrojem NextEngine v režimu 
Macro (facies symphysialis), v tis. bodů na palec čtvereční.

Zpravidla platí, že čím větší je počet 
vrcholů, tím detailněji reprezentuje 
model tvar reálného předmětu. Rozlišení 
polygonálních modelů může teoreticky 
narůstat do nekonečna, současně s  ním 
však narůstá také velikost souboru 3D 
dat a náročnost počítačového zpracová-
ní. Použité rozlišení je vždy kompromisem 
mezi účelem, pro který je model využíván 
a cenou, nároky kladenými na výpočetní 
vybavení. 

Podle zvolené metody může být 
rozlišení výsledného modelu ovlivněno 
zpravidla na několika úrovních, při 
snímání, na úrovni bodového mraku nebo 
při spojování skenů do jednoho modelu. 
Redukce rozlišení je také základním 
nástrojem aplikací pro editaci trojrozměr-
ných modelů (Amira – Simplify; GOMIn-
spect – Thin mesh; MeshLab – Quadratic 
Edge Collapse Decimation). 

Počet vrcholů polygonální sítě na jednotku plochy

Obr. 12 Rozlišení polygonálních modelů
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Editační aplikace nabízejí také nástroje na 
zahuštění polygonální sítě, vždy jde pouze 
o dopočítání polohy nových vrcholů na 
základě informace obsažené ve stávají-
cím modelu!

Obr. 13 Rozlišení povrchových modelů
Modely s větším rozlišením reprezentují věrněji podobu modelovaného objektu. Při redukci rozlišení dochází k 
nevratné ztrátě informace. Umělé navýšení počtu vrcholů s pomocí editačních nástrojů vede ke zhuštění poly-
gonální sítě, ale ne k rekonstrukci ztracené informace!

1.4. Postup tvorby povrchových 
modelů

Bez ohledu na použitou metodu 
může být proces tvorby 3D povrchového 
modelu rozdělen na tyto základní kroky:
1) Snímání

Prvním krokem je samotný záznam 
povrchových dat. Primárním výstupem 
může být mrak bodů nebo polygonální síť. 

Ať už objekt skenujeme laserovým 
skenerem nebo ho snímáme pro fotogram-
metrické modelování, není zpravidla 
možné zachytit celý jeho povrch najednou. 
Důvodem jsou zakryté a odvrácené části 
povrchu a oblasti, kterými se skenovaný 
objekt dotýká podložky nebo nástrojů, 
které fixují jeho polohu. 

Pro získání kompletního 360° modelu 
je tak ve většině případů nutné nasnímat 
objekt vícekrát z  různých úhlů. Výjimku 
mohou představovat povrchové reliéfy.
2) Ořezávání (Trimming) 

Druhým krokem je čištění skenů od 
nežádoucích částí, jako jsou záznamy 
bezprostředního okolí objektu, držáků, 

podložky atd. Součástí skenů mohou být 
také různé artefakty skenování, které by 
mohly mít nežádoucí vliv na kvalitu výsled-
ného modelu.

Obr. 14 Oříznutí částí skenů zachycujících rotační 
stolek, na kterém byla umístěna skenovaná pánevní 
kost.

3) Zarovnání dílčích skenů (Alignment 
v  programu NextEngine; Registration  
v programu MicroScan Tools) 

Pokud mezi záznamem jednotlivých 
dílčích skenů došlo k  reorientaci skenova-
ného objektu, např. k  jeho obrácení tak, 
aby mohly být nasnímány dříve nedostup-
né části, jednotlivé dílčí skeny na sebe 
vzájemně nesedí – nevytvářejí dojem 
jednolitého modelu. V  tomto kroku jsou 
dílčí skeny zarovnány tak, aby jejich poloha 
odpovídala povrchu skenovaného objektu. 
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4) Tvorba finální polygonální sítě (Fuse, 
Merge) 

Vyrovnané dílčí skeny vytvářejí dojem 
jednolitého modelu, stále však jde  
o samostatné, překrývající se polygonální 

Obr. 15 Zarovnání dílčích skenů – původní skeny na sebe neseděly, po zarovnání vytvářejí skeny dojem jedno-
litého modelu zubu.

sítě. Model sestavený z  překrývajících se 
sítí by prakticky nešlo dále editovat a analy-
zovat. Editační nástroje pracují většinou 
s  jednou sítí, v  místech překryvu by se 
tedy musely editovat všechny sítě zvlášť. 
Vícevrstevný model navíc obsahuje velké 
množství redundantní informace,  která 
navyšuje objem dat. Z těchto důvodů jsou 
zarovnané dílčí skeny sloučeny do jedno-
vrstevné polygonální sítě, konečného 
modelu. 

V  závislosti na použité metodě může 
v  této fázi dojít k  polygonizaci zarovna-
ných bodových mraků, spojení zarovna-
ných dílčích sítí (Fuse při použití NextEn-
gine) nebo k  převodu zarovnaných sítí 
na mrak bodů a k opětovné polygonizaci 
(MicroScan Tools).
5) Export

Aplikace ovládající skenery a fotogram-
metrické aplikace využívají k  uložení 
dat zpravidla soubory vlastních formátů 
(nelze je otevřít v  jiných aplikacích). Pro 
další použití se proto hotové 3D modely 
exportují do některého z  obecných 
formátů 3D povrchových modelů (viz kap. 
1.2. Povrchová data – typy a formáty)
6) Post-processing

Poslední fází tvorby 3D povrchové-
ho modelu je konečná úprava modelu Obr. 16 Sloučení olygonálních sítí.
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za pomoci editačních nástrojů. V  tomto 
kroku jsou využívány nástroje pro opravu 
polygonální sítě, redukci rozlišení, zápla-
tování děr nebo úpravy povrchu. Řada 
nástrojů je v nabídce samotných programů 
pro ovládání skenerů nebo fotogrammet-
rických aplikacích (potom jsou prováděny 
před exportem), zároveň je však volně 
dostupná řada editačních aplikací dat 
třetích stran. Editace 3D modelů je náplní 
kapitoly 2. Editace trojrozměrných modelů.

1.5. Triangulační 3D laserové  
skenery

3D laserové skenery jsou soustavou 
laseru, vyzařujícího pruh světla,  
a digitální kamery, která zaznamená-
vá odraz světla od povrchu skenovaného 
objektu. Kamera je umístěna mimo osu 
promítání, z jejího pohledu se tedy obraz 
pruhu mění v závislosti na tvaru povrchu, 
na který je promítán. Zdroj laseru, kamera 
a promítaný obraz tvoří pomyslný trojú-
helník. Protože vzdálenost mezi zdrojem 
a kamerou a úhel promítání jsou známy, 
mohou být na základě polohy promítané-
ho obrazu v  zorném poli snímače vypočí-
tány, triangulovány 3D souřadnice bodů 
obrazu. Triangulací většího počtu bodů na 

Obr. 17 Triangulace tvaru skenovaného povrchu lase-
rovým skenerem.

celé snímané ploše je vytvořen mrak bodů, 
základ 3D povrchového modelu. 

Ve vybavení Laboratoře morfologie  
a forenzní antropologie jsou dva laserové 
skenery, skener NextEngine a skener 
MicroScribe.

NextEngine HD je stolní laserový skener, 
umožňující vytvoření digitálních modelů 
s  plně barevnou texturou. Ovládacím 
rozhraním je nativní program ScanStu-
dio. Skener sestává ze snímače a stolku, 
na který se umísťuje skenovaný objekt. 
Vlastní snímač je nepohyblivý.  Stolek je 
polohovatelný a může být naprogramován 
tak, aby se během skenování otáčel kolem 
vertikální osy a umožnil tak nasnímání 
objektu ze všech stran. Skenování tak může 
být částečně automatizováno. V  základní 
verzi umožňuje NextEngine skenovat ve 
dvou režimech „Macro“ a „Wide“, které se 
liší jak rozlišením výsledných modelů, tak 
velikostí, které mohou skenované objekty 
dosahovat (viz kapitola 1.5.1.). 

Obr. 18 Jednoosý stolek a stolek MultiDrive
Ke skeneru můžeme připojit jednoosý stolek (pro 
režim WIDE a MACRO), otáčející se podél vertikální 
osy, a stolek „MultiDrive“ (pouze makro), který se 
může natáčet i okolo horizontální osy a nabízí tak 
větší možnosti polohování objektu v průběhu ske-
nování

Specifikace snímacích režimů skeneru 
NextEngine

rozlišení:
velikost objektu:
snímací vzdálenost:

MACRO režim WIDE režim
0,013 mm
7,6 x 12,7 cm
16,5 cm

0,38 mm
25,4 x 33 cm
43 cm
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Skener MicroScan je skenovací 
nástavec ramenového digitizéru 
MicroScribe. Na rozdíl od skeneru NextEn-
gine se během skenování ručně pohybuje 
snímačem umístěným na kloubovém 
rameni okolo snímaného objektu, jehož 
poloha je fixována. Ramenový digitizér 
poskytuje informaci o přesné poloze 
snímače, který zachycuje povrcho-
vou morfologii. Skenování nemůže být 
automatizováno a skener neumožňu-
je vytvářet texturované modely, zazna-
menává pouze tvar. Díky pohyblivému 
ramenu a malým rozměrům je však skener 
flexibilní, umožňuje skenování větších 
předmětů a ploch, které jsou pro snímač 
skeneru NextEngine špatně dostupné, 
např. vnitřního povrchu dutých předmětů.

Skener MicroScan pracuje ve dvou 
režimech Large laser a Small laser, 
vhodného pro skenování menších objektů 
a detailů, které se liší v hloubce pracovní-
ho pole.

Specifikace skeneru MicroScan
Přesnost: 0,1 – 0,3 mm
Rychlost triangulace 28 tis. vrcholů
Dva lasery pro skenování předmětů různé veli-
kosti.

1.5.1. Praktická ukázka – digitalizace lidské pánevní kosti skenerem  
NextEngine
Příprava skenování

•	 Ke skeneru připojíme otočný stolek. Lidská pánevní kost zhruba odpovídá rozměrům pro 
skenování v nastavení Wide, proto použijeme jednoosý stolek a tento režim.  

•	 Skener připojíme k počítači. 
•	 Spustíme program ScanStudio HD.

Správa souborů v programu NextEngine
Každý nový projekt (obsahující skeny jednoho objektu, záložní kopie, fotografie pro generování 
textury atp.) je ukládán pod automaticky generovaným jménem 

3D_scan_##

do složky určené v nastavení programu. Defaultně je využívána složka "… > Dokumenty > My 3D 
> …", tato složka může být změněna v nastavení programu (Edit > Preferences).

Projekt můžeme ve kterékoliv fázi uložit do námi zvoleného adresáře (File >  Save as…). Původní 
projekt zůstává uložen v nastavené složce a může být vymazán.  
S přibývajícími skeny a záložními kopiemi (vytvářenými programem před každým editačním 
krokem) narůstá velikost složky projektu o stovky Mb až gigabity!!! K úspoře místa na HDD je 
dobré projekt dotáhnout do konce v původním umístění, vymazat nepotřebné dílčí skeny a až 
na závěr archivovat definitivní podobu projektu v konečném umístění.
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•	 Ikonou Scan spustíme skenovací rozhraní.

I. Snímání

Skenovací rozhraní

•	 Do žlutého okna vepíšeme název projektu
•	 Skenovanou pánev umístíme na otočný stolek, správné umístění přitom sledujeme v náhledo-

vém okně. 
•	 Pro první snímání zvolíme vertikální orientaci kosti. Skener tak bude moci nasnímat téměř celý 

povrch pánve. Pánev je důležité upevnit tak, aby se vůči stolku nehýbala!!! Pomoci si můžeme 
držáky, které jsou ke skeneru k dispozici. 

•	 Zvolíme typ skenování
•	 Cílem je vytvořit kompletní digitální model pánevní kosti, pro první skenování tedy zvolíme režim 

skenování 360. Počet snímání, tedy počet úhlů, ze kterých bude kost nasnímána, nastavíme 
volbou Divisions. V našem případě nastavíme počet Divisions  na 13. S počtem snímání roste 
kompletnost výsledného modelu, zároveň však vzrůstá časová náročnost skenování. Počet 
Divisions tak nastavujeme v závislostech na komplexnosti skenovaného tvaru a našich časových 
možnostech.

360
Při tomto nastavení je předmět nasnímán vícekrát, z různých úhlů.
Počet úhlů, ze kterých bude předmět nasnímán, nastavujeme hodnotou 
Divisions. Např. při nastavení Divisions na 10 je předmět nasnímán z 10 
různých úhlů. Mezi jednotlivými snímáními se stolek pootočí o 36°.

Bracket
Skener nasnímá objekt třikrát, jednou v nastavené poloze a dvakrát, 
pootočený doprava a doleva o úhel daný hodnotou Divisions (360/
DIVISIONS). Volbu Bracket  můžeme využít při doskenovávání oblastí, 
které nebyly pokryty při 360 skenování.

Single
Skener nasnímá objekt jednou, v nastavené poloze. Typ Single může být 
využit podobně jako Bracket, je však méně účinný.

Positioning – automatizace skenovacího procesu
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•	 Nastavíme rozlišení skenování na 1,1 k points/inch2

Při nastavení 1,1 k points/inch2 se vždy můžeme dostat k modelu v maximálním rozlišení (viz 
následující rámeček), proto využijeme toto nastavení.

Rozlišení výsledného modelu není dáno pouze množstvím snímané informace, ale především 
různým stupněm její následné redukce. Redukce modelu je nastavena a provedena automatic-
ky podle nastaveného rozlišení skenování. Např. při nastavení rozlišení 4,4, 2,0 nebo 1,1 snímá 
skener vždy v rozlišení 4,4k/in, následně však data redukuje na nastavenou hodnotu.

Automatická redukce rozlišení

Díky tomu, že program uchovává původní, neredukovaná data, můžeme model vždy přepočí-
tat na nejvyšší rozlišení, dané kvalitou snímání (viz tabulka). K přepočtu rozlišení slouží nástroj 
Regenerate scans (Fuse > Regenerate scans... >...).

•	 Ovladači stolku nastavíme počáteční polohu pro skenování. 
Při volbě 360 vždy zkontrolujeme, jestli je kost v zorném poli kamery v průběhu celého cyklu. 
Pokud používáme volbu Bracket nebo Single, nastavíme počáteční polohu tak, aby byla jasně 
viditelná oblast, kterou chceme skenovat.

Multi-Drive

Při použití stolku Multi-Drive můžeme nastavit jak 
vertikální, tak horizontální polohu ovladači Start, 
resp. Tilt.

•	 Skenování spustíme ikonou Scan.
•	 Změníme polohu kosti na otočném stolku a 

skenování opakujeme tak, abychom pokryli 
celý povrch kosti. 
V případě pánve nebyla nasnímána spodní 
část sedací kosti, na které pánev stála  
a hřeben kosti kyčelní, který nebyl pro 
snímač viditelný. Abychom získali kompletní 
model, naskenujeme kost podruhé v poloze 
kolmé na původní polohu. Skener tak 
nasnímá kost z  jiných úhlů než při prvním 
skenování a doplní chybějící oblasti. 

•	 Pokud nám to časové možnosti dovolují, 
provedeme další skenování v režimu 360. 
V opačném případně můžeme slepá místa 
doskenovat v módu Bracket.



25

•	 V případě potřeby skenování opakujeme v jiné poloze tak, abychom zaznamenali celý povrch 
kosti.

•	 Výstup skenování můžeme prohlížet v základním okně aplikace.
Skeny z  jednoho vícenásobného skenování (režim 360 nebo Bracket) tvoří tzv. Family skenů. 
Jednotlivé Family jsou zobrazeny na dolní liště pod náhledovým oknem. První Family je umístěna 
v zeleném poli spodní lišty, každá další skenovaná Family je umístěna do modrého pole
Skeny patřící do jedné Family jsou vzájemně správně orientovány, vytvářejí dojem jednolité-
ho modelu, jde však o několik samostatných polygonálních sítí!!! (pokud bychom s pánví mezi 
jednotlivými skenováními pohnuli, skeny by k sobě nepasovaly).  
Dvojitým kliknutím LMB na miniaturu jedné z Family můžeme na dolní liště zobrazit jednotli-

vé skeny tvořící Family. Na liště pak můžeme skeny z Family oddělit (přetažením dané ikony 
do pravého, modrého pole, nebo kliknutím RMB na ikonu a volbou Detach scan), případně je 
odstranit (volbou Delete).

V některých případech může dojít k chybné orientaci v rámci 
jedné Family sítí (viz doprovodné obrázky).

Chyba může být opravena rozdělením sítí Family a jejich 
opětovným spojením.

•	 Rozevřeme Family špatně orientovaných skenů (dvojklik 
LMB na miniaturu).

•	 jednotlivé skeny v dolní liště (kromě jednoho) přetáhne-
me do modrého pole lišty, vpravo.

•	 Pomocí funkce Alignment spojíme libovolné dva skeny, 
zbytek skenů se připojí automaticky.

Možnosti obecného nastavení skenovacího procesu (Scan > Settings...)

Texture Capture Mode – umožňuje nastavení snímání 
barev na černobílý režim, (resp. stupně šedi, Monochro-
me), standardní barevný režim (RGB) nebo kvalitní 
barevný režim (Multi-Spectral)
Turn off Texture Capture – vypnutí záznamu textury
Disable Scan-time AutoAlignment - vypnutí automatické-
ho alignování dílčích skenů během skenovacího procesu.
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•	 Spustíme nástroj Trim.
•	 Zobrazíme Family, kterou chceme editovat (kliknutím LMB na příslušnou ikonu ve spodní liště).
•	 Za pomoci jednoho ze selekčních nástrojů označíme části sítě, které chceme odstranit. 
•	 Označujeme za pomoci tlačítka LMB s aktivovanou ikonou „+“ (De/Select). Stejným způsobem 

můžeme vybrané části odznačit s aktivovaným „-“.

II. Ořezávání - Trim

•	 Označené oblasti odstraníme kliknutím na ikonu Trim.
•	 Protože nepracujeme s  jednotlivými dílčími skeny, ale s  celou Family skenů, označujeme  

a odmazáváme části všech dílčích skenů, které jsou součástí dané Family. 

Automatické ořezávání – Polish > AutoTrim

Části objektu naskenované pod příliš velkým úhlem 
mohou být zdrojem nepřesností. Generované 
polygony jsou v těchto místech zpravidla větší, než je 
nastavené rozlišení a mohou být naskenovány s větší 
chybou (větší vliv triangulační chyby).
Nástroj AutoTrim dovoluje tyto polygony automatic-
ky odstranit buď na základě úhlu, který svíraly s osou 
skenování, nebo na základě jejich velikosti. 
Automatické ořezání může zvětšit přesnost modelu 
a omezit nežádoucí artefakty, zároveň však vede ke 
ztrátě dat v oblastech složitější morfologie.
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Prvním krokem je manuální, hrubé zarovnání jednotlivých Family 
na principu Three point alignment, druhým pak automatické 
dohledání optimální polohy. 
V zeleném poli spodní lišty je umístěna referenční Family. Family 
z dalších skenování jsou umístěny v modrém poli. Jde o skeny, které 
neprošly Alignment. 
Nástrojem Alignment vždy zarovnáváme neorientované Family, 
v modrém poli, na Family referenční. 

III. Zarovnání dílčích skenů – Alignment

•	 Kliknutím LMB označíme jednu z  Family skenů v  modrém poli 
spodní lišty.

•	 Spustíme nástroj Align.

•	 Na oba modely umístíme přetažením minimálně tři barevné 
kuličky tak, aby kuličky stejné barvy byly na stejných místech skenovaného objektu.

•	 Po nadefinování bodů zarovnáme rodiny skenů tlačítkem Attach Scans. 
•	 Program zarovná skeny na základě polohy tří bodů a následně automaticky hledá největší shodu. 
•	 Po zarovnání je sken přemístěn do zeleného pole spodní lišty.
•	 V některých případech program na příkaz Align nereaguje. Je potřeba odejít z nástroje Align  

a znovu jej aktivovat. Orientační body zůstanou zachovány.
•	 Příkazem Refine můžeme zopakovat fázi automatické reorientace skenů. 
•	 Mírou přesnosti zarovnání je ukazatel na horní liště. Pokud je nepřesnost vyšší než 0,005, 

doporučuje se aplikovat Refinement.
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Family dílčích skenů, které chceme sloučit, musejí být umístěny v zeleném prostoru spodní lišty, 
tj. být vzájemně správně orientovány.

Max. Iterations – nastavení počtu iterací celého 
procesu. Čím vyšší počet, tím vyšší přesnost, ale 
také časová náročnost (zvýšení počtu je ekvivalentní 
provedení Refinement).
Ignore Outlier Vertices – při výpočtu vzájemné 
polohy ignoruje polygony příliš vzdálené od průměru
Allow only small transform – tato volba omezí 
automatickou reorientaci pouze na malé posuny

    Obecná nastavení nástroje Alignment – Edit > Preferences… >  Align settings…

Nastavení mají vliv především na výpočetní náročnost celého procesu – může být ponecháno 
default nastavení.

IV. Tvorba finální sítě – Fuse

•	 Nástroj slučování polygonálních sítí spustíme ikonou Fuse.
•	 Nastavíme úroveň zjednodušení Simplify – tolerovanou odchylku od původní morfologie. 

V našem případě nastavíme zjednodušení na nulovou hodnotu tak, abychom dostali co nejde-
tailnější model. Při tomto nastavení bude mít výsledný model podobné rozlišení jako původní 
skeny.
Jednotkou zjednodušení je maximální povolená odchylka nově generované sítě od tvaru 
původních skenů. Tento algoritmus zajišťuje, že si oblasti se složitější morfologií uchovají větší 
rozlišení než oblasti s jednodušší morfologií.

V oblastech se složitější 
morfologií zůstává detail-
nější rozlišení
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•	 Proces spustíme ikonou Fuse. Výsledkem je spojení všech vzájemně se překrývajících sítí  
a vytvoření editovatelného jednovrstvého modelu. Miniatura modelu je umístěna v modrém 
poli dolní lišty. Zdrojové sítě jsou přesunuty do zeleného pole.
Celý proces Fuse můžeme spustit také přes ikonu Settings, otevřené dialogové okno nám 
zpřístupňuje některé volby jako automatické zaplňování děr nebo zvětšení rozlišení výsledného 
modelu (viz následující rámeček).

V případě aktivace jedné z prvních dvou možností 
dojde zároveň s generováním modelu také  
k zaplnění děr:
Water tight model – nově vzniklý polygonový 
model je kompletně uzavřený – větší díry jsou 
automaticky zaplněny.
Není 100% spolehlivý, v případě pánve 78 děr 
zůstalo!!! Volba vhodná pro složité objekty, které 
nechceme následně editovat.
Fill holes – můžeme specifikovat maximální 

Další možnosti nastavení funkce Fuse

Automatické zaplňování děr

rozměry děr, které budou zaplněny. Vhodné pro eliminaci malých děr.
Zaplňování děr může mít za následek vznik nechtěných artefaktů, pokud budeme model 
editovat v dalších programech, nemusíme automatické zaplňování děr využívat.

Nastavení Texture blending ovlivňuje algorit-
mus vytváření textury nového skenu. Čím 
vyšší, tím je výsledná textura jednotnější – bez 
výrazného efektu na kvalitu modelu. 
Složitější modely mají často výrazně poškoze-
nou texturu

Texture blending
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Další možnosti nastavení funkce Fuse

Resolution ratio (RR)

Volba Resolution ratio nastavuje poměr velikosti polygonů výsledného modelu k velikosti 
polygonů původních skenů. V základu je nastaveno na 0,9, tj. polygony výsledného modelu 
budou velikostí zhruba odpovídat velikosti polygonů původních modelů. V případě jemných 
předmětů, předmětů s hranami nebo tenkými stěnami je dobré snížit toto nastavení na ca 
0,2-0,4, při tomto nastavení bude mít výsledný model vyšší rozlišení než původní skeny. 
!!!Nízké hodnoty Resolution ratio při fúzování sítí o vysokém rozlišení vedou k výraznému růstu 
objemu dat a k padání aplikace!!!
Volba se částečně kryje s nastavením hodnoty Simplification, která má rozhodující vliv na 
rozlišení výsledného modelu, tj. pokud nastavíme vysokou hodnotu Simplification, budou 
modely i při nízké hodnotě RR redukované. V plné míře se nastavení Resolution ratio projeví až 
při nastavení simplifikace 0.

Vliv různého nastavení RR na rozlišení výsledného 
modelu. Skenováno při rozlišení 1,1 k/inch.

Polygonální model můžeme exportovat do dvou obecných 3D formátů – .stl a .obj (viz kap. 1.2. 
Povrchová data – typy a formáty). 
Před exportem se ujistíme, že v zeleném poli dolní lišty je zobrazen pouze definitivní model pánve, 
jednotlivé Family skenů jsou umístěny napravo, v modrém poli.

•	 Klikneme na ikonu Output 

•	 Zvolíme formát pro export

V. Export modelu
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•	 Pokud chceme dál pracovat s texturovaným modelem, zvolíme formát .obj, v případě, že nám 
jde pouze o morfologii, zvolíme jednodušší formát .stl (viz 1.2. Povrchová data – typy a formáty).

•	 Zvolíme složku pro export a model exportujeme.

Ovládacím rozhraním je nativní program MicroScan Tools. 

1.5.2. Praktická ukázka – digitalizace lidské lebky za pomoci  
povrchového skeneru MicroScan

Příprava skenování

Rozhraní programu MicroScan Tools

•	 Podle návodu připevníme snímací hlavu k  ramenovému 
digitizéru a zařízení propojíme s počítačem. 

•	 Spustíme aplikaci ScanStudio
•	 Provedeme tzv. Homing - rameno skeneru uvedeme do 

základní polohy (na obrázku) a stiskneme tlačítko na jeho 
základně. 

•	 Ikonou Connect propojíme aplikaci se  skenerem. Stav 
připojení můžeme sledovat jako Status, v dialogovém okně 
nalevo od pracovní plochy. Při správném připojení svítí 
zeleně s nápisem Ready.

•	 Pokud jsme přístroj nově sestavili, musíme provést 
kalibraci za pomoci kalibrační koule.

•	 Postup sestavení přístroje, ustavení základní poloh  
a kalibrace jsou podrobně popsány v návodu skeneru. 
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•	  V  dialogovém okně MicroScan aktivujeme jeden z režimů 
snímání. Large Laser, pro větší objekty, a Small Laser, pro 
skenování s detailnějším rozlišením. 

•	 Oba typy snímání musejí být kalibrovány zvlášť!

I. Snímání – Scan phase

•	 V  dialogovém okně Adjust nastavíme parametry snímání. Pokud laser snímače 
namíříme na povrch skenovaného předmětu, vidíme v okně Adjust obraz paprsku. 
Parametry v okně nastavíme tak, aby zobrazená čára byla tenká a nepřerušovaná.

Nastavení skenování – Adjust

Exposure – nastavuje citlivost senzoru. Nízké hodnoty 
jsou vhodné pro světlé objekty, vysoké naopak pro velmi 
tmavé objekty. 

Tolerance – nastavuje maximální šířku obrazu paprsku. 
Čím je hodnota větší, tím je senzor tolerantnější. U 
lesklých předmětů proto volíme vyšší hodnoty.

•	 Lebku umístíme v dosahu skeneru tak, aby se nemohla hýbat. Důležité je, abychom snímačem 
dosáhli pohodlně na celý povrch, který chceme skenovat. 

•	 Provedeme Homing – tj. ustavíme digitizér do základní polohy a zmáčkneme tlačítko na bázi 
digitizéru.

•	 Snímač namíříme na povrch skenovaného předmětu, pokud možno kolmo. Sledujeme obraz 
paprsku v černém okně nalevo, linka by měla být přibližně uprostřed plochy.

•	 Záznam povrchu spustíme stisknutím tlačítka na snímači. Povrch lebky snímáme pomalým, 
nepřerušovaným pohybem. Udržujeme přitom potřebnou vzdálenost od lebky. V okně aplikace 
můžeme pozorovat vytvářející se polygonální síť.
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•	 Snímání ukončíme stiskem tlačítka na snímači.
•	 Plocha nasnímaná na „jeden zátah“, dílčí sken, je označována Sweep a je ihned zobrazena v okně 

aplikace. Špatně naskenovaný Sweep můžeme odstranit tlačítkem Delete Last. 
•	 Skenem můžeme otáčet za pomoci myši při stisknutém RMB. Pro posun skeneru aktivujeme 

ikonu Move.
•	 Pokračujeme ve skenování dalších Sweep  a nasnímáme celý přístupný povrch.
•	 Změníme polohu lebky tak, abychom mohli nasnímat oblasti, které při prvním 

skenování nebyly přístupné
•	 Stisknutím ikony New Scan vytvoříme nový dílčí sken, skupinu Sweeps (zobrazí se v okně Objects 

nalevo).
•	 Provedeme Homing a přístupná povrch nasnímáme (stejně jako v předchozích krocích). 
•	 Skenování libovolně opakujeme s  různě polohovanou lebkou, dokud nenasnímáme celý její 

povrch. 
•	 Cílem skenování je získat skeny celého povrchu lebky. Je nutné, aby se jednotlivé dílčí skeny 

dostatečně překrývaly tak, aby je následně bylo možné na sebe navázat.

•	 Skenování je dobré průběžně ukládat, v názvu souboru ani v cestě nesmí být diakritika.

V okně Objects vidíme jednotlivé nasnímané skeny (tvořené jedním 
a více Sweepy).
Zaškrtnutím políčka nalevo od názvu skenu nastavujeme jeho viditel-
nost.
Kliknutím LMB na název, jednotlivé skeny aktivujeme. Aktivace je 
nutná u mnoha editačních nástrojů.
Kliknutím RMB můžeme zobrazit informace o skenu, případně změnit 
některá nastavení.

Seznam naskenovaných objektů – okno Objects
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•	 V  seznamu Objects aktivujeme sken, který chceme editovat (kliknutím 
LMB na název skenu).

•	 Spustíme nástroj pro výběr oblastí skenu – Select.

II. Ořezání

•	 Oblasti, které chceme odstranit, označíme 
obkreslením při zmáčknutém LMB. 
K  ovládání výběru slouží ikony Clear – 
zruší výběr; Invert – označí doplněk; Cut – 
odstraní označené oblasti.

•	 Vybrané části odstraníme tlačítkem Cut (případně tlačítkem Delete).
•	 Postup opakujeme u všech dílčích skenů.

•	 Spustíme nástroj Register. Současně se nalevo zobrazí okno, za pomoci kterého 
registraci ovládáme.

III. Zarovnání dílčích skenů (Register)

•	 Aktivujeme skeny, které chceme zarovnat (současná aktivace se provádí příkazem 

•	 Na každý z dvojice skenů umístíme nejméně tři body, které si odpovídají polohou. Body umísťu-
jeme kliknutím LMB. Špatně umístěné body odstraníme příkazem Clear.

•	 Po umístění bodů obě Sweeps zarovnáme kliknutím na ikonu Register.

Tvorba finální sítě ze zarovnaných dílčích sítí probíhá v programu MicroScan Tools ve třech navazu-
jících krocích, během kterých je možné data dále čistit a editovat.

Sweeps phase 
je fází dorovnání dílčích skenů, sweeps, jejich sloučení a převodu na mrak bodů. Při úpravě modelu 
využíváme ikon z nabídky Sweeps, postupujeme jimi zleva doprava.

IV. Tvorba finální sítě 

Ctrl + LMB). Primárně označený sken, červeně zabarven, si zachová svoji pozici – je referenční.
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•	 Prvním krokem je automatické dorovnání dílčích skenů. V okně Objects aktivujeme skeny, které 
chceme zarovnat a spustíme nástroj Register Objects.

•	 Nastavíme parametry zarovnání a spustíme tlačítkem Ok.

Search Range – maximální rozmezí, ve 
kterém funkce hledá odpovídající si sítě.

Iterations – počet opakování.

Area Sampling – určuje, kolik procent 
objektů je bráno při počítání vzdálenos-
ti mezi objekty. Čím méně procent, tím je 
proces rychlejší, ale zato méně přesný. 
V průběhu se zobrazují měnící se údaje  
o chybách (průměrná a maximální).

Možnosti nastavení parametrů Register

•	 Nástrojem Merge Objects provedeme sloučení skenů do jednoho 
objektu.

•	 Nástrojem Register Sweeps provedeme automatické zarovnání všech 
Sweeps tvořících model. Tento proces zlepšuje kvalitu výsledného 
modelu.

•	 Konečnou operací je převod skenu na bodový mrak za pomoci nástroje 
Generate Pointcloud.

•	 Dialogové okno umožňuje nastavit redukci modelu, tj. převést na body 
pouze část z  celkového počtu vrcholů. V  našem případě tuto volbu 
nevyužijeme.

Points phase 
je fází úpravy bodového mraku. Úpravy zahrnují odstranění odlehlých bodů, redukci počtu bodů, 
vyhlazení povrchu a nakonec převedení bodů na polygonální síť. 

•	 Spustíme nástroj Detect Noise, který slouží k  odstranění šumu, bodů ležících 
mimo hlavní bodový mrak. 

•	 V záložce Expert můžeme nastavit parametry bodů, které budou považovány za 
šum. Algoritmus funkce spočítá pro každý bod počet bodů, které se nacházejí 
v určeném poloměru (radius). Když je počet okolních bodů pod zadané číslo 
(Count), bod je považován za bod ležící mimo mimo hlavní mrak.

•	 V našem případě ponecháme nastavení nabízené programem. 
•	 Výběr bodů spustíme ikonou Ok, vybrané body odstraníme stisknutím Delete.
•	 Špatně položené body a části modelu mohou být označeny také nástrojem Select 

a následně odmazány.
•	 Dalším krokem je redukce počtu bodů za pomoci nástroje Sample, který spustíme 

příslušnou ikonou.
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•	 V  našem případě zvolíme metodu Density a nastavíme aplikaci tak, aby mezi body výsled-
ného mraku byla vzdálenost min. 0,5 mm. Nastavíme tedy hodnotu na 0,5 mm a stiskneme 
Ok. Nástroj vybere body splňující zadaný parametr (jsou zobrazeny červeně). Označené body 
odstraníme tlačítkem Delete. 

•	 Spustíme nástroj Smooth, sloužící pro vyhlazení bodového mraku. Tuto fázi v případě našeho 
modelu přeskočíme tak, abychom zachovali původní, nevyhlazený tvar.

•	 Nástroj Smooth nejprve vypočítá polynomiální povrch v místě každého bodu a následně tento 
bod na povrch projektuje, tím dojde k vyhlazení povrchu.

Nástroj nabízí dvě metody výběru bodů pro vymazání:
Density (redukce podle hustoty) – jsou ponechány pouze ty body, které se nacházejí 
blíže jiným bodům, než je zadaná vzdálenost.
Random (náhodný výběr) – aplikace náhodně vybere zadané procento bodů.

Možnosti nastavení nástroje Sample

Radius – určuje okolí, na jehož základě bude počítán polynomiální povrch. Čím vyšší je hodnota 
Radius, tím účinnější je vyhlazování a jeho časová náročnost.

Degree – určuje stupeň polynomiálního povrchu, maximum je 6. Čím je vyšší, tím více je 
zachováno detailů.

Density – odstraňuje body před vyhlazováním tak, že vzdálenost mezi každými dvěma body 
bude odpovídat alespoň určené hodnotě. Body jsou sice odstraněny, ale stále jsou 
používány k počítání polynomiálního povrchu. 

Možnosti nastavení nástroje Smooth

•	 Posledním krokem fáze Points je převod bodového mraku na polygonální síť, 
nástrojem Triangulate, který spustíme příslušnou ikonou.

•	 V dialogovém okně nastavíme Open, protože model není uzavřen. V opačném 
případě bychom využili volbu Closed.

Mesh phase
Ve fázi Mesh je upravována polygonální síť, vytvořená polygonizací bodového 
mraku. Polygonální síť můžeme vyhladit, vyplnit díry, případně redukovat její 
velikost. V  našem případě tyto kroky přeskočíme a editaci modelu dokončíme  
v některém z editačních programů třetích stran (viz kapitola 2. Editace ...)
Pro vyhlazení polygonální sítě slouží nástroj Smooth. Nástroj má podobný vliv na 
model jako stejnojmenný nástroj pro vyhlazování mraku bodů. Výhodou je, že 
můžeme za pomoci selekčních nástrojů Select specifikovat oblast modelu, která 
bude vyhlazená.

Average – vyhlazuje síť na základě zprůměrování polohy sousedících bodů. Pro každý bod je 
spočítán průměr všech okolních bodů. Parametr Weight pak určuje, do jaké míry bude bod 
do průměru posunut, při nastavení 0 zůstane v původní pozici, při nastavení 100% je pak bod 
přemístěn přímo do průměru.
Normal Orientation – síť je vyhlazena posunem každého bodu podél jeho normály. Tato metoda 
je jemnější než první.

Možnosti nastavení nástroje Smooth (Polygonal phase)
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Nástroj Decimate slouží k redukci polygonální sítě. K dispozici je redukce na počet 
vrcholů (Target Triangles), nebo na procento z celkového počtu (Percentage). Stejně 
jako u nástroje Smooth můžeme redukovat jen vybranou část modelu (Selection)

•	 Spustíme dialogové okno Exportu (File > Export…).
•	 Nastavíme umístění a požadovaný formát modelu, v našem případě .stl.
•	 Model exportujeme.

V. Export modelu do některého z obecných formátů

V  nejširším smyslu je fotogrammet-
rie (Albrecht Meydenbauer, r. 1858) obor, 
který se zabývá zpracováním informací 
nesených obrazovým záznamem, v užším 
pak rekonstrukcí trojrozměrného tvaru, 
velikosti a vzájemné polohy vyfotografo-
vaných předmětů. Příkladem nejjedno-

1.6. Digitalizace stabilních objek-
tů – fotogrammetrie

dušší fotogrammetrické operace je využití 
měřítka na snímku k  měření velikosti 
vyfotografovaných předmětů. V  tomto 
textu se budeme zabývat výhradně digitál-
ním fotogrammetrickým modelováním 
(nebo také digitální 3D fotogrammet-
rií), tj. vytvářením 3D digitálních modelů 
předmětů z fotografií pořízených digitální-
mi fotoaparáty. 

Fotogrammetrické modelování

s.
123D Catch)
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Rozvoj fotogrammetrického modelo-
vání je úzce spojen především s vývojem 
a rozšířením dostatečně výkonných 
počítačů, schopných provádět složité 
obrazové analýzy v reálném čase. Výhodou 
fotogrammetrie je její nízká finanční 
náročnost a flexibilita. Zájemcům je  
k dispozici řada bezplatných nebo cenově 
dostupných aplikací, které umožňují 
vytvořit kvalitní 3D digitální modely.  
K pořízení dostatečně kvalitních fotogra-
fií přitom postačují běžně dostupné 
digitální fotoaparáty. Za cenu řádově nižší 
v  porovnání např. s  laserovými skenery 
tak můžeme vytvořit 3D digitální modely 
pro studijní, prezentační nebo archivační 
účely. 

S využitím digitálního fotoaparátu jako 
jediného záznamového zařízení je spojena 
také řada dalších výhod fotogrammet-
rického modelování. Zpravidla platí, že 
může být modelován jakkoliv velký objekt, 
pokud může být dostatečně kvalitně 
nasnímán. Stejnými metodami může být 
vytvořen detailní model lidského zubu, 
stejně jako věrný model nálezové situace 
při terénním výzkumu. Dobrý model 
lze vytvořit s použitím několika desítek 
fotografií (podle složitosti), které mohou 
být pořízeny v řádu minut. Velkou výhodou 
spojenou s  využitím běžně dostupných 
fotoaparátů je také mobilita a nezávislost 
na zdroji elektrické energie. Při archeo-
logicko-antropologických výzkumech se 
fotogrammetrické modelování osvědčilo, 

např. jako vhodný doplněk ke klasickým 
dokumentačním metodám. Při výzkumu 
masového hrobu obětí poválečného násilí 
z  Dobronína například posloužily hrubé 
modely jednotlivých fází odkryvu hrobu 
k  lepšímu pochopení složité nálezové 
situace.

Jednou z  bezplatně dostupných 
aplikací pro automatickou tvorbu fotore-
alistických modelů z  fotografií je 123D 
Catch. Aplikace využívá tzv. Cloud compu-
tingu, výpočetně velmi náročné fotogram-
metrické výpočty neprobíhají ve vlastním 
počítači, ale na serveru provozovatele. 
V  počítači nainstalovaný program slouží 
pouze jako rozhraní pro nahrání fotogra-
fií na server, jednoduchou editaci výsled-
ného modelu a export. Pro využití aplikace 
je nutné internetové připojení. Vytvoření 
fotogrammetrického modelu za pomoci 
123D Catch aplikace bude náplní praktické 
části této kapitoly.

Bezplatnou alternativou je program 
Python Photogrammetry Toolbox (PPT), 
určený primárně pro Debian. Na rozdíl 
od 123D Catch provádí PPT výpočty 
přímo v  počítači, bez odesílání fotogra-
fií. Celá výpočetně náročná operace může 
zahltit běžný počítač až na několik hodin. 
Výsledkem není definitivní model, jako 
v případě 123D Catch, ale mrak bodů 
v prostoru, vyžadující další editaci. Všechny 
aplikace, potřebné k  dokončení modelu 
jsou volně dostupné a součástí operačního 
systému ArcheOS (GNU/Linux). 

Obr. 19. Fotogrammetrický model lidského zubu (dva projekty, ca 60 fotografií) a jedné z fází odkryvu maso-
vého hrobu v Dobroníně (7 snímků???).
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Obr. 20. Model lebky vytvořený v programu PPT GUI

123D Catch (Autodesk) 
+	 fotorealistické modely pro prezentační účely
+	 minimální časová náročnost, úplná automatizace
+	 nízké požadavky na výpočetní výkon
−	 minimální kontrola nad vytvářeným modelem – výsledkem je téměř definitivní 
                model, polygonová síť

−	 redukované rozlišení – program automaticky redukuje rozlišení fotografií na 3 Mpx
−	 zatím jako freeware program, výrobce si nárokuje práva na výsledné modely

Python Photogrammetry Toolbox (PPT GUI)
+	 větší kontrola nad výsledným modelem
+	 detailnější modely, vytvořené na základě neredukovaných fotografií
+	 zpracování v prostředí počítače – bezpečnější pro citlivá data
−	 vyšší náročnost na výpočetní výkon
−	 vyšší časová a odborná náročnost, spojená s dokončením mraku bodů a generová 
                 ním polygonální sítě

Bližší informace jsou k dispozici na stránkách 
http://www.arc-team.homelinux.com

Bezplatně dostupné aplikace pro fotogrammetrické modelování
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Správné nasnímání objektu je 
základním předpokladem kvalitního 
výsledného modelu. Porušení základ-
ních pravidel vede ke vzniku nechtěných 
artefaktů modelování, snižujících kvalitu 
výsledného modelu. Zásadní chyby ve 
vstupních snímcích mohou znemožnit 
generování modelu.

 Veškerá pravidla, probraná níže, 
vycházejí ze skutečnosti, že aplikace 
vytvářejí 3D povrchový model pouze na 
základě série snímků, zachycujících objekt 
z  různých úhlů. Jde o základní princip 
fotogrammetrického modelování, proto 
pravidla platí v  případě všech fotogram-
metrických aplikací. Konkrétní algoritmy, 

1.6.1. Zásady fotografování objektů pro fotogrammetrické modelování
používané ke generování 3D dat se však 
liší, různé aplikace jsou tak různě citlivé na 
porušení konkrétních pravidel.

Veškerý modelovaný povrch musí 
být zaznamenán na dvou a více snímcích 
pořízených z dostatečně rozdílných úhlů. 

Nedostatečné pokrytí snímky vede 
ke vzniku neúplného modelu. Malý 
úhel mezi osami fotografií zachycujících 
stejnou oblast vede k nepřesné triangula-
ci povrchových dat a k chybám v modelu.

Pro lepší kontrolu nad pokrytím 
snímaného objektu a plynulejší zpracová-
ní projektu je vhodné, aby na sebe snímky 
prostorově navazovaly. 

Algoritmy dostatečného pokrytí modelovaného objektu

Nejjednodušším způsobem nasnímání je jeden 
prstenec fotografií, doporučený úhel mezi snímky 
5-10°.  
Nevýhodou je pouze jedna rovina snímání.

Členitější objekty, zejména na straně přivrácené k 
podložce, můžeme nafotit ze dvou, výškově separo-
vaných prstenců. 

V případě rozměrnějších objektů můžeme kombi-
novat série fotek, zaměřené na dílčí části scény. 
Pokud zachováme mezi oblastmi dostatečný překryv, 
snímky budou zkombinovány do jednoho modelu. 
Pro modelování kostry byly nasnímány tři série fotek, 
zaměřené na oblast dolních končetin, pánve a horní 
části trupu. 
Pokud je mezi snímky dosta-
tečný překryv, jsou do projektu 
správně zařazeny i snímky 
detailů, pořízené z různých 
poloh. Focení proto můžeme 
zcela přizpůsobit tvaru 
modelovaného objektu, např. 
nasnímat větší množství detail-
ních snímků složitějších oblastí.
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Modelovat lze pouze objekty s  jasně 
rozlišitelnou povrchovou texturou. 
Jednobarevné a hladké povrchy nemají 
dostatečný počet rozlišitelných prvků, na 
základě kterých by mohl být generován 
jejich 3D model, mohou způsobovat chyby 
v projektu a na jejich místě vznikají díry.

Na snímané scéně během focení  
s ničím nepohybujeme.

Sebemenší změna polohy snímaných 
objektů má zásadní dopad na schopnost 
aplikací generovat 3D model. Z  tohoto 
důvodu je velmi obtížné touto metodou 
modelovat živé objekty.

Snímaný objekt musí být pevně fixován, 
pokud dojde k  jeho pohybu během 
snímání, musí se celé snímání opakovat.

Pohybujeme s fotoaparátem, ne 
s modelovaným objektem.

I když zajistíme jednotný pohyb všech 
snímaných objektů v  zorném poli fotoa-

parátu, dochází k  drobným změnám 
osvětlení, které mohou mít za následek 
chyby v  modelu. Aplikace 123D Catch 
není na porušení tohoto pravidla výrazně 
citlivá.

Osvětlení scény musí být neměnné.
Při snímání nepoužíváme blesk fotoa-

parátu, při jeho použití se totiž osvětlení 
scény mění s  pohybem fotoapará-
tu. Změny osvětlení během venkovního 
snímání mohou vést k chybám modelu.

Ze scény eliminujeme průhledné  
a lesklé předměty.

Průhledné předměty nemohou být 
fotogrammetricky modelovány, protože 
se jejich podoba se změnou úhlu pohledu 
mění. Odlesky světla od povrchu modelo-
vaných objektů jsou jednou z  největších 
překážek fotogrammetrického modelová-
ní, i drobné odlesky od povrchu objektů 
způsobují chyby ve výsledném modelu.

Opakující se motivy a symetrie scény 
mohou způsobit chybu zpracování.

Pruhy s  terči umístěné do tvaru pravi-
delného šestiúhelníku způsobily chybu 
v  orientování fotografií a poškození 
výsledného modelu.
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Pokud můžeme, fotíme v plně 
manuálním režimu, při jednotném 
nastavení expozice.

Manuální nastavení jedné hodnoty 
expozice a clony pro záznam celé série 
snímků zajistí světelnou stálost a kvalitní 
textury výsledného modelu. Při použití 
automatického režimu se expozice jednot-
livých snímků mění, např. podle jejich 
orientace vůči zdroji světla, textura výsled-
ného modelu pak může být flekatá. 

Fotíme s  co nejvyšším nastavením 
clony tak, abychom měli dobře proostře-
nou celou plochu snímků. Při vysokých 
hodnotách expozice používáme vždy 
stativ a časovou spoušť.

Všechny snímky fotíme s  jedním 
nastavením ohniskové vzdálenosti 
(nezoomujeme) a rozlišení.

Snímky dodatečně neupravujeme!!!
Editace snímků, jejich ořezávání, 

upravování barev atp., vede vždy k vážným 
poruchám modelu!

Pokud chceme model využít k měření 
reálných rozměrů, umístíme na modelo-
vanou scénu měřítko.

Fotogrammetrické modely nemají 
rozměry v  reálných jednotkách. Modely 
můžeme dodatečně naškálovat za pomoci 
známého rozměru – měřítka. 

Náplní praktické části je vytvoření fotogrammetrického modelu celého lidského zubu s použitím 
aplikace 123D Catch. V případě modelování podobných prostorových objektů je potřeba vytvořit a 
spojit více dílčích modelů, zaměřených na různé části objektu, analogicky k sestavování více dílčích 
skenů při laserovém skenování. 
Model zubu vytvoříme ze dvou dílčích projektů, jednoho zaměřeného na oblast korunky a druhého, 
modelujícího kořen zubu. Modelovací proces je představen na příkladu korunky, postup modelo-
vání kořene je totožný. Generování dílčích modelů odpovídá fázi snímání, další fáze tvorby 3D 
povrchového modelu, tj. zarovnání dílčích skenů a jejich spojení, bude provedena v  programu 
MeshLab a je součástí praktické ukázky práce v tomto programu (viz kap. 2. Editace...).

1.6.2. Praktická ukázka – vytvoření digitálního modelu lidského zubu 
v programu 123D Catch

Prvním krokem je pořízení dostatečně kvalitních snímků korunky zubu podle výše uvedených 
pravidel. Zásadní je pokrytí celého modelovaného povrchu dostatečným počtem fotografií. 

•	 Zub zafixujeme na podložku tak, aby se vůči okolí nehýbal 
•	 Jako podložku použijeme čtverečkovaný papír, který obsahuje řadu dobře rozlišitelných prvků, 

jeho využitím tak předejdeme vzniku chyb v projektu.

I. Snímání zubu

•	 K zubu umístíme měřítko
•	 Zvolíme vhodný objektiv a nastavení fotoaparátu. 

Pro snímání zubu použijeme makroobjektiv 
•	 Aplikace 123D Catch automaticky redukuje 

rozlišení zpracovávaných fotek na 3 MPx. Z tohoto 
důvodu usilujeme o to, aby byl zub nasnímán v co 
největším detailu a zabíral tak na fotografii co 
nejvíce místa. V  případě zubu umožňuje pořídit 
dostatečně detailní snímky právě makroobjektiv. 

•	 Nasnímáme zub tak, aby byla každá oblast modelovaného povrchu zachycena minimálně na 
dvou, lépe však 3-4 fotografiích. Korunka zubu má poměrně jednoduchou, nečlenitou morfo-
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logii, nafotíme ji proto metodou jednoho prstence ca 20-30 fotografií. Na členitý kořen zubu 
můžeme použít více, jinak uspořádaných snímků. 

•	 Spustíme aplikaci 123D Catch
Pro použití aplikace 123D Catch je potřeba zaregistrovat se na stránkách provozovatele (http://
www.123dapp.com/catch) a následně stáhnout a nainstalovat program do počítače. Součástí účtu 
je datové úložiště, na které se automaticky ukládají námi vytvořené modely. Díky tomuto úložišti 
můžeme naše modely prohlížet a stahovat na kterémkoliv počítači prostřednictvím webového 
prohlížeče. 

Deset z celkem 25 fotografií použitých k vytvoření modelu 
korunky. Vpravo můžeme vidět uspořádání snímků v prostoru 
do jednoho prstence. 

•	 Pro vytvoření nového modelu 
zvolíme „Create a new Capture“ 
a přihlásíme se k našemu účtu.

•	 V  prohlížeči vybereme fotogra-
fie, které chceme použít pro tvorbu modelu

•	 Výběr fotografií potvrdíme ikonou „Create project“
Do projektu můžeme přidat další snímky volbou 

„Add More Photos“, měnit výběr snímků můžeme 
po kliknutí na text „##_photos“, pod ikonou „Create 
project“.

•	 V  otevřeném dialogovém okně vyplníme základní 
údaje o projektu. Výpočet modelu spustíme jednou 
z ikon „Wait“ a „Email me“. Využijeme volbu Wait.

Wait – aplikace zůstane spuštěna, po nahrání snímků 
na server a výpočtu modelu, jehož postup můžeme 
sledovat, se model automaticky stáhne a otevře 
v rozhraní 123D Catch.

Email Me – nahrání snímků proběhne na pozadí, link 
na stažení projektu přijde v e-mailové zprávě.
Po spuštění výpočtu modelu jsou fotografie nahrány 
na server, kde je automaticky generován 3D model. 
Rychlost uploadu a výpočtu závisí na rychlosti inter-
netového připojení a složitosti projektu, zpravidla 
trvá desítky minut.
Po zpracování se ze serveru stáhne soubor obsahu-
jící model a automaticky se otevře v rozhraní 123D 
Catch. Soubor je v nativním formátu programu 123D 
Catch (koncovka .3dp) a může být otevřen pouze 
v této aplikaci. Pro použití modelu v dalších progra-
mech pro editaci a vizualizaci 3D dat je nutné model 
exportovat do některého z obecných 3D formátů.
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Manuální polohování snímků v aplikaci 123D Catch

Při bezchybném zpracování projektu jsou všechny 
snímky, které byly do programu nahrány, správně 
identifikovány a využity pro tvorbu modelu. V 
některých případech může dojít k automatickému 
vyřazení snímků nebo jejich chybnému zařazení 
do projektu. 
S prvním případem se můžeme setkat zpravidla při 
nedostatečném překryvu mezi skupinami snímků 
nebo v případě snímků, které se vymykají úhlem 
záběru nebo přiblížením. Nezařazené snímky jsou 
umístěny na spodní liště vpravo, s ikonou vykřič-
níku.
V případě špatně zařazených snímků můžeme 
na modelu pozorovat chyby v geometrii nebo 
v textuře. V případě pánevní kosti 
bylo chybou symetrické uspořádání 
pomocných terčíků, kromě porušené 
geometrie se chyba projevila typickými 

„duchy“ na textuře, dané prolnutím 
špatně orientovaných fotografií. Identi-
fikaci špatně orientovaných snímků 
umožňuje režim PhotoLock, ve kterém je 
v náhledovém okně do snímku superpo-
nován vytvořený model.

Chybně zpracované snímky mohou být přiřazeny manuální editací lícovacích bodů. Často je 
však chyba výsledkem špatné kvality snímků nebo porušením některého z pravidel. Manuální 
přiřazení snímku může vést v konečném důsledku ke zhoršení modelu.

Postup manuálního přiřazení
•	 Na nezařazený snímek klikneme RMB a zvolíme „Manually Stitch Photo“
•	 V otevřeném dialogovém okně umisťujeme na různé snímky odpovídající si body.
•	 Po editaci minimálně 4 bodů spustíme přepočet projektu kliknutím na ikonu „Submit“.

Nezařazené snímky 
jsou umístěny v 
okně vlevo, snímky 
zařazené do projektu 
jsou v pravých dvou 
oknech. Na nezařa-
zený snímek musíme 
umístit minimálně 
čtyři body, které 
zároveň identifiku-
jeme na více zařaze-
ných snímcích. 
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snímačů a je designována pro snímání 
obličeje. Kvůli zakřivení hlavy není tento 
dvoukamerový skener schopný nasnímat 
najednou kompletní povrch obličeje, 
včetně jeho okrajových částí, ale poskytuje 
jeho přesný model z jednoho pohledu. 

Vectra XT obsahuje celkem šest 
snímačů, skener má větší zorné pole  
a lépe pokrývá snímanou oblast těla. 
Design skeneru umožňuje současné 
nasnímání celé plochy obličeje, včetně uší, 
krku a ramen a rozsáhlých částí trupu.

Výhodou optických skenerů Laborato-
ře je velmi krátká délka záznamu, pohybu-
jící se v řádu milisekund. Tak krátký 
interval téměř eliminuje chyby výsledné-
ho modelu způsobené pohybem snímané 
osoby a snižuje časovou náročnost 
skenování. Použité bílé světlo nepředsta-
vuje zdravotní riziko. Výhodou optických 
skenerů je také podobnost celého procesu 

Další fází tvorby modelu zubu je zarovnání dvou dílčích modelů, modelu kořene a modelu korunky, 
a jejich spojení v jeden finální model zubu. Tyto operace jsou náplní praktické ukázky v programu 
MeshLab. 
Modely vytvořené programem 123D Catch můžeme uložit přímo v nativním formátu aplikace 
(přípona .3dp). Soubor se automaticky ukládá do adresáře, ve kterém jsou zdrojové fotografie. 
Aby bylo možné s modely pracovat v programu MeshLab.
•	 Otevřeme dialogové okno exportu File > Export Capture As…
•	 V dialogovém okně zvolíme umístění a formát .obj
Model je ve formátu .obj uložen do 4 souborů, obsahujících zvlášť 3D informaci, texturu atd. 
Abychom mohli model otevřít v dalších programech, musíme mít k dispozici všechny tyto soubory!

Opravení špatně zařazených snímků 

•	 Kliknutím LMB na miniaturu snímku 
nebo ikonu PhotoLock spustíme režim 
PhotoLock, náhled na snímek se super-
ponovaným modelem.

•	 Přepínáním mezi snímky hledáme 
špatně přiřazený snímek, tj. snímek, 
na který superponovaný model nesedí.

•	 Špatně orientovaný snímek oddělíme 
volbou RMB (na miniaturu snímku) > 

“Unstitch Photo”
•	 Oddělený snímek manuálně přiřadíme 

do projektu předchozím postupem.

1.7. Digitalizace živých osob – 
optické skenery

Optické skenery pro snímání živých 
osob jsou soustavou synchronizovaných 
fotoaparátů, které zaznamenají podobu 
těla z několika úhlů zároveň, ve vysokém 
rozlišení. Pořízené snímky jsou následně 
automaticky zpracovány fotogrammet-
rickým algoritmem. Výstupem je trojroz-
měrný model, opatřený fotorealistickou 
texturou. Skener modeluje pouze povrch, 
který je zachycen minimálně na dvou 
snímcích. Stejně jako u jiných bezkon-
taktních metod platí, že čím je úhel mezi 
snímaným povrchem a osou skenování 
menší, tím nepřesnější je výsledný model. 

Ve výbavě Laboratoře morfologie  
a forenzní antropologie jsou dva optické 
skenery firmy Canfield Inc. – Vectra M1 
a Vectra XT. Vectra M1 sestává ze dvou 
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Obr. 21. Snímání skenerem Vectra M1

s fotografováním. Snímané osoby tak 
nejsou v pro ně neobvyklé situaci. Skenery 
Vectra jsou designované pro použití 
v klinické praxi. Díky tomuto úzkému 
zaměření jsou skenery vybaveny uživa-
telsky přívětivým ovládáním a kompakt-
ním designem. Na straně druhé software 
poskytuje pouze omezené množství 
obecně použitelných editačních nástrojů. 

Další nedostatky skenerů souvisejí 
především s omezeními samotného 
fotogrammetrického algoritmu. Skenery 
nejsou schopny snímat oblast kštice  
a hustě ochlupených částí těla. Výrazné je 
také nedokonalé nasnímání tváře v oblasti 
očí, způsobené přítomností řas, obočí  
a lesklé, průhledné rohovky.

Obr. 22. Snímání skenerem Vectra XT a výsledné modely

1.7.1. Praktická ukázka – snímání obličeje skenery Vectra M1 a Vectra XT, 
analýza a editace modelů v aplikacích Face sculptor a Analysis

Náplní praktické kapitoly je digitalizace lidského obličeje skenery Vectra M1 a Vectra XT. Ovládací 
rozhraní obou skenerů jsou velmi podobná, v některých detailech jsou však přizpůsobena různým 
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možnostem obou skenerů. Uvedený postup je primárně věnován práci se skenerem Vectra XT, 
popsána jsou také specifika práce se skenerem M1.

I. Příprava skenování

Oba skenery jsou ovládány prostřednictvím aplikace Vectra. Hlavní součástí aplikace je databáze 
pacientů (probandů), do které se ukládají nasnímané modely a další, doplňující data jako údaje 
o pacientech, fotografie, editované ukázkové modely atd. Veškeré funkce skeneru a ovládacího 
rozhraní jsou přístupné prostřednictvím databáze. Funkce jsou rozděleny do tří samostatných 
modulů:

Struktura programu Vectra

Založení nového pacienta

•	 Spusťte aplikaci Vectra
•	 Klikněte na ikonu new patient
•	 Vyplňte informace o pacientovi (datum musí být ve formátu 

MM/DD/YYYY - dokud není vyplněno správně, je pole růžové)
•	 Skenovací rozhraní může být aktivováno stiskem ikony new 

capture nebo prostřednictvím karty nového pacienta open 
chart, např. pro nahrání dalších údajů a dat.

•	 Pro vyhledání již existujícího pacienta stiskněte ikonu look 
up patient, do příslušných polí zadejte údaje o pacientovi  - 
průběžné výsledky vyhledávání zobrazíte stisknutím Show 
matches. Po vyhledání pacienta spusťte skenovací rozhraní 
stiskem ikony new nebo otevřete jeho kartu příkazem open 
chart.
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II. Skenování
Po každém novém sestavení a ustavení by skenery měly být kalibrovány za pomoci přilože-
ných kalibračních desek. Chybná kalibrace může vést k nepřesnostem ve výsledných modelech. 
Podrobný návod na kalibraci je umístěn na rubu kalibračních desek.
•	 Spusťte skenovací rozhraní (např. za pomoci ikony New 

capture v kartě pacienta)
•	 Probanda ustavíme do standardizované polohy tak, aby 

byla oblast, kterou chceme nasnímat, umístěna přibližně 
uprostřed náhledových oken. Při skenování obličeje 
skeneru Vectra XT orientujeme probanda pomocí přímek 
v náhledových oknech, u Vectry M1 slouží k nastavení 
snímání dvojice sbíhavých světel, určujících ideální vzdále-
nost snímané plochy od skeneru. 

•	 Při skenování ostatních částí trupu Vectrou XT platí 
obecnější principy – oblast, kterou chceme digitalizovat, 
musí být viditelná ze všech nabízených pohledů, pokud 
možno v jejich středu. U Vectry XT můžeme náhledová 
okna přizpůsobit části těla, kterou skenujeme, za pomoci 
ikon…

Obecná pravidla snímání

Snímáme zásadně bez šperků a nalíčení
Pot, mastnota a další mohou být zdrojem lesku a způsobovat chyby ve výsledných 

modelech
Vlasy by měly být upraveny tak, aby nezakrývaly obličej, uši a krk – algoritmus není 

schopen modelovat vlasy a ojedinělé vlasy v obličeji mohou být zdrojem nechtěných 
artefaktů modelování

Polohu probandů při snímání standardizujeme - standardně se proband dívá do 
zrcátka, má zavřená ústa (jemný stisk) a neutrální výraz

Orientace probanda při snímání

Vectra M1
k ustavení probanda slouží sbíhavá bodová světla – skenovaný povrch je v ideální 
vzdálenosti od skeneru, pokud světla splývají v jeden bod.

skenování pravého poloprofilu příklad ustavení při skenování  
en-face

skenování levého poloprofilu

•	 Při správné poloze probanda stiskněte ikonu Take picture, případně tlačítko na dálkovém 
ovladači. Po nasnímání probanda se automaticky spustí proces generování modelu. Tvorbu 



49

modelu můžete zrušit příkazem discard & retake, případně 
přerušit volbou keep & retake. V druhém případě se uloží 
původní fotografie a generování modelu můžeme provést 
dodatečně.
Nově vytvořený model je automaticky uložen do karty 
pacienta a může být dále zpracován v jednom z modulů 
Sculptor a Analysis. V kartě pacienta můžeme model také 
vymazat příkazem delete, případně přesunout k jinému pacientovi příkazem move.

III. Face sculptor – odstranění nechtěných částí modelů
Modul Face sculptor umožňuje editaci vytvořeného modelu a nabízí také řadu možnosti automa-
tických analýz tvaru obličeje. Protože jsou skenery Vectra designovány pro využití v estetickém 
lékařství, obsahuje modul Sculptor řadu nástrojů simulujících výsledky vybraných kosmetických 
zásahů.

•	 V kartě pacienta označte model, se kterým chcete pracovat
•	 Model otevřete v modulu Face sculptor kliknutím na ikonu open in Sculptor 

Navigace v modulu Face sculptor

Základní ikony umožňující nastavení náhledu modelu jsou umístěny na levé straně 
aplikace

Nástroje modulu Sculptor jsou rozděleny do tří módů Contouring, Rhinoplasty a Chin augmentati-
on, mezi kterými se přepíná za pomoci ikon na horní straně náhledového okna. Nástroj Trim image 
je součástí všech tří módů, nejpřímější přístup je přes mód Contouring.
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•	 Aktivujte mód Contouring
•	 V levém panelu nástrojů aktivujte nástroj trim image 
•	 Za pomoci některého z výběrových nástrojů označte část 

modelu, kterou chcete odstranit. K dispozici jsou dva nástroje 
pro výběr sítě: rectangular tool (v některých verzích programu 
box crop nebo manual box) – výběr za pomoci rámečku); lasso 
selection – volný výběr, analogický ke kreslení. 

•	 Využít můžete také příkaz invert selection pro převrácení výběru. 
Vybrané části se označí modře.

•	 Označené části odstraňte kliknutím na ikonu fajfky, umístěnou 
pod seznamem nástrojů.

IV. Face sculptor – módy Chin augmentation a Contouring - umístění 
význačných bodů

Módy Rhinoplasty a Chin augmentation nabízejí nejširší analytické a editační možnosti. Prvním 
krokem při použití těchto módů je poloautomatické umístění sady definovaných bodů na model 
obličeje. Správné umístění bodů, odpovídající jejich definicím, je základem správného fungování 
následných analýz a nástrojů pro úpravu modelu.

•	 Kliknutím na příslušnou záložku spusťte jeden z módů

•	 Program automaticky umístí body na povrch modelu
•	 Obvykle je nutné polohu automaticky dohledaných bodů 

poupravit (přetáhnutím bodu myší se stisknutým LMB). 
Automatické umístění bodů můžete opakovat stiskem ikony 
Auto landmarks. Pokud jsou body výrazně špatně umístěny, 
můžete celou sadu bodů vymazat příkazem Delete landmarks  
a následně body umístit ručně, podle pokynů programu.

•	 Překontrolujte polohu bodů také při zobrazení bez textury. Zapnutí a vypnutí zobrazování 
textury umožňuje příslušná ikona, umístěná na horní liště programu.
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Texturovaný model Netexturovaný model

Správná poloha význačných bodů

V. Face sculptor – automatická analýza modelu (nástroje Assessments)
Nástroje Assessments nabízejí možnost různých vizuálních, metrických a proporčních analýz 
modelu. Nástroje jsou rozděleny do tří módů Rhinoplasty, Chin augmentation a Contouring podle 
toho, pro jaké procedury jsou nejvíce informativní. Nástroje v jednotlivých módech se částečně 
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překrývají, největší množství nástrojů je přístupných v módech Rhinoplasty a Chin augmentation.

•	 Aktivujte příslušný mód
•	 Rozbalte nabídku Assessments kliknutím na stejnojmennou ikonu, zvolte některý z nástrojů

Reflection – zobrazí stranově obrácený obličej

Horizontal proportions - zobrazí výškové proporce dolního (menton - subnasale)  
a středního (subnasale - radix) segmentu obličeje

Vertical proportions – zobrazí proporce levého a pravého laterálního segmentu obličeje 
(laterální canthus - mediální canthus) a mediální části obličeje (vzdálenost obou bodů 
canthus), rovněž měří vzdálenost mezi body alare

Tip projection – zobrazí proporce nosu - projekce/délka hřbetu (vzdálenost špička nosu 
- radix)

Columella-labial angle – úhel labrale superius – subnasale – collumella

Nasofrontal angle – úhel mezi hřbetem nosu a spodní částí čela (úhel mezi špičkou nosu 
– radix – glabella)

Nasofacial angle – úhel mezi hřbetem nosu a obličejem (úhel mezi přímkami pogonion 
- glabella a špička nosu - radix)

Nasomental angle – úhel definovaný body pogonion – špička nosu – radix, zobrazena 
je také horizontální vzdálenost přímky pogonion – špička nosu od labrale superius  
a inferius

Tip deviation – odchylka špičky nosu od střední roviny

Dorsal height – prominence hřbetu nosu nad linii špička nosu –  radix

Mód contouring
Brown spots – zobrazí pouze hnědé barvy textury (poškození od slunce, melasma)

Red areas - zobrazí pouze červené barvy textury

Red/Brown – kombinace obou předchozích nástrojů

Správná poloha význačných bodů

VI. Face sculptor – editace modelu
Modul Face sculptor nabízí nástroje pro základní editaci tvaru vygenerovaného modelu a jeho 
textury. Tyto nástroje jsou dobrým prostředkem pro editaci modelu při zachování detailní textury. 
Editování texturovaných modelů s použitím aplikací třetích stran je náročné a může vést ke ztrátě 
a poškození textury.
Editační nástroje jsou dostupné v jednotlivých módech v levém menu, pod záložkou se jménem 
aktivovaného módu. 
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V módech Rhinoplasty a Chin augmentation jsou přístupné především nástroje umožňující předde-
finované změny tvaru obličeje např. zúžení a rozšíření nosu nebo konkrétní změnu tvaru brady. 
Tyto nástroje byly navrženy pro snadnou vizua-
lizaci chirurgických zákroků. Většina nástrojů se 
ovládá stejně.

•	 Aktivujte příslušný mód
•	 V menu v levé části obrazovky zvolte 

nástroj (např. Rhinoplasty > Dorsal height)

•	 Jezdcem v levé dolní části obrazovky nastavte tvarovou změnu

Dorsal height - minimální hodnota Dorsal height - maximální hodnota

Výjimkou jsou nástroje Free hand tool a Profile warp tool a Warp, které dovolují volně editovat 
profil obličeje.

Mód Contouring nabízí obecnější editační nástroje, které mohou být využity pro volnou remodela-
ci polygonální sítě modelu, odstranění artefaktů skenování nebo úpravu textury. Nástroj Resurface 
slouží k vyhlazení (zastření) textury. Nástroj se používá analogicky ke kreslení, kdy se při stisknu-
tém LMB edituje oblast v místě kurzoru.

Resurface – před Resurface – po

Nástroj Resurface přibližuje texturu editované oblasti přirozenému zbarvení kůže, nástroj se 
používá stejně jako nástroj Contouring.

Nástroj Wrinkle přenáší barvu z jednoho místa modelu na druhé (nástroj je analogický nástroji 
razítko v grafických programech), umožňuje podstatné změny barvy modelu, např. odstranění 
tetování.
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•	 Aktivujte nástroj Wrinkle
•	 Za pomoci kurzoru označte oblast, která bude zdrojem textury (např. oblast kůže bez vad)
•	 Při stisknutém LMB přeneste barvu textury na cílovou oblast

Wrinkle – před Wrinkle – po

Nástroj sculpt umožňuje editovat tvar polygonální sítě. V závislosti na nastavení vtlačuje nebo 
vytahuje povrch modelu nebo model v místě editace vyhlazuje. 

•	 Zvolte funkci nástroje sculpt
•	 Tvar modelu editujeme tahem kurzoru 

po povrchu modelu při stisknutém LMB 
nebo opakovaným klikáním pro postupné 
změny (při editování tvaru je dobré 
nastavit netexturované zobrazení)

Sculpt – původní model Sculpt – výsledek editace

Alternativou k nástroji sculpt jsou samostatné nástroje pro změnu objemu modelu (warp, inflate/
deflate a smooth), jejichž ikony jsou umístěné pod nástrojem sculpt.

Nástroj Warp slouží pro volnou modelaci označených oblastí polygonální-
ho modelu.

•	 Aktivujte nástroj Warp
•	 Při stisknutém LMB obtáhněte kurzorem oblast, kterou chcete editovat
•	 Při stisknutém LMB modelujte vyznačený povrch

Warp – původní model s označenou oblastí 
editování

Warp – výsledek vytáhnutí označené oblasti 
modelu
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Podobnou funkci má nástroj inflate/deflate. V případě 
nástroje inflate/deflate se oblast modelu vybraná v 
prvním kroku needituje ručně, ale za pomoci jezdce 
v levé dolní části obrazovky (podobně jako v případě 
nástrojů módů Rhinoplasty a Chin augmentation). 
Stejně se používá nástroj smooth, v případě kterého 
se za pomoci jezdce nastavuje požadovaná úroveň 
vyhlazení označené oblasti.

VII. Face sculptor – zobrazení výsledku editace
Program nabízí čtyři možnosti, jak vizualizovat rozdíly mezi původním modelem (označen jako 

„preop“) a výsledkem editace (označen jako „sim.1“) a také rozdíly mezi jednotlivými modely, 
uloženými v kartě pacienta. Nástroje jsou přístupné přes nabídku View results ve všech třech 
módech.
Při jednotlivých zobrazeních se mezi porovnávanými modely přepíná v dolní části náhledového 
okna.

VIII. Uložení výsledného modelu do karty pacienta
Editovaný model můžeme uložit do karty pacienta

•	 Kliknutím na ikonu diskety v levém horním rohu programu otevřete dialogové okno pro uložení 
modelu
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•	 V dialogovém okně označte možnost Current simulation surface (můžete změnit jméno modelu)
•	 Stiskněte save

IX. Modul Analysis – export modelu do obecného formátu 3D grafiky
Program Vectra uchovává všechny modely v nativním formátu aplikace (soubory s příponou .tom). 
Modely mohou být exportovány do některého z obecných formátů 3D grafiky za pomoci exportní-
ho nástroje modulu Analysis.

•	 Model, který chcete exportovat, označte v kartě pacienta
•	 Kliknutím na ikonu open in Analysis model otevřete v modulu 

Analysis 
•	 Příkazem File > Export otevřete dialogové okno nástroje pro export 

modelu
•	 Nastavte umístění souboru, jméno a požadovaný formát (pole Files 

of type) a model exportujte příkazem Save
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Modely vytvořené segmentací objemo-
vých dat, povrchovými skenery nebo 
fotogrammetrickými aplikacemi, jsou 
často v  podobě, která nevyhovuje jejich 
plánovanému použití. Modely mohou 
obsahovat nedostatky, které navyšují 
objem dat, omezují použití některých 
analytických nástrojů nebo působí rušivě 
při zobrazení a prezentaci modelu. Po 
vytvoření modelu tak zpravidla následuje 
fáze jeho editace, během níž mohou být 
za pomoci různých editačních nástrojů 
téměř neomezeně upraveny různé vlast-
nosti modelu.

Editační nástroje můžeme rozdělit do 
několika skupin podle toho, které prvky 
modelu upravují. První skupinou jsou 
nástroje pro základní čištění modelu od 
nadbytečných dat a defektů polygonál-
ní sítě. Tyto nástroje neovlivňují podobu 
samotného modelu, očištění vede 
především k redukci objemu dat, a tím ke 
snížení výpočetní náročnosti další práce  
s modelem. Druhá skupina nástrojů slouží 
k  editaci tvaru modelu. Použitím těchto 

Rozdělení editačních nástrojů 

1) Nástroje pro čištění modelu od nadbytečných dat, defektních polygonů a nežádoucích 
částí
odstranění redundantních dat
odstranění defektních polygonů
odstranění nežádoucích částí sítě
odstranění izolovaných fragmentů

2) Nástroje pro úpravu geometrie polygonální sítě
Oprava zdvojení polygonální sítě
Vyplňování děr
Změna rozlišení

3) Nástroje pro změnu velikosti a polohy modelu v trojrozměrném prostoru
Škálování modelu
Nastavení modelu do definované polohy
Volné polohování modelu
Zarovnání překrývajících se dílčích modelů

4) Nástroje pro editaci barevné informace 

2. Editace trojrozměrných modelů
nástrojů může dojít k podstatným změnám 
modelu a odchýlení se jeho tvaru od tvaru 
modelovaného objektu, tedy ke změně 
informace nesené modelem. Třetí skupina 
nástrojů neovlivňuje podobu modelu, ale 
upravuje jeho velikost a polohu v systému 
souřadnic. Tyto nástroje jsou využívány 
k  ustavení modelu do některé z  defino-
vaných poloh nebo pro vzájemné uspořá-
dání více souvisejících modelů. Příkladem 
prvně jmenovaného využití je ustavení 
modelu lebky do polohy odpovídají-
cí frankfurtské horizontále, usnadňující 
jeho další analýzy a prezentaci, vzájemné 
polohování více modelů je pak základem 
virtuální restaurace. Volba editačních 
nástrojů a pořadí jejich použití záleží na 
stavu původního modelu a požadova-
né výsledné formě. Očištění modelu je 
vhodné provádět hned na počátku editace, 
pořadí ostatních kroků však musíme 
přizpůsobit konkrétním okolnostem. Tvar 
polygonální sítě je například vhodné 
editovat v co možná nejvyšším, původním 
rozlišení a až nakonec rozlišení modelu 
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redukovat podle požadavků na výsledný 
model. Příliš velké rozlišení však zvyšuje 
výpočetní náročnost práce s  modelem, 
proto je často nutné přistoupit k  jeho 
počáteční redukci. Dalším příkladem je 
odstranění izolovaných fragmentů, které 
může být provedeno jako jeden z prvních 
kroků, zároveň však odstraníme fragmenty, 
které mohou být využity při vyplňování 
děr v síti (viz 2.2.4. Odstranění...).

Nástroje pro editaci polygonálních 
modelů jsou často součástí samotných 
ovládacích rozhraní skenerů, aplikací 
pro segmentaci objemových dat  
a fotogrammetrických aplikací. Speciali-
zované programy pro úpravu 3D modelů 
však nabízejí výkonnější nástroje a širší 
možnosti nastavení editačních kroků.  
V této kapitole budou prakticky představe-
ny především dvě volně dostupné aplikace 
pro editaci 3D modelů, MeshLab a GOM 
Inspect. Oba programy nabízejí podobnou 

GOM Inspect je aplikací pro editaci a komparaci polygonálních sítí. Pro nekomerční využití 
je aplikace dostupná bezplatně. GOM Inspect byl vyvinut především pro oblast strojírenství, 
konkrétně pro analýzu odchylek mezi návrhem součástky, v některém z designovacích programů, 
a její finální podobou, digitalizovanou 3D skenerem. Kvůli tomuto zaměření má práce s polygonál-
ními modely v tomto programu svá specifika:

2.1.1. Praktická ukázka – postup editace modelu lebky v programu GOM 
Inspect

2.1. Editační aplikace

škálu editačních nástrojů, v  detailech se 
však odlišují. 

Program GOM Inspect nabízí výkonné 
nástroje pro editaci geometrie polygo-
nálních sítí, nepracuje však s  barevnou 
informací. Program MeshLab pracuje 
téměř se všemi formáty 3D modelů, 
včetně formátů obsahujících barevnou 
informaci, mezi jeho nevýhody však patří 
menší uživatelská přívětivost a nestabilita. 

Aplikace pro editaci 3D modelů pracují 
zpravidla se svými, nativními formáty 
souborů, tzv. projekty, které se liší od 
obecných 3D formátů. Pro editaci musejí 
být modely do editačních aplikací nejprve 
importovány. U některých programů 
(GOM Inspect) se model stává importem 
součástí projektu, u jiných programů 
(MeshLab) obsahuje projekt pouze cestu 
k  souboru modelu. Stejně jako u jiných 
nativních formátů platí, že projekty mohou 
být otevřeny pouze ve svém programu, 
proto modely po skončení editace opět 
exportujeme do některého z  obecných 
formátů.

•	 modely jsou do programu importovány buď 
jako CAD (tzv. Nominal elements), nebo 
Mesh (tzv. Actual elements).

•	 Modely importované jako CAD jsou chápány 
jako referenční modely, původní návrhy, 
proto se nedají editovat.

•	 Modely importované jako Mesh jsou 
chápány jako skeny a jsou editovatelné.

•	 Porovnání a superpozice jsou možné pouze 
mezi objektem importovaným jako Mesh a 
modelem importovaným jako CAD.

Podporované 3D formáty:
•	 import: STL, POL, PLY, G3D
•	 export: STL, PLY, G3D
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•	 Model importujeme jako Mesh do otevře-
ného projektu.

•	 Do projektu importujeme 3D model buď 
přes dialogové okno File > Import > File..., 
nebo přetažením ikony souboru přímo do 
okna programu, na ikonu Import.
•	 V dialogovém okně nastavíme typ impor-

tovaného modelu (Target element type) 
na Mesh, model lebky tak bude importo-
ván jako editovatelný model.
Všechny prvky projektu, tj. importované 
modely, editované body, míry atp., jsou 
uvedeny v seznamu Elements nalevo, kde 
jsou roztříděny podle typu. Importova-
ná lebka je zařazena do Actual Elements 
> Meshes.

Základní navigace v programu GOM Inspect

LMB - otáčení
shift + LMB – otáčení kolem osy pohledu
kolečko myši -  ZOOM
stisknuté kolečko myši – posun
Pro nastavení standardního pohledu 
je vhodný navigátor v levé dolní části 
editačního okna.

Projekt programu GOM Inspect

Nativním souborem aplikace GOM Inspect je projekt, uložený v samostat-
ném adresáři. Jméno a umístění adresáře je nastaveno při uložení. 
Adresář obsahuje spouštěcí program projektu (přípona .ginspect_prj), 
stejně jako všechny importované modely, editované prvky atp.  
Pro správné fungování projektu je potřeba celý adresář!!! 

Pozměněné modely jsou při uložení součástí projektu. Do některého  
z obecných 3D formátů mohou být exportovány příkazem:

File > Export > Mesh > Stl… (případně jiný formát)

V následujícím textu bude stručně představen způsob editace modelu za pomoci nástrojů aplikace 
GOM Inspect na příkladu modelu lidské lebky. Blíže se budeme věnovat pouze obecným pravidlům 
práce v programu GOM Inspect, návody na použití jednotlivých nástrojů jsou součástí obecného 
přehledu editačních nástrojů v druhé části této kapitoly.

Projekt obsahující model „H115_lebka-_raw“, impor-
tovaný jako Mesh, a model „H115_lebka_CT“, impor-
tovaný jako CAD a zneviditelněný
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Pokud projekt obsahuje více modelů, editován je vždy jen ten, který je označen/aktivován 
v  seznamu Elements. V  seznamu Elements můžeme také nastavit viditelnost jednotlivých 
prvků, kliknutím LMB na ikonu oka.

V rámci projektu můžeme měnit umístění modelů mezi Nominal nebo Actual Elements
Operations > CAD > Actual Mesh to CAD
Operations > CAD > CAD to Actual Mesh

•	 Model očistíme od nadbytečných dat a chyb polygonální sítě nástrojem Eliminate Mesh Errors.
•	 Nástrojem Thin Mesh provedeme počáteční redukci rozlišení s nastavením Surface tolerance 

0.2mm a Max. edge length 2mm, při tomto nastavení se bude redukovaný model lišit od 
původního maximálně o 0,2 mm a žádná z hran nebude delší než 2 mm.

•	 Označíme všechny izolované polygonální sítě, ověříme, že nechceme žádný z fragmentů využit 
pro další editaci, např. pro vyplňování děr, a odstraníme je příkazem Ctrl + Del.

•	 S pomocí nástrojů pro výběr sítě ořežeme případné nežádoucí části modelu. Stejné nástroje 
využijeme také k  začištění nerovností sítě, které vznikají na okrajích přirozených otvorů jako 
artefakty skenování. Tyto nerovnosti mohou negativně ovlivnit následné vyplňování děr.

•	 Díry v polygonální síti vyplňujeme nejprve automaticky nástrojem Close Holes: Operations > 
Mesh > Close Holes > Automatically (Filling result – normal, Max. hole size – 10, Max. number of 
edges – 30, Delete neighborhood – 1) a poté za pomoci manuálního nástroje, nastavení přizpů-
sobujeme tvaru a velikosti díry. Velké otvory, jako např. apertura piriformis, vyplňujeme za 
pomoci polygonálního můstku. Pokud jsou díry součástí zdvojeného povrchu a složitějších chyb 
sítě, musíme nejdříve tyto chyby odstranit.

•	 Model lebky ustavíme do frankfurtské horizontály za pomoci nástroje Operations > Alignment > 
Single Element Transformation > 3-2-1…

2.1.2. Praktická ukázka – práce v programu MeshLab
MeshLab je volně dostupná, opensou-

rce aplikace, zaměřená na zpracová-
ní a editaci polygonálních modelů. Mezi 
výhody patří velké množství editačních 
nástrojů a podporovaných formátů, včetně 
formátů modelů opatřených barevnou 
texturou nebo informací o barvě vrcholů. 
Nevýhodou programu je nestabilita  
a časté padání Windows verze programu. 

Podporované 3D formáty:
Import: PLY, STL, OFF, OBJ, 3DS, COLLADA, PTX, V3D, PTS, APTS, XYZ, GTS, TRI, ASC, X3D, X3DV, 
VRML, ALN
Export: PLY, STL, OFF, OBJ, 3DS, COLLADA, VRML, DXF, GTS, U3D, IDTF, X3D

•	 Po skončení editace model exportujeme do některého 
z  obecných formátů. Před exportem můžeme provést 
redukci rozlišení, případně reorientaci modelu do defino-
vané polohy (viz kap. 2.4. Nastavení velikosti a polohy...).
•	 Model označíme v seznamu Elements nalevo.
•	 Příkazem File > Export > Mesh > Stl… aktivujeme 

dialogové okno pro export do formátu .stl
•	 Zvolíme složku, do které bude model exportován  

a exportujeme stiskem tlačítka Ok.
•	 Bez nastavení cílové složky se model exportuje do složky 

Export umístěné v adresáři projektu.
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LMB – otáčení
Ctrl + LMB – posouvání
ZOOM – přibližování/oddalování
Shift + ZOOM – změna FOV (field of view)
Ctrl + h – návrat k originální poloze
LMB + Ctrl + Shift – ovládání osvětlení

Help > On screen 
quick help

MeshLab – základní navigace

Nativním souborem aplikace MeshLab jsou  tzv. projekty (přípona .mlp).
Projekt je jednoduchý textový soubor, obsahující pouze cesty k jednotlivým modelům, 
případně tzv. roto-translační matice, ne už samotné modely. Modely jsou vždy načítány  
z externích souborů – v případě, že změníme cestu k modelům (přesuneme je do jiné složky, 
případně odstraníme), projekt v plné podobě nenačteme!!!!!

Projekt programu MeshLab, správa modelů

Po editaci modelu v prostředí MeshLab 
(posuneme v prostoru, umažeme, zjedno-
dušíme atd.), je tento model v Layer Dialog 
označen hvězdičkou – to znamená, že model 
byl změněn v projektu, ale nebyl uložen, 
soubor modelu je nezměněn!!!! 

Editované modely musejí být exportovány – 
File > Export Mesh...

Projekt se dvěma importovanými modely. Vidi-
telný pro úpravy je pouze model kořene, který byl 
současně editován bez uložení, proto je označen 
hvězdičkou.

V následujícím textu bude stručně představen způsob editace modelu za pomoci nástrojů aplikace 
MeshLab. Modelovým příkladem bude dokončení modelu zubu ze dvou dílčích modelů, vytvo-
řených v programu 123D Catch. Součástí postupu je vyčištění modelů a jejich následné spojení 



62

v  jeden definitivní model zubu. Blíže se budeme věnovat pouze specifikám  práce v  programu 
MeshLab, konkrétní návody na použití jednotlivých nástrojů jsou součástí obecného přehledu 
editačních nástrojů v druhé části této kapitoly.

Dva dílčí modely, vytvořené s pomocí aplikace 123D Catch Konečný model zubu

•	 Do projektu MeshLab importujeme oba modely zubu 
(jeden modelující kořen zubu, druhý polovinu zubu  
s korunkou). Import provedeme příkazem File > Import 
> Import Mesh nebo přetažením ikony souboru do okna 
aplikace.
Importované modely jsou zobrazeny v  Layer 
Dialog, dialogovém okně umožňujícím 
nastavení viditelnosti (LMB kliknutím na 
ikonu oka) a aktivaci jednotlivých modelů. 
Layer Dialog spustíme příslušnou ikonou. 
Všechny editační nástroje účinkují vždy jen na 
ten model, který je aktivován v Layer Dialog. 
V našem případě provedeme první úpravu 
dílčího modelu kořene zubu a následně 

Seznam importovaných objektů 
a nastavení jejich viditelnosti

Historie příkazů

úpravu dílčího modelu korunky (model aktivujeme kliknutím LMB na jeho název v Layer Dialog)
•	 Odstraníme nadbytečná data modelu. 

Modely exportované z aplikace 123D Catch jsou zpravidla čisté, bez redundantních dat a defekt-
ních polygonů. Model zubu, vyrobený za pomoci programu 123D Catch, obsahuje pouze malé 
množství Self-intersecting polygonů. Bez dodatečných úprav nemá odstranění těchto polygonů 
smysl. 

•	 Pokud je zapotřebí, redukujeme rozlišení modelu.
•	 Za pomoci nástroje Filters > Cleaning and Repairing > Remove Isolated pieces (wrt. Diameter.)…

odstraníme izolované fragmenty. Chceme odstranit všechny izolované fragmenty, bez ohledu 
na jejich konkrétní velikost, proto nastavíme hodnotu „perc on“ např. na 50. Při tomto nastavení 
budou odstraněny všechny fragmenty menší než 50% velikosti celého modelu.

•	 Automatickým nástrojem vyplníme díry v  polygonální síti – Filters > Remeshing, Simplificati-
on and Reconstruction > Close Holes. Maximální velikost vyplňovaných děr nastavíme na 20. 
Aktivací volby Prevent creation of self-intersecting faces zabráníme vzniku sebe-protínajících se 
polygonů.
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•	 Provedeme škálování obou modelů podle přiloženého měřítka.
•	 Editace velikosti, polohy nebo orientace je v programu MeshLab spojena s tzv. roto-translační 

maticí, do které jsou dané editační kroky nejprve uloženy a až následně musejí být aplikovány 
na samotný model (viz následující rámeček).

Při změně velikosti, polohy nebo orientace 
modelu nedochází rovnou ke změně 
samotného modelu, přepočítání polohy 
vrcholů v prostoru, ale pouze k uložení 
změn ve formě tzv. roto-translační matice, 
která je k modelu přiřazena a přes kterou je 
model zobrazován. Při uložení projektu se 
matice stává jeho součástí a původní modely 
zůstávají nezměněny, při opětovném otevření 

Roto-translační matice

projektu jsou modely opět zobrazeny přes roto-translační matici.
Modely, ke kterým je připojena roto-translační matice, jsou v seznamu objektů označeny 
hvězdičkou, při jejich aktivaci je vpravo dole matice zobrazena.

Aplikaci roto-translační matice na model provedeme příkazem Freeze Current Matrix v menu, 
které otevřeme kliknutím RMB na název modelu v seznamu vrstev. Přepočtem modelu matice  
v pravé části spodní lišty zmizí. Stejně jako u ostatních editačních kroků,  musí být upravený 
model následně exportován (File > Export Mesh...).

Volbu Freeze Current Matrix obsahují dialogová okna řady editačních nástrojů. Při jejím zatržení 
je rovnou model rovnou editován bez toho, aby k němu byla nejprve přiřazena matice.

•	 Za pomoci nástroje Z-painting odstraníme nežádoucí části obou 
modelů.

•	 Modely vzájemně zarovnáme za pomoci nástroje Align tak, aby 
vytvořily dojem jednolitého modelu.

•	 Oba dílčí modely sloučíme do jednoho nástrojem Flatten Visible Layers.
•	 Klikneme RMB na jeden ze dvou modelů v  seznamu Layer Dialog a v  menu zvolíme Flatten 

Visible Layers. 
•	 V  dialogovém okně zvolíme možnost Delete Layers, po vytvoření nového modelu budou 

původní dílčí modely z projektu odstraněny. Výsledkem je jeden model, který exportujeme do 
jednoho souboru. Nedochází k žádné změně morfologie původních, spojovaných polygonálních 
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sítí, ani k jejich vzájemnému propojení, příkaz pouze sloučí viditelné sítě do jednoho modelu. 
•	 Pokud náš projekt obsahuje více modelů a chceme spojit jen některé, využijeme volbu Merge 

Only Visible Layers a nastavíme jako viditelné pouze ty modely, které chceme spojit.
•	 Na definitivní model přeneseme z dílčích modelů textury.
•	 Model exportujeme

•	 Exportovaný model aktivujeme v seznamu Layer Dialog
•	 Model exportujeme příkazem File > Export Mesh...

2.2.1. Odstranění redundantních 
dat

2.2. Čištění 3D povrchových 
modelů

Soubory 3D modelů obsahují často 
redundantní data, která zbytečně navyšují 
datovou velikost modelu a zvyšují 
výpočetní náročnost práce s  modelem. 
Nejčastějšími typy redundantních dat jsou 

vrcholy a polygony definované stejnými 
souřadnicemi (duplicated vertices, dupli-
cated faces) a polygony s  nulovou 
plochou, například polygony definova-
né třemi totožnými vrcholy (tzv. degene-
rated faces). Odstraněním těchto prvků 
nedojde k žádné změně informace nesené 
modelem, pouze k  redukci objemu dat,  
a tím k zefektivnění další práce s modelem.

Program GOM Inspect obsahuje nástroj Eliminate Mesh Errors, který odstraňuje redundantní data 
společně s defekty polygonální sítě.

GOM Inspect – odstranění redundantních dat

•	 Označíme celý model – RMB na náhledové okno > Select all
•	
•	 Spustíme nástroj čištění modelu – Operations > Mesh > Eliminate 

Mesh Errors
Po vyčištění modelu program zobrazí informace o počtu opravených 
chyb.

MeshLab – odstranění redundantních dat

Nástroje pro odstranění redundantních dat jsou součástí nabídky Filters > Cleaning and Repairing.

•	 V okně LayerDialog aktivujeme model, který chceme editovat (LMB)
•	 Následně aplikujeme nástroje z nabídky Filters > Cleaning and repairing…

…> Remove Duplicated Vertex – odstraní zdvojené vrcholy
…> Remove Duplicate Faces – odstraní zdvojené polygony
…> Remove Zero Area Faces – odstraní nulové polygony
…> Remove Unreferenced Vertices – odstraní vrcholy, které nejsou součástí žádného polygonu 
(samostatné body)

Redundantní informace modelu peruánské 
lebky, skenovaného přístrojem MicroScan
Původní model :
Vrcholů – 6800 K
Velikost – 495 MB
Po odstranění redundantních vrcholů:
Vrcholů – 1142 K
Velikost – 114 MB
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Defekty polygonální sítě nejsou překážkou 
běžného využití modelů pro měření a prezen-
taci, jejich přítomnost však může ztěžovat 

2.2.2. Odstranění defektních polygonů
další editaci polygonální sítě a bránit aplikaci 
některých editačních nástrojů.

Nejčastějšími defekty sítě jsou:
Non-manifold edges – hrany, které jsou součástí 
více než dvou polygonů.
Non-manifold vertices – vrcholy, které jsou součástí 
více polygonů, které nesdílejí své strany.

Self-intersecting faces – polygony, které protínají 
sama sebe. Pokud jsou tyto polygony odstraně-
ny bez další editace, vznikají v síti díry, které jdou 
zaplnit opět pouze self-intersecting polygony, 
proto k tomuto kroku často nepřistupujeme.

Non-manifold edge

Non-manifold vertex

Pro odstranění některých typů defektů slouží nástroj Eliminate Mesh Errors

•	 Označíme celý model – RMB na náhledové okno > Select All
•	 Spustíme nástroj čištění modelu – Operations > Mesh > Eliminate Mesh Errors

GOM Inspect – odstranění defektů polygonální sítě

MeshLab – odstranění defektů polygonální sítě

•	 V okně LayerDialog aktivujeme model, který chceme editovat (LMB)
•	
•	 Nástroje z nabídky Filters > Cleaning and Repairing… slouží k označení příslušných defektních 

polygonů
•	 … > Select Self Intersecting Faces 
•	 … > Select non Manifold Edges 
•	 … > Select non Manifold Vertices 
•	
•	 Označené prvky odstraníme stiskem Del.

2.2.3. Odstranění nežádoucích částí sítě – nástroje pro výběr polygonál-
ní sítě

Nechtěné části modelu zbytečně 
navyšují jeho datovou velikost, mohou 

překážet následným analýzám nebo 
působit rušivě při vizualizaci. 

•	 Za pomoci některého z nástrojů výběru označíme část polygonální sítě, kterou chceme odstranit.
•	 Označenou oblast sítě odstraníme příkazem Ctrl + Del

Odstranění nežádouchích částí sítě – GOM Inspect
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Nástroje pro výběr polygonální sítě

Nástroje výběru polygonální sítě jsou v nabídce Edit > Selection in 3D …, některé nástroje jsou 
přístupné i rychlou volbou RMB > …  a na liště umístěné ve spodní části náhledového okna. 
Výběr sítě neslouží pouze k čištění modelu, ale obecně ke specifikaci editované oblasti při 
použití různých nástrojů (např. vyhlazování sítě nebo automatického vyplňování děr).

Základní možnosti výběru jsou:
výběr všech sítí, které jsou nastavené jako viditelné 
Edit > Selection in 3D > Main Selection > Select All (také přes RMB) 
výběr části sítě, ohraničené definovaným polem a otočené lícem (front side)
Edit > Selection in 3D >  Surface Selection > Select/Deselect on Surface (také přes RMB)

1) Spustíme nástroj
2) Za stisku LMB obkreslíme oblast, kterou chceme označit
3) Stiskneme RMB a vybereme, jestli chceme danou oblast označit „+“ nebo 
odznačit „-„ (funguje i na odznačení specifických částí sítě)
výběr části sítě, ohraničené definovaným polem a přímo viditelné v náhledo-
vém okně (v případě zdvojených povrchů vybere jen vrchní, viditelný)
Edit > Selection in 3-D >  Surface Selection > Select/Deselect In Viewing Direction

výběr všeho, co se nalézá v definovaném poli (i zakrytých částí a částí sítě obrácených rubem)
Edit > Selection in 3D >  Surface Selection > Select/Deselect Through Surface
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Výběrovými nástroji programu MeshLab jsou Select Faces in Rectangular region a Z-painting. 
První ze jmenovaných nástrojů nemusí fungovat správně na některých výpočetních konfiguracích 
(program se zasekává), proto k výběru sítě použijeme nástroj Z-painting, který funguje analogic-
ky k malování od ruky.

•	 V Layer Dialog aktivujeme model, který chceme ořezat.
•	 Příslušnou ikonou aktivujeme nástroj Z-painting.
•	 V dialogovém okně zvolíme nástroj pro výběr sítě. 

Odstranění nežádouchích částí sítě – MeshLab

•	 Při stisknutém LMB  vybereme kurzorem části sítě, které 
chceme vymazat. Vybrané části sítě můžeme odznačit stisknu-
tím RMB. Pro pozdější použití ponecháme u modelů měřítka.

•	 Vybrané části sítě vymažeme za pomoci  nástroje pro odstra-
nění polygonů a vrcholů nebo stiskem Del.

•	 Vybereme a zviditelníme druhý 
model a postup opakujeme.

•	 Stejně jako u jiných editačních 
kroků modely po skončení editace 
exportujeme.

Digitální model je velmi často tvořen 
nejen hlavní polygonální sítí, ale také 
větším množstvím drobných izolova-
ných sítí, které vznikají jako artefakty 
skenování (fragmenty, zdvojení povrchu, 
okolí atp.). Pokud jsou izolované sítě 
součástí jednoho souboru, modelu, 

2.2.4. Odstranění izolovaných 
fragmentů sítě

většina editačních programů je nerozliší 
a pracuje s  modelem jako s celkem. 
Izolované sítě mohou působit potíže při 
aplikaci některých editačních a analytic-
kých nástrojů (např. zaplňování děr nebo 
měření objemu). Pokud fragmentární sítě 
nenesou využitelnou informaci, přistupu-
jeme k jejich odstranění. 

Renderovaný model (vlevo) lidské lebky získaný za pomoci skeneru NextEngine a stejný model se žlutě zvýraz-
něnými samostatnými sítěmi (vpravo).
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Ne vždy jsou izolované sítě nežádoucí 
součástí modelu. Může jít o sítě, které jsou 
naskenovány správně a mohou být využi-
telné např. při vyplňování děr. Odstraně-
ním těchto sítí můžeme přijít o podstat-
nou část informace.

•	 Spustíme nástroj Select Path – Edit > Selection in 3D > 
Select Path

•	 LMB klikneme na model 
•	 Tento nástroj slouží k označení jedné, spojité polygonál-

ní sítě. Pokud klikneme na hlavní síť, která tvoří model, 
označí se pouze ta a izolované fragmenty zůstanou 
neoznačené (zelené).

•	 Použijeme nástroj Invert Selection - Edit > Main Selecti-
ons > Invert Selection

•	 Nástroj Invert Selection slouží k  obrácení výběru, po 
jeho použití by měly být vybrány pouze izolované 
fragmenty.

•	 Ověříme, že jsou vybrány pouze fragmenty, které 
chceme odstranit. Fragmenty, které nechceme vymazat, 
odznačíme nástrojem Select Path a stisknutím Ctrl + 
LMB

•	 Označené sítě odstraníme stisknutím Ctrl + Del

Program také umožňuje výběr všech sítí menších než je 
definovaná velikost – Edit > Selection in 3D > Other selecti-
ons > Select Patches By Number of Points.... Maximální 
velikost sítí může být definována procenty vrcholů celého 
modelu (Max. percentage) nebo počtem vrcholů (Max. 
number of points)

Odstranění izolovaných fragmentů – GOM Inspect

Odstranění izolovaných fragmentů – MeshLab

MeshLab umožňuje odstranit polygonální sítě na základě definované velikosti.
•	 Spustíme nástroj pro odstranění fragmentů – Filters > Cleaning and Repairing > Remove Isolated 

Pieces (wrt Diameter.)…
•	 Definujeme velikost polygonálních sítí, které mají být odstraněny. Chceme-li odstranit všechny 

izolované fragmenty, bez ohledu na jejich konkrétní velikost, můžeme nastavit hodnotu „perc 
on“ např. na 50. Při tomto nastavení budou odstraněny všechny fragmenty menší než 50 % 
velikosti celého modelu.
Ve stejném dialogovém okně můžeme nastavit velikost odstraněných fragmentů také  
v absolutní hodnotě „world unit“. Varianta stejného nástroje, Remove Isolated pieces (wrt Face 
num.), pak umožňuje nastavit velikost fragmentů v počtu polygonů.

•	 Fragmenty odstraníme příkazem Apply.
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2.3. Editace geometrie polygonál-
ní sítě
2.3.1. Vyplňování děr

Polygonální sítě tvořící 3D model často 
obsahují velké množství děr. Nemusí jít 
pouze o díry odpovídající přirozeným 

otvorům modelovaného objektu nebo 
díry vzniklé v  místech, která nemohla 
být nasnímána, např. z  důvodu zákrytu 
nebo špatné dostupnosti. Velké množství 
nepatrných děr vzniká také v  důsledku 
chybného generování polygonální sítě, jde 
o artefakty tvorby modelu.

Díry v  polygonální síti mohou být 
překážkou aplikace některých analy-
tických nástrojů (např. měření objemu, 
vytváření rovinných řezů). Úplná uzavře-
nost polygonálních sítí je nutná také pro 

3D tisk – některé aplikace z tohoto důvodu 
hlásí chybu při ukládání neuzavřeného 
modelu do formátu stl, nativního formátu 
stereolitografie, jedné z metod 3D tisku.

GOM Inspect nabízí nástroj pro automatické zaplnění děr definovaných rozměrů, který je vhodný 
pro vyplnění malých děr v polygonální síti. Pro vyplnění větších děr je k dispozici manuální nástroj, 
poskytující větší kontrolu nad tvarem výplně. Komplexní díry mohou být před vyplněním přemos-
těny za pomoci polygonálního můstku. Pokud je model tvořen dvěma nezávislými polygonální-
mi sítěmi, nemohou být tyto sítě spojeny za pomoci automatického vyplňování děr (díry musí být 
zcela ohraničena polygony). V takových případech využijeme k propojení sítí polygonální můstek 
a až následně vzniklé díry vyplňujeme. Stejný postup zvolíme v případě, kdy chceme fragment sítě, 
umístěný v prostoru díry, využít pro tvorbu výplně.

Vyplňování děr v polygonální síti – GOM Inspect

Automatické vyplňování

•	 Označíme celý model – LMB > Select All.
•	 Spustíme nástroj pro automatické vyplňování – Operations > Mesh > Close holes > Automati-

cally…
•	 Nastavíme parametry děr, které chceme automaticky zaplnit (podle obrázku níže).

U řady nástrojů lze parametry jejich použití nastavit automaticky, kliknutím Ctrl + LBM na 
relevantní oblast polygonální sítě. Automatické vyplňování nastavíme kliknutím na okraj díry 
tak, že budou vyplněny díry stejné a menší velikosti.

•	 Nástroj aplikujeme stiskem Apply
U našeho modelu lebky vedlo dané nastavení k zaplnění 226 děr z 260.
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Podoba výplně, u malých děr 
nemá nastavení podstatnější 
vliv na výsledek.

Max. velikost editovaných děr 
v mm

Max. velikost editovaných děr 
v počtu ohraničujících poly-
gonů

Počet řad polygonů obklopují-
cích díru, které budou odma-
zány (vyšší číslo znamená 
zpravidla vyšší úspěšnost zapl-
ňování děr)

Manuální vyplňování děr

•	 Spustíme nástroj manuálního vyplňování děr – Operations > Mesh > Close 
holes > Interactivelly... nebo příslušnou ikonou.

•	 Díru, kterou chceme editovat, vybereme kliknutím Ctrl + LMB do blízkosti 
jejího okraje

•	 Po nastavení parametrů výplně aplikace dopředu vypočítá její tvar (v případě složitějších děr 
může tato operace trvat několik sekund).

•	 Nastavení Filling result měníme podle požadovaného výsledku. V  případě některých děr je 
dobré zvolit jemnější přechod, respektující tvar okolí díry, v případě přirozených děr můžeme 
použít rovnou výplň (Plane-based).

•	 Výplň aplikujeme příkazem Apply.
•	 Celý proces opakujeme u dalších děr modelu.

Vliv různého nastavení Filling result na podobu výplně
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Volba Delete neighborhood 
Volba Delete neighborhood udává počet řad polygonů sousedících s dírou, které budou před 
vyplněním odmazány. Umožňuje tak nastavit, do jaké míry bude tvar výplně respektovat tvar 
okrajů díry. 
Podobná volba je přítomna u řady editačních nástrojů. 
Vliv různého nastavení hodnoty Delete neighborhood na tvar výplně.

Vyplňování děr za pomoci polygonového můstku

•	 Spustíme nástroj Mesh Bridge – Operations > Mesh > Close 
holes > Mesh Bridge...

•	 Kliknutím LMB + Ctrl k okrajům díry definuje-
me začátek a konec polygonálního můstku. 

•	 Hodnotou Tangential tension nastavíme zakřivení můstku – 
čím menší, tím více můstek respektuje tvar krajů.

•	 Můstek vytvoříme volbou Ok
•	 Nové díry zaplníme nástrojem pro interaktivní vyplňování 

děr
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•	 Fragmenty propojíme polygonovými můstky.
•	 Vzniklé díry interaktivně vyplňujeme.

Vyplňování děr s využitím izolovaných fragmentů

Program MeshLab obsahuje nástroj, který automaticky vyplňuje všechny díry do velikosti defino-
vané počtem polygonů ohraničujících díru. 

Vyplňování děr v polygonální síti – MeshLab

•	 Spustíme nástroj automatického vyplňování 
děr – Filters > Remeshing, Simplification and 
Reconstruction > Close holes
Definujeme max. velikost vyplňovaných děr. 
Pro vyplnění drobných děr zvolíme nějakou 
přibližnou hodnotu, např. 20 (při nastavení 
na tuto hodnotu budou editovány všechny 
díry, které jsou ohraničeny dvaceti a méně 
polygony). Nastavení příliš velké hodnoty by 
mohlo vést k nechtěnému uzavření větších 
děr.

Volba Prevent creation of selfintersecting faces zamezí vytvoření self-intersecting polygonů.

2.3.2. Oprava zdvojení polygonál-
ní sítě

Zdvojení polygonální sítě je defektem, 
který může komplikovat některé editační 
kroky. Součástí zdvojení je často díra, jejíž 
uspořádání je tak složité, že nejde uzavřít. 
Problémem je tak např. úplné uzavření 
modelu obsahujícího zdvojené povrchy.

Oprava zdvojeného povrchu může 
znamenat podstatný zásah do tvaru 
modelu!!!

•	 Za pomoci nástroje Select/Deselect On Surface označíme oblast zdvojení. 
•	 Aplikujeme nástroj Repair, bez volby Cut Selected Area.

Výsledkem mohou být díry a velké množství fragmentů.
•	 Pokud žádný z fragmentů nechceme využít k zacelení sítě, označíme všechny malé fragmenty 

Oprava zdvojení polygonální sítě – GOM Inspect
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volbou Select Patches By Number of Points a odmažeme je  stiskem Del.
Pokud chceme některý ze vzniklých fragmentů využít, spojíme jej s  hlavní sítí polygonovými 
můstky (viz 2.2.4. Odstranění izolovaných fragmentů sítě).

•	 Díry vyplníme za pomoci interaktivního nástroje.
Výsledkem je hladký, uzavřený povrch. 

2.3.3. Redukce rozlišení
Redukce rozlišení je krokem, ke 

kterému můžeme přistoupit v  různých 
fázích editace modelu. V ideálním případě 
pracujeme s  modelem v  původním, 
maximálním rozlišení, daným např. 
nastavením 3D skenování. S  rostoucím 
rozlišení modelu však úměrně stoupá 

velikost souboru a výpočetní náročnost 
jeho zpracování, proto často přistupu-
jeme k  redukci rozlišení na počátku celé 
editace tak, abychom snížili její výpočetní 
náročnost. Zvolené rozlišení je vždy 
kompromisem mezi množstvím uchované 
informace, zachycených detailů, a velikostí 
souboru.

•	 Vybereme celý model – RMB > Select All…
•	 Spustíme nástroj pro redukci rozlišení „Thin 

Mesh“ – Operations > Mesh > Thin…
Zvolíme nastavení Surface tolerance  
a zadáme maximální odchylku, kterou může 
mít nový model od originálu. Můžeme 
aktivovat také volbu Max. edge length, 
která omezuje délku hran nově vzniklých 
polygonů.
Např. při nastavení Surface tolerance na 
hodnotu 0.2 a Max. edge length 2 bude 
výsledkem redukce polygonální síť, která se 
tvarově neliší od původní sítě o víc než o 0.2 

Redukce rozlišení polygonální sítě – GOM Inspect
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mm a jejíž vrcholy nejsou od sebe dál než 2 mm. 
•	 Redukci spustíme tlačítkem Apply

Druhou možností je nastavení přesného počtu vrcholů redukované polygonální sítě (Number of 
points). Výhodou nastavení maximální odchylky je, že nemusí být specifikován konkrétní počet 
bodů, závislý na velikosti sítě a její složitosti, ale jen tvarová tolerance. 

Původní model Surface tolerance 0,1 mm Surface tolerance 0,5 mm

Vliv různého nastavení redukce na výslednou polygonální síť

•	 V  Layer Dialog aktivujeme model (LMB), 
jehož rozlišení chceme redukovat 

•	 Spustíme nástroj redukce rozlišení – Filters 
> Remeshing, Simplification and Reconstruc-
tion > Quadric Edge Collapse Decimation... 

•	 Nastavíme parametry redukce a aplikuje-
me – Apply

•	 Target number of faces – nastavíme počet 
polygonů výsledného modelu 

•	 Preserve Normal, Preserve Topology, 
Preserve Boundary – volby zabraňují-
cí větším změnám v geometrii modelu. 
Při aktivace bude zachováno směrování 
polygonů, redukce rozlišení nepovede ke 
změnám topologie modelu, např.  vyplnění 
děr v  modelu, a ke změnám tvaru děr 
v polygonální síti.

•	 Jednotlivé volby jsou podrobně popsány 
v  nápovědě, která může být aktivována 
tlačítkem Help v  dialogovém okně. Stejná 
nápověda je k dispozici u většiny nástrojů.

Redukce rozlišení polygonální sítě – MeshLab
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2.4. Nastavení velikosti a polohy 
modelu, virtuální restaurace

2.4.1. Změna velikosti digitálních 
modelů – úprava fotogrammetric-
kých modelů na reálné rozměry

Fotogrammetrické modely nemají 
reálné rozměry. Pokud mají být modely 

využity pro měření ve virtuálním prostředí, 
musejí být zvětšeny nebo zmenšeny tak, 
aby jejich rozměry odpovídaly reálným 
rozměrům modelovaných objektů. Pro 
kalibraci modelu musíme znát některý 
délkový rozměr modelu. Nejspolehlivější 
je modelovat současně s předmětem také 
měřítko. 

•	 Model aktivujeme v panelu Layers Dialog
•	 Za pomoci nástroje Measuring Tool změříme známý rozměr modelu, v našem případě 16 mm 

dlouhý úsek měřítka
•	 Aktivujeme nástroj Measuring Tool

Změna velikosti digitálního modelu – MeshLab

Kliknutím LMB umístíme první a druhý bod rozměru. Vzdálenost se zobrazí  
u jednoho z  bodů, nikam se automaticky nezaznamenává, dalším kliknutím LMB 
původní rozměr zmizí a začínáme nové měření.

•	 Naměřenou hodnotou zaznamenáme a vydělíme 
skutečnou vzdáleností (16 mm).
V našem případě získáme hodnotu 1,06 (17/16,2).

•	 Model transformujeme vypočteným poměrem 
za pomoci nástroje Transform: Scale (Filters > 
Normals, Curvatures and Orientation > Transform: 
Scale...)

•	 Označíme příslušný model a spustíme nástroj 
změny velikosti.

•	 Do pole X Axis zadáme vypočtený poměr
•	 Zaškrtneme pole Uniform Scaling, tak dojde 

k uniformní transformaci modelu. Pokud by tato 
volba nebyla zaškrtnuta, model by se měnil jen 
podél jedné ze souřadnicových os a došlo by ke změně jeho tvaru.

•	 Díky zaškrtnutí pole Freeze Matrix dojde rovnou k přepočítání modelu (viz rámeček Roto-trans-
lační matice v kapitole 2.1.2.).

•	 Velikost modelu změníme příkazem Apply.

Změna velikosti digitálního modelu – GOM Inspect
Nástroje pro změnu velikosti modelu jsou v  nabídce Operations > Alignment > Single Element 
Transformation > Scale… 
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•	 Model aktivujeme kliknutím LMB na jméno 
modelu v seznamu Elements.

•	 Spustíme nástroj Scale, vybereme volbu 
By factor – změnu velikosti na základě 
zadaného faktoru.

•	 Zadáme faktor změny velikosti a aplikujeme.

2.4.2. Nastavení modelu do defi-
nované polohy

Digitální modely jsou tvořeny vrcholy, 
jejichž poloha v prostoru je definována 
hodnotou tří souřadnic. Každý model má 
tedy určitou polohu a orientaci v kartézské 
soustavě souřadnic. Poloha modelu, 
získaného skenováním nebo fotogramme-
tricky, je často dána polohou objektu při 
snímání nebo kalibrací dotykového digiti-
zéru. Poloha modelu v soustavě souřadnic 
není totožná s polohou, ve které se 
na model díváme v náhledovém okně 
aplikací. Otáčením modelu v náhledovém 

okně ve skutečnosti měníme úhel pohledu 
a ne orientaci modelu.

Editační programy umožňují změnu 
polohy a orientace modelu v jeho soustavě 
souřadnic – tj. přepočítání polohy všech 
vrcholů modelu. Tyto nástroje můžeme 
využít k ustavení modelu do některé ze 
standardních poloh (např. anatomické 
polohy nebo frankfurtské horizontály), do 
polohy vhodné k prezentaci (například 
do takové polohy, že se při otevření  
v editačním programu model zobrazí  
v anatomické poloze) nebo při virtuální 
restauraci.

Orientace souřadnicové soustavy

Programy pro editaci a prezentaci 3D dat se liší ve směřování souřadnicových os a jejich 
orientaci při načtení modelu.

GOM Inspect

Směřování os
Orientace souřadnicové sou-
stavy při spuštění programu

Landmark

Orientace souřad-
nicové soustavy při 
spuštění

Program Amira nabízí rychlou orientaci modelu 
do poloh odpovídajících základním anatomic-
kým rovinám.  
Aby orientace modelu odpovídala schématic-
kému zobrazení ikon, musí být model oriento-
ván podle schématu napravo.

Amira
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Frankfurtská horizontála je podle definice taková orientace lebky, při níž leží horní okraje vnějších 
zvukovodů a dolní okraje očnic (antropometrické body porion, resp. orbitale) ve vodorovné rovině. 
Poloha lebky ve frankfurtské horizontále je považována za anatomickou (fyziologickou) polohu a je 
jednou ze standardních poloh využívaných v antropologii. Řada antropometrických bodů a měr je 
definována vzhledem k frankfurtské horizontále nebo jejich definice vycházejí z lebky orientované 
v této poloze. Standardizace digitálního modelu do polohy analogické k frankfurtské horizontále 
nám umožní standardizaci měření modelu a je výhodná také pro prezentační účely.

Všechny nástroje pro změnu polohy a orientace digitálního modelu jsou v  nabídce Operati-
ons > Alignment > Single Element Transformation... Pro ustavení lebky využijeme nástroj 3-2-1…, 
orientaci modelu za pomoci 6 bodů.
•	 Model lebky importujeme jako Mesh do projektu GOM Inspect (model můžeme importovat 

také jako CAD)
•	 Na modelu vytvoříme celkem 6 bodů, které poslouží k nastavení lebky do frankfurtské horizon-

tály. Pro vytvoření bodů na povrchu modelu slouží nástroj  Construct > Point > Surface Point… 
Polohu bodu definujeme kliknutím Ctrl + LMB na model a následně volbou Create. Pro přehled-
nost můžeme v dialogovém okně každý bod pojmenovat.
Postupně na model lebky umístíme kraniometrické body pravý a levý porion, orbitale, nasion, 
lambdu a prosthion (viz následující obrázek).

Nastavení digitálního modelu do definované polohy v programu GOM Inspect – 
ustavení lebky do frankfurtské horizontály

•	 Spustíme nástroj 3-2-1… pro polohování modelu
•	 Dialogové okno nastavíme podle obrázku napravo. K  definici 

základní roviny využijeme oba body porion a bod orbitale, frank-
furtská horizontála tak bude odpovídat rovině X . Body nasion 
a lambda definujeme orientaci roviny Y, prosthion využijeme 
k  určení směřování osy Z. Výsledné postavení lebky bude 
odpovídat uvedenému schématu.

Polohu mění vždy všechny prvky aktivované v seznamu Elements. 
Pokud chceme polohovat model lebky společně s  definovanými 
body, je nutné označit v seznamu všechny tyto prvky!
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Nástroje pro polohování digitálních 
modelů jsou často využívány k sestavo-
vání modelů do vyšších celků. V kontextu 
kosterní antropologie se nejčastěji jedná 
o znovu-sestavení kosti ze samostat-
ných modelů jejích zlomků nebo ustavení 
kostí do původní, fyziologické polohy. 
Protože jde o postup analogický ke 
klasickým restauračním metodám, ale 
probíhající plně ve virtuálním prostředí 
počítače, hovoříme o tzv. virtuální restau-
raci. 

Digitální modely, získané některou 
z  metod povrchového skenování, 
jsou orientovány nezávisle na sobě, 
v  různých souřadnicových soustavách, 
tj. při současném načtení do některého 
z  editačních programů nejsou vzájemně 
správně orientovány. 

2.4.3. Sestavování digitálních 
modelů, restaurace ve virtuálním 
prostředí

Příkladem mohou být modely kostí 
pánve, které byly skenovány samostatně. 

Do fyziologické polohy, do podoby 
pánve, musejí být modely ustaveny 
v některém z editačních programů.
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K volnému polohování digitálních modelů slouží nástroj Manipulators Tool

•	 V seznamu Layer Dialog aktivujeme model, který chceme polohovat.
•	 Spustíme nástroj Manipulators tool.
•	 Stiskem T aktivujeme změnu polohy, stiskem R aktivujeme otáčení.
•	 Při stisknutém LMB nastavíme myší novou polohu, orientaci modelu.

Stisknutím X, Y nebo Z  můžeme zafixovat rovinu, podél které bude model posunován, resp. 
osu, okolo které bude model rotovat. Další možnosti ovládání jsou uvedeny v dialogovém okně 
nástroje.

•	 Novou polohu, orientaci aplikujeme tlačítkem Enter. Stiskem Backspace nastavené polohování 
zrušíme. Celý proces můžeme libovolně opakovat.
Stejně jako je tomu u jiných editačních nástrojů, je i v  tomto případě k modelu nejdříve 
připojena roto-translační matice. Samotný model změníme aplikací matice příkazem Freeze 
Current Matrix (možnost se zobrazí po stisku LMB na název objektu v Layer Dialog). Následně 
může být model exportován.  

Volné polohování digitálních modelů – MeshLab

Volné polohování digitálních modelů – GOM Inspect

Nástroje pro polohování modelu jsou součástí nabídky Operations > Alignment > Single Element 
Transformation >…
Nástroje neumožňují volné polohování, jako je tomu u aplikace MeshLab, pro virtuální rekonstruk-
ci jsou velmi obtížně použitelné.

•	 Translate
Vektor posunu definujeme dvěma body, 
které umístíme na model kliknutím Ctrl + 
LMB. 

•	 Rotate
Rotaci definujeme úhlem otočení a osou, okolo které model rotujeme.

Editační programy nabízejí nástroje, 
které automaticky nebo polo-automatic-
ky zarovnávají modely na základě jejich 
tvarových podobností. Tyto nástroje 
mohou být využity pro superpozici 
polygonálních modelů, např. pro ilustraci 

2.4.4. Superpozice a spojování díl-
čích modelů tvarových rozdílů, nebo pro vzájemné 

zarovnání dílčích modelů, využitelné při 
tvorbě ucelených fotogrammetrických 
modelů. Polohování můžeme provést 
manuálně (viz kapitola 2.4.3.), v  případě, 
že se dílčí modely překrývají, je jedno-
dušší využít některý ze specializovaných 
nástrojů pro zarovnání sítí.

•	 Oba modely importujeme do programu
•	 Aktivujeme nástroj Align pro poloautomatické superponování polygonálních sítí. 
•	 V dialogovém okně nástroje Align jsou dva modely, stejně jako v Layer Dialog.
•	 Aktivujeme model, který chceme využít jako referenční, a klikneme na volbu Glue Here Mesh, 

tím polohu modelu zafixujeme.
•	 Označíme druhý model a klikneme na Point Based Glueing.

Zarovnání a spojení dílčích modelů – MeshLab
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Point Based Glueing slouží k  hrubé, základní superpozici sítí. Algoritmus je analogický 3-point 
Alignment sítí při laserovém skenování

•	 Na každý model umístíme postupně 3 body tak, aby odpovídající si body (stejné pořadí) byly 
na stejných místech. Body umisťujeme dvojitým kliknutím na model, špatně umístěné body 
odstraníme Ctrl + 2x LMB.

•	 Modely superponujeme volbou OK.
•	 V  dialogovém okně Align jsou referenč-

ní síť a sítě, které na ni byly superpo-
novány, označeny hvězdičkou. Pokud 
nejsme s  výsledkem manuální superpozi-
ce spokojeni, oddělíme superponovanou 
síť příkazem Unglue Mesh a superponová-
ní opakujeme.

•	 Druhou fází je automatické dorovnání super-
ponovaných sítí, které spustíme příkazem 
Process. Program automaticky najde největší shodu mezi oběma sítěmi a dokončí jejich super-
pozici. 
Po zarovnání je druhému modelu přiřazena roto-translační matice (viz 2.1.2.). Aby si model 
uchoval svoji novou orientaci, aplikujeme volbu Freeze Current Matrix a model exportujeme.
V této fázi tvar superponovaných sítí odpovídá tvaru modelovaného zubu, stále však jde o dvě 
izolované polygonální sítě, umístěné ve dvou souborech.

Digitální modely mohou mít informaci 
o barvě přiřazenou k  samotným prvkům 
polygonální sítě, vrcholům a polygonům, 
nebo mohou být propojeny s  externím 

2.5. Přenos barevné informace 
mezi modely

souborem, obsahujícím texturu. Aplikace 
pro editaci digitálních modelů nabízejí 
nástroje, za pomoci kterých lze barevnou 
informaci mezi texturou a prvky modelu 
přenášet.

Celý postup je velmi náchylný na padání programu. Na některých sestavách je nutné po každém 
kroku model exportovat a program restartovat.

•	 Do projektu importujeme model, na který chceme přenést barevnou informaci, a zdrojový 
model.

•	 Spustíme nástroj pro přenos barevné informace z textury na vrcholy - Filters > Texture >  Texture 
to Vertex Color...

Přenos barevné informace z textury na prvky polygonální sítě – MeshLab
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•	 Jako Source Mesh nastavíme „barevný“ 
model, jako Target Mesh zvolíme model bez 
barevné informace.

•	 Hodnotu Max. Dist Search necháme 
v  původním nastavení, nebo zvolíme 
hodnotu Perc např. 1

•	 Hodnota udává, v  jaké vzdálenosti od 
textury bude program hledat vertexy pro 
přenos barevné informace. 

•	 Barvu přeneseme volbou Apply
•	 Pokud přenášíme informaci z  více modelů, 

jako je tomu v případě modelového příkladu fotogrammetrického modelu zubu, celý proces 
opakujeme. Kvůli nestabilitě aplikace je dobré cílový model nejdříve exportovat, aplikaci restar-
tovat a celý proces opakovat s druhým zdrojovým modelem.
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Polygonální modely mohou být 
zkoumány prostřednictvím řady digitál-
ních nástrojů, které v  řadě ohledů 
přesahují možnosti nástrojů aplikovaných 
v reálném, fyzickém prostředí. Digitální 
nástroje umožňují nejen základní délková 
měření modelů, ale také přesné měření 
objemu objektů a obsahu jejich povrchu, 
neinvazivní tvorbu rovinných řezů, regis-
traci morfometrických dat a prezenta-
ci tvarových rozdílů mezi porovnávanými 
modely.

3. Analýza digitálních modelů

V současné době je volně dostupná řada 
aplikací nabízejících široké spektrum analy-
tických nástrojů. Následující text se zaměří 
na lineární měření modelů, vytváření 
rovinných řezů a registraci 3D souřadnic 
bodů ve freeware programech Landmark, 
MeshLab a GOM Inspect. Programy 
MeshLab a GOM Inspect  nabízejí vedle 
analytických nástrojů řadu nástrojů pro 
editaci povrchových modelů. Základy práce 
v  těchto aplikacích byly proto představe-
ny v  kapitole 2. Editace trojrozměrných 
modelů. Kapitolu uzavírá ukázka tvorby 

3.1. Aplikace pro analýzu 3D poly-
gonálních modelů

3.1.1. Landmark
Landmark je volně dostupnou aplikací 

pro editaci, analýzu a interpretaci morfo-
metrických dat. Aplikace umožňuje editaci 
bodů na povrchu digitálních modelů, 
export prostorových souřadnic těchto 
bodů a komparaci modelů na základě 
rozdílů v poloze definovaných bodů. Body 
jsou editovány jako tzv. primitives, tj. buď 
jako samostatné body, body rozmístě-
né na křivce nebo ploše nebo jako body 
definující vzdálenost.

Nativním formátem programu je 
soubor .land. Všechna importovaná  
a editovaná data jsou součástí souboru 
projektu. Aplikace umožňuje import 
modelů ve formátu .ply, a import prosto-
rových dat ve formátu NTS a pts. Ve 
stejných formátech mohou být souřadni-
ce význačných bodů exportovány.

Ke stažení je program na adrese - 
http://www.idav.ucdavis.edu/research/
EvoMorph

rovinných řezů v  programu Amira, který 
je dále představen v  kapitole věnované 
záznamu a zpracování objemových dat.
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Prostředí aplikace Landmark

Před editací musejí 
být importované 
modely nahrány 
příkazem Load into 
A, Load into B (v 
nabídce aktivované 
kliknutím RMB na 
model ve stromu 
projektu) do okna 
A nebo B.  

Editace primiti-
ves probíhá pouze  
v hlavním, největším 
náhledovém okně. 
Okna A a B maxima-
lizujeme kliknutím 
LMB na lišty 

Importovaná data jsou vypsána 
ve stromu projektu nalevo. 

Primitives
Všechny typy primitives se umisťují na povrch modelu příkazem Shift+LMB, stejnou kombinací 
mohou být prvky uchopeny (zvýrazní se žlutě) a přesunuty.

Editace různých typů primitives:

Body
Kliknutím Shift + LMB jsou body automaticky umístěny na povrch modelu  
a očíslovány podle pořadí. 
!!!Číslování začíná od 0!!!

Křivky 
Každá křivka je definována třemi body, které umisťujeme postupně na povrch 
modelu. Jednotlivé křivky na sebe můžeme navázat tím, že jako první bod 
křivky označíme poslední bod křivky předcházející.

Vzdálenosti
Vzdálenost je vždy definována dvěma body. Body mohou být nově umístěny 
nebo mohou být označeny už existující body.

Vlastnosti prvků mohou být editovány v dialogovém okně Edit primitives.
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Formáty NTS a pts

NTS
Soubor souřadnic, uvedený standardizo-
vanou hlavičkou:
1 data ve formě matice
1L – jeden objekt s popiskou
57 – počet souřadnic pro jeden objekt 
(počet bodů x dimenze)
1 – obsahuje chybějící data
9999 – označení chybějících dat
Dim=3 – trojrozměrné souřadnice

pts
Jednoduchý soubor obsahující pouze 
název prvků a souřadnice.

Import a zobrazení modelů v aplikaci Landmark

•	 Spustíme aplikaci a otevřeme nový projekt File > New, v dialo-
govém okně projekt pojmenujeme a zvolíme jeho umístění. 
Projekt spustíme stiskem Ok.

•	 Do projektu importujeme model ve formátu .ply volbou 
Project > Import (nebo File > Import > Into project).

•	 Importovaný model se pod svým názvem objeví ve stromu 
projektu nalevo.

•	 Prvním krokem je nahrání modelu do jednoho ze zobrazo-
vacích oken A nebo B příkazem Load into A, res. Load into B, 
z nabídky Project nebo z menu zobrazeném kliknutím RMB na 
název modelu. 

•	 Následně model zobrazíme v hlavním okně kliknutím LMB na 
záhlaví okna.

Postup exportu dat se u jednotlivých prvků mírně liší, je proto probrán pro každý typ 
prvků samostatně jako součást editačního postupu. 

K  měření vzdáleností na digitálních 
modelech slouží nástroje měřící přímou 
vzdálenost mezi definovanými body 
povrchu modelu, analogicky k dotykovým 
měřidlům. K měření projektivních měr je 

3.2. Měření lineárních vzdáleností potřeba využít specializovaných nástrojů, 
které promítají přímou vzdálenost na 
definovanou rovinu nebo simulují branže 
posuvného měřidla (obojí v  nabídce 
programu GOM Inspect). 
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•	 Model zobrazíme v hlavním okně.
•	 Aktivujeme nástroj Measurements 

Měření přímých vzdáleností – Landmark

•	 Příkazem Shift + LMB umístíme na model 
body definující vzdálenost. Pokud jsou 
na modelu umístěné samostatné body, 
můžeme je pro definování vzdálenosti použít.
Lineární vzdálenosti můžeme využít pro kalibraci importovaného modelu. V  prvním kroku 
definujeme známou vzdálenost. Otevřeme dialogové okno Edit primitives („Primitive type“ musí 
být nastaven na „Distance“) a do pole Actual measured distance vepíšeme reálnou hodnotu 
této vzdálenosti.

•	 Vzdálenosti jsou exportovány ve formě prostorových souřadnic definujících bodů prostřednic-
tvím okna Project > Export. (Soubory vzdáleností mají příponu .dims).

Aplikace nabízí jednoduchý nástroj pro měření vzdáleností, nástroj neumožňuje exportovat 
naměřenou hodnotu nebo projekt s definovanými vzdálenostmi uložit.

•	 Otevřeme projekt s importovaným modelem.
•	 Spustíme nástroj lineárního měření.

Měření přímých vzdáleností – MeshLab

•	 LMB umístíme první a druhý bod, definu-
jící vzdálenost. Aplikace následně zobrazí 
hodnotu vzdálenosti. 
Data se nikam neexportují a při opětovném 
použití zobrazená hodnota zmizí. 

Registrace polohy význačných bodů 
na digitálních povrchových modelech 
odpovídá digitalizaci význačných bodů 
na objektech dotykovým digitizérem. 
Výhodou digitálního prostředí je možnost 
uložit postup práce a dodatečně kontro-
lovat umístění bodů, stejně jako větší 

3.3. Registrace význačných bodů přístupnost různých struktur analyzova-
ného objektu. Nevýhodou je především 
horší lokalizace některých význačných 
bodů, v  závislosti na kvalitě/přítomnos-
ti textury a přesnosti modelu. Prvním 
krokem je umístění bodů na povrch digitál-
ního modelu, druhým export 3D souřadnic 
těchto bodů, obvykle v textovém formátu.
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•	 Model zobrazíme v  hlavním 
náhledovém okně.

•	 Na model umisťujeme jednotli-
vé význačné body stiskem Shift + 
LMB. Stejnou kombinací můžeme 
body uchopit a posunout po 
povrchu modelu. 
Body jsou automaticky číslovány 
od s00… 
Pokud bychom editovali body 
pro geometricko-morfometric-
ké analýzy, na více modelech, 
musíme vždy dodržet pořadí 
bodů!!!

•	 V dialogovém okně Edit Landmark 
Primitives můžeme jednotli-

Editace a export význačných bodů– Landmark

vé body pojmenovat (Annotation), změnit jejich pořadí (Re-order), případně body vymazat 
(Delete). Pro editaci bodů nastavíme Primitive type na Single Points.
Body můžeme také označit jako tzv. Missing data, takto označené body budou mít při exportu 
souřadnice „9999 9999 9999“. Tuto možnost můžeme využít například při registraci bodů pro 
geometricko-morfometrické analýzy. V  případě těchto analýz musí být na všech porovnáva-
ných objektech zaznamenán stejný počet bodů, ve stejném pořadí. Pokud nemůžeme na model 
některý bod umístit, např. z důvodu neúplnosti modelu, umístíme tento bod do jiného místa 
a po registraci bod označíme jako Missing, zachováme tak stejné pořadí a počet bodů u všech 
modelů.

•	 Spustíme dialogové okno exportu Project > Export
•	 Nastavíme formát exportního souboru. Pro export souřadnic bodů jsou určeny formáty .dta 

a .pts. Pokud projekt obsahuje více druhů Primitives, specifikujeme v okně Advanced options“ 
pouze Points. Volbu Use calibrate… necháme aktivovanou.

•	 V liště Into folder nastavíme adresář, do kterého budou soubory exportovány, a data exportu-
jeme volbou Ok.

•	 Program Landmark umožňuje importovat body uložené ve formátu .dta nebo .pts. Tuto funkci 
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můžeme například využít v případě, že chceme v programu Landmark pracovat s body, které 
jsme zaznamenali v  jiné aplikaci, například v programu MeshLab, který pracuje s barevnými 
modely. Body importujeme do programu příkazem File > Import > Into Project.

•	 Otevřeme projekt s modelem.
•	 Spustíme nástroj editace povrchových bodů 

Construct > Points > Point..

Editace a export význačných bodů– GOM Inspect

•	 Body umisťujeme na povrch modelu příkazem Ctrl + LMB. V dialogovém okně můžeme změnit 
jméno bodu. Vytvoření bodu potvrdíme příkazem Construct. 
Všechny definované prvky jsou součástí projektu a jsou uvedeny v seznamu Explorer jako tzv. 
Geometries…
Prostorové souřadnice všech prvků mohou být exportovány ve formátu CSV nebo ASCII 
příkazem File > Export > Geometry…

•	 V seznamu Explorer označíme body, které chceme exportovat nebo nadřazenou složku Points 
v případě, že chceme exportovat všechny body.

•	 Souřadnice bodů exportujeme přes dialogové okno File > Export > Geometry
Pokud nezměníme cílové umístění exportovaných dat, uloží se do složky Export, která je součástí 
projektu.

Formáty CSV a ASCII

CSV – tabulka s hlavičkou, názvy a souřad-
nicemi jednotlivých bodů, případně 
dalšími daty (např. normály)

ASCII – jednoduchý soubor obsahující 
pouze souřadnice bodů. Soubor je impor-
tovatelný do dalších aplikací
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Editace a export význačných bodů– MeshLab

Body editujeme za pomoci nástroje PickPoints. Nástroj pracuje s  předpřipravenými šablonami, 
do kterých jsou doplňovány souřadnice. Prvním krokem je příprava šablony s  konfigurací bodů, 
druhým pak samotná registrace polohy bodů.

•	 Otevřeme projekt s importovaným modelem.
•	 Spustíme nástroj PickPoints
•	 Volbou Add Point přidáme do šablony potřebný počet bodů, pro lepší přehled body pojmenu-

jeme.
•	 Vedle Add Point jsou v Template Controls umístěny také další nástroje pro ovládání šablony. 

Námi vytvořenou šablonu můžeme uložit pro pozdější použití volbou Save, dříve vytvořenou 
šablonu můžeme nahrát volbou Load. Volbou Clear šablonu kompletně vymažeme.
K editaci bodů, obsažených v šabloně, slouží 
nabídka pod seznamem bodů. Možností 
je body přejmenovat (Rename Point), 
odstranit body ze šablony (Remove Point), 
vymazat souřadnice bodu (Clear Point).

•	 V  dialogovém okně označíme první bod 
(kliknutím LMB) a určíme jeho polohu na 
modelu pravým tlačítkem myši. Pokračuje-
me v umístění všech bodů šablony, do dialo-
gového okna jsou automaticky zaznamená-
ny jejich souřadnice.
Špatně umístěný bod můžeme znovu zazna-
menat nebo využít volby Move Point, kdy 
s bodem můžeme při stisknutém RMB volně 
hýbat po povrchu modelu. 

•	 Šablonu se souřadnicemi uložíme příkazem 
Save.
Souřadnice jsou uloženy ve formátu .pp. 
Soubor může být otevřen např. v textovém editoru a souřadnice překopírovány do tabulky.

•	 Spustíme program a importujeme do něj 
model spodní čelisti přetažením souboru 
do okna Pool (vlevo) nebo přes příkaz Open 
data.
Datové moduly – modely, souřadnice, řezy 
atd. jsou v programu Amira zobrazeny zeleně.

•	 Kliknutím LMB aktivujeme model v  okně 
Pool a příkazem SurfaceView jej zobrazíme.
K modelu se připojí modul zobrazení (Surfa-
ceView). Zobrazení mají žlutou barvu.

•	 Vytvoříme datový modul, který bude 
obsahovat souřadnice registrovaných význač-
ných bodů – Create > Data > Landmarks
V  Pool se objeví nový zelený modul 
Landmarks, do kterého budou ukládány 
souřadnice bodů.

Editace a export význačných bodů– Amira
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Aplikace nabízejí řadu nástrojů pro 
tvorbu volně definovaných povrchových 
křivek a rovinných řezů, průsečíků modelů 
s  definovanými rovinami. Vytvořené 

3.4. Editace a export křivek křivky mohou být exportovány ve formě 
vektorů, častěji jsou však exportová-
ny a dále zpracovávány souřadnice bodů, 
kterými křivka prochází.

Program Landmark umožňuje editaci křivek za pomoci bodů umístěných na povrch modelu, 
křivka je body interpolována bez ohledu na polygonální síť modelu, kterou může volně procházet, 
nejedná se tedy o skutečnou povrchovou křivku.

Editace a export křivky – Landmark

•	 Editovaný model importujeme do programu a zobrazíme v hlavním editačním 
okně.

•	 Aktivujeme nástroj Curve. Základní křivky jsou v aplikaci Landmark definovány 
vždy třemi body, umisťovanými na povrch modelu příkazem Shift + LMB. Jednot-
livé křivky na sebe mohou být navázány (první bod křivky umístíme do posledního bodu křivky 
předcházející), stále se však jedná o samostatné křivky, samostatné Primitives, uvedené a edito-
vatelné v dialogovém okně Edit Landmark Primitives zvlášť.

Aplikace neumožňuje export křivek ve 
formátu vektorové grafiky, ale pouze ve 
formě souřadnic tzv. semi-landmarks, bodů, 
kterými křivka prochází. Počet semi-land-
marks se nastavuje v dialogovém okně Edit 
Landmark Primitives, volbou Semilandmark 
density (Primitive type musí být nastaven 
na Curves). Počet semi-landmarks nastavu-
jeme pro každou křivku zvlášť, ne pro celou 
spojitou křivku, body proto nejsou podél 
celé spojité křivky pravidelně rozmístěny.

•	 Souřadnice semi-landmarks exportujeme ve 
formátu .nts nebo .pts přes dialogové okno 
exportu (Project > Export). Pokud projekt 
obsahuje více druhů Primives, specifikuje-
me v okně Advanced Options prvek Curves. 

Editace a export křivky – GOM Inspect

•	 Otevřeme projekt a importujeme model.
•	 Spustíme nástroj pro konstrukci povrchových křivek (Construct > Curve >  Surface Curve…)
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•	 Umísťováním bodů na povrch modelu (Ctrl + LMB) editujeme průběh křivky. Pokud v průběhu 
editace křivky klikneme na její první bod, křivku uzavřeme. Vytvoření naeditované křivky 
potvrdíme volbou Ok.

Křivka je zařazena do seznamu Explorer, do 
oddílu Geometries > Surface Curves.
Na rozdíl od křivek editovaných v programu 
Landmark je výsledkem jediná povrchová 
křivka (a ne řetězec křivek), přesně kopíru-
jící povrch modelu.

Program exportuje křivky ve formě 
souřadnic velkého počtu bodů, kterými 
procházejí. Počet bodů, jejichž souřadni-
ce exportujeme je nastaven automaticky (v 
případě křivky editované na pánvi jde o ca 
500 bodů).

•	 Křivku, kterou chceme editovat, označíme v seznamu Explorer a spustíme dialogové okno pro 
export File > Export > Geometry… 

•	 V dialogovém okně nastavíme jméno souboru a jeho umístění, křivku exportujeme příkazem 
Export. 

Editace a export rovinných řezů – GOM Inspect

Program GOM Inspect umožňuje vytvářet rovinné řezy digitálními modely. Výsledkem je křivka 
odpovídající průsečíku polygonálního modelu a definované roviny.   
Vytvoření rovinného řezu probíhá ve dvou krocích. Prvním krokem je definování roviny řezu (v 
případě, že nechceme vést řez rovnoběžný s  rovinami souřadnicového systému), druhým pak 
vytvoření samotné křivky.
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•	 Otevřeme projekt a importujeme model.
•	 Spustíme nástroj vytvoření roviny za pomoci tří bodů (Construct > Plane >  3-Point plane…)
•	 Příkazem Ctrl + LMB umístíme na povrchu 

modelu 3 body, kterými bude rovina 
procházet.

•	 Rovinu vytvoříme příkazem Create.
Rovina je jedním z  geometrických prvků 
(stejně jako body). Vytvořené roviny jsou 
proto uvedeny v  seznamu Explorer jako 
Sections.

•	 Označíme část modelu, kterou chceme vést 
řez. V našem případě celý model.

•	 Spustíme nástroj pro vytvoření rovinného 
řezu (Construct > Section > Single Section…)

•	 V  dialogovém okně zvolíme za Reference 
plane námi definovanou plochu. 
Volba Position umožňuje posun plochy řezu 
vůči referenční ploše, v  našem případě 
ponecháme nastavení 0. Řez bude veden 
přímo námi definovanou plochou. 

•	 Rovinný řez vytvoříme příkazem Create.
Rovinné řezy jsou uvedeny v seznamu prvků Elements jako Sections.

•	 Křivku, kterou chceme editovat, označíme v seznamu Explorer a spustíme dialogové okno pro 
export File > Export > Geometry… 

•	 V dialogovém okně nastavíme jméno souboru a jeho umístění, křivku exportujeme příkazem 
Export. 
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•	 Spustíme program a importujeme do něj model dolní čelisti, kterou zobrazíme (viz kroky 1 a 2 
v předchozí podkapitole)

•	 LMB aktivujeme zobrazovací modul SurfaceView
•	 Kliknutím na červenou ikonu Cutting Plane aktivujeme nástroj pro tvorbu rovinných řezů.

Moduly nástrojů jsou zobrazeny červeně.

Editace a export rovinných řezů – Amira

•	 V režimu Interact nastavíme za pomoci 
ovladače rovinu řezu do požadované polohy. 
V našem případě tak, aby ležela v sagitální 
rovině. 

•	 Po nastavení správné polohy vytvoříme 
rovinný řez kliknutím LMB na ikonu Cut 
v  okně Properties (musí být aktivován 
modul CuttingPlane).
Příkazem je vytvořen datový modul 
rovinného řezu CuttingLine.

•	 Křivku exportujeme volbou Save Data As, která je dostupná v nabídce File (při aktivovaném 
datovém modulu CuttingLine) nebo v menu, které zobrazíme kliknutím RMB na datový modul 
křivky.
Program Amira umožňuje exportovat křivky ve formě vektoru (v exportním okně nastavíme 
formát dxf) nebo ve formě souřadnic velkého počtu bodů, kterými křivka prochází (v exportním 
okně nastavíme formát .lineset). 
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Formáty exportu křivek

Lineset – jednoduchý textový soubor 
obsahující hlavičku a souřadnice bodů 
ležících na křivce

DXF – formát obsahující křivku ve 
vektorové podobě, neredukovanou na 
body. Formát dxf být importován do celé 
řady aplikací pro editaci 3D dat, např. 
Rhinoceros.
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3D záznam a zpracování objemových dat

Martin Čuta
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4. Objemová data 
jsou informace z řady po sobě poříze-

ných záznamů – řezů – pozorované-
ho objektu.  Tyto informace jsou méně 
často získávány metodou sériové fotogra-
fie fyzických řezů objektem, nebo častěji 
pomocí pokročilých zobrazovacích metod 
(CT – počítačová tomografie, MRI – 
magnetická rezonance).  Surová pořízená 
objemová data tedy mají podobu na 
sebe navršených řezů. Ve většině zázna-
mových formátů (nejužívanější je formát 
záznamu medicínských dat DICOM) je 
sken opatřen doplňujícími informace-
mi (metadata – informace o paciento-
vi, datum pořízení, typ přístroje a další 
technické údaje).  Každý z řezů má určitou 
šířku a výšku, jeho plocha je rozdělena 
na pixely (stejně jako u digitální fotogra-
fie – pixel = picture element). Každý pixel 
má udané souřadnice x, y v karteziánské 
soustavě. V závislosti na typu a nastavení 
přístroje (pro příklad uveďme běžný 
medicínský CT přístroj), mají jednotlivé 
řezy různou vzdálenost od sebe (která 
určuje rozlišení) a tloušťku, která udává 
třetí rozměr (a výslednou souřadnici Z) 
v karteziánské soustavě. Takto vymezená 
jednotka je základní jednotkou třídimen-
zionálního zobrazení objemových dat – 
voxel.

Jak bylo uvedeno výše, objemová data 
mají podobu sériových řezů zkoumaným 
objektem. Tomografie je obecný název 
pro metody tvorby virtuální podoby 
objektu na základě řezů – „slice“ – jedná se  
o tenké řezy (planární rovinné podjed-
notky) hmotným objektem. 

4.1. Metody záznamu objemových 
dat

Pomocí výpočetní nebo také počíta-
čové tomografie (z  anglického názvu 
Computed Tomography) vytváříme 
kompletní zobrazení objemu snímaného 

4.1.1. Výpočetní tomografie

objektu z  velkého počtu sériových 
rentgenových snímků.  Metoda využívá 
adsorpce rentgenového paprsku vysíla-
ného pohybující se rentgenkou, což 
umožňuje záznam objektu z mnoha úhlů. 
Na základě slábnutí radiace dopada-
jící na senzory (díky jejímu pohlcová-
ní závislému na hustotě objektu – např. 
rozdílných tkání lidského těla) určuje 
složitý výpočtový algoritmus prosto-

Obr.23 Výpočetní tomograf

Obr. 24 Sériové snímky pořízené výpočetním tomo-
grafem
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rové uspořádání struktur adsorbují-
cích záření. Na množství takovýchto 
měření slábnutí záření závisí prostorové 
rozlišení každého nasnímaného obrazu.  
U současných medicínských CT přístrojů je 
maximální úroveň prostorového rozlišení 
0,6 mm – tedy každý nasnímaný obraz – 
řez – má tloušťku 0,6 mm. CT řezy slouží 
jako vstupní data pro skládání 3D modelu 
metodou segmentace a následné vykres-
lení 3D modelu – rendering (viz dále). 

4.1.1.1. Micro-CT (mikro-tomografie)
Tato zobrazovací metoda je princi-

piálně shodná s  medicínskou výpočetní 
tomografií (CT), ale poskytuje zobrazení 
ve vysokém rozlišení – v  řádech mikro-
metrů. Toto rozlišení hraničí se sférou 
jiné biomedicínské disciplíny – histologie. 
Získáváme tím možnost (do značné míry) 
pozorovat vše, co lze pozorovat na velmi 
tenkých mikroskopických řezech, avšak 
bez nutnosti objekt fyzicky řezat.

Obr. 25 Mikro-tomograf

4.1.2. Magnetická rezonance
Stejně jako v  případě výpočetní 

tomografie, magnetická rezonance 
(Magnetic resonance imaging – MRI) 
generuje objemová data v  podobě na 
sebe navršených paralelních řezů (zbarve-
ných v  odstínech šedé). Metoda pořizo-
vání záznamu je však podstatně odlišná 

– není využíván princip zobrazování 

pomocí ionizujícího záření, ale princip 
nukleární magnetické rezonance ve velmi 
silném magnetickém poli. Při medicín-
ském využití MRI je vzhledem k vysokému 
obsahu vody v  lidském těle využíváno 
rezonance jader vodíku (obsahujících 
jeden proton) v  magnetickém poli. Tato 
metoda je vhodná především pro zobra-
zování měkkých tkání (ze všech neinva-
zivních zobrazovacích metod poskytuje 
jejich nejkontrastnější vizi). Na výsledném 
zobrazení jsou od sebe jednotlivé tkáně 
zřetelně odlišeny, což je dáno rozdílnou 
odpovědí různých tkání na magnetic-
ké pole o stejné hodnotě (v závislosti na 
obsahu vody). 

Obr. 26 Přístroj pro vyšetření magnetickou rezonancí

Obr. 27 MRI snímek ramene
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Pokud máme k dispozici sérii fyzických 
řezů zkoumaným objektem (např. lidským 
tělem), je možné snímky použít jako 
zdrojová data pro skládání 3D podoby 
objektu. Digitální fotografie série řezů 
(případně digitalizované fotografie 
pořízené na kinofilm) lze po správném 
uspořádání do posloupnosti ve speci-
alizovaných programech segmentovat  
a následně vykreslit 3D virtuální 
(objemový) objekt. Rozlišení výsledné 
vizualizace objektu závisí na tloušťce 
fyzických řezů – viz obr. 29 (The Visible 
Human Project).

4.1.3. Sériová fotografie

Obr. 28 Fotografie řezu lidskou hlavou – The Visible 
Human Project

Obr. 29 Virtuální 3D model vytvořený na základě séri-
ových fotografií – The Visible Human Project

Post-processing neboli zpracování 
4.2. Zpracování obrazu

obrazu zahrnuje segmentaci – prahování 
pořízených snímků a následné vykreslo-
vání (rendering) virtuálního 3D objektu. 
Jedná se o postupy náročné na hardware 
i specializovaný software. Běžně jsou 
používány komerční programy Amira 
(zaměřením spíše pro biomedicínský 
výzkum) či Avizo (pro industriální výzkum 
a praxi). Alternativami jsou např. software 
3D Slicer či OsiriX.

Program Amira je profesionální komerční software umožňující zpracování primárně biome-
dicínských dat pro účely vědeckého bádání. Program je primárně koncipován pro konstrukce  
a rekonstrukce 3D objektů, jejich vizualizace, editaci a analýzy. Jedná se o velmi výkonný nástroj 
s širokou škálou možností – ať už se týká typů dat, která dokáže importovat (od fotografií, přes 
snímky z  CT, laserových či optických skenerů až po komplexní polygonální modely), nebo  
o typy přípravných datových operací, až po úpravu a analýzy hotových virtuálních modelů v 3D 
prostředí. V neposlední řadě nabízí řadu možností pro export modelů, od možnosti prohlížení  
v základním prohlížeči Adobe Acrobat Reader 9.0 a vyšší, po vytisknutí 3D objektu v 3D tiskárně 
(tzv. stereolitografie) (FEI, 2014).

Software Amira
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Orientace v pracovním prostředí software AMIRA verze 5.0.1

V základním prostředí programu se nachází čtyři podokna (každé z oken má libovolně nastavitel-
nou velikost – velikost je možné nastavit kliknutím na kraj okna a tahem myší do požadované 
vzdálenosti). 

•	 a) největší okno v základním nastavení programu představuje primární pracovní prostředí, ve 
kterém se zobrazuje a interaktivně manipuluje buď s 3D virtuálním modelem, nebo s 2D snímky 
(CT skeny, fotografie atd.). 
Primární okno lze přepínat do jednoduché-
ho, půleného či segmentárního uspořádání 
ikonami na liště vpravo nahoře. V  každém 
segmentu je možné zobrazit rozdílný pohled 
na model nebo snímky či simultánní pohledy 
na různá zobrazení základních dat. 

•	 Zcela vlevo na liště primárního pracovního okna se nachází manipulační nástroje. Šipka 
zastupuje nástroj Interact, který má využití např. při ořezu snímků či editaci.

•	 Nástroj Trackball otáčí celým virtuálním prostorem podle tří os (libovolně nastavitelných, viz 
dále). 
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•	 Nástroj Translate posouvá celým virtuálním modelem dle tří os. 
•	 Nástroj Zoom umožňuje přiblížení či oddálení prostoru. 
•	 Nástroj Rotate otáčí prostorem podle středu otáčení. 
•	 Nástroj Seek přiblíží označený bod. 
•	 Nástroj Home vrátí prostor do původní pozice, nástroj Set home umožní nastavení výchozí 

pozice. 

•	 Nástroj Perspective umožňuje přepínat mezi ortogonálním nastavením (2D pohled na objekt 
– projekce na rovinu obrazovky) a „3D“ prostorem, kdy je pomocí perspektivy (simulace 3D 
prostředí) dosaženo dojmu pohledu na reálný objekt – vzdálenější objekty jsou menší atd.

Následují ikony zastupují nástroje, které umožňují změnu orientace tří na sebe kolmých os  
a nástroje, které umožňují měření, tvorbu snímku pracovního okna (nejde o screenprint, program 
vytvoří a do souboru exportuje .jpg reprodukci s  vysokým rozlišením objektu v  primárním 
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pracovním okně, případně obraz lze odeslat přímo do tiskárny nebo do poznámkového bloku)  
a stereo zobrazení. Nejvíce vpravo se nachází ikony umožňující rozdělení pracovní plochy na více 
oken, ve kterých je možné zobrazovat data v různých projekcích.

•	 b) Vlevo od primárního pracovní-
ho okna se nachází Okno správce 
dat, které je možno zapnout ve třech 
módech v  závislosti na prováděné 
operaci. Mód Pool (aktivuje se 
kliknutím na ikonku Object Pool) 
zobrazuje probíhající projekty, prová-
zanost jednotlivých typů dat a prove-
dených kroků. Obecně platí – zelené 
ikonky označují datové soubory, 
červené provedené operace a žluté 
výsledná zobrazení. 

•	 V módu Pool otevíráme (nahráváme 
– Load) datové soubory kliknutím 
na ikonku Open Data. Otevře se 
navigační okno, ve kterém vybíráme 

•	 V  módu Pool se nacházejí ikonky jednotlivých datových souborů, jejich vzájemné provázání  
a navázání na provedené operace. Je možné se mezi jednotlivými kroky vracet, měnit a upravovat 
je, případně rušit provázání, mazat. Tyto změny však mohou měnit i navázané datové soubory 
či provedené operace. Každá ikonka v módu Pool je označena dvěma čtverečky; oranžová barva 
levého čtverečku značí, že je ikona aktivní (zobrazuje se), kliknutím na čtvereček ji můžeme 
deaktivovat. Pravý čtvereček umožňuje manipulaci s provázáním jednotlivých datových souborů 
a operací. Kliknutím na ikonu pravým tlačítkem myši se zobrazují dostupné operace, které je 
možno s daným souborem provést. Nejpodstatnější z těchto operací se zobrazují v příkazové 
liště okna Pool.

•	 Z dalších módů využijeme Segmentation Editor (zcela vpravo). Segmentation Editor umožňuje 
výběr a úpravu snímků pro tvorbu 3D modelu.

požadované soubory, které budou do programu nahrány.
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•	 c) Pod oknem správce dat se zobrazuje (v 
závislosti na zvoleném módu Správce či 
na dalších nastaveních) okénko Proper-
ties, které zobrazuje vlastnosti zvolených 
dat nebo zvolená nastavení prováděných 
pracovních kroků s možností jejich změny. 

•	 d) pod pracovním oknem se nachází okénko 
Console, ve kterém jsou v textovém formátu 
zaznamenány provedené kroky.

Formáty dat v SW AMIRA 
Amira dokáže otevírat širokou škálu vstupních 2D i 3D grafických dat. Provedené datové operace 
se ukládají do projektů s příponou .hx vlastní pouze pro SW AMIRA. Projekty načítají jak cestu  
k jednotlivým souborům dat různého formátu, které jsme otevřeli nebo vytvořili v rámci projektu, 
ale také jejich provázanost. Jednotlivé datové formáty jsou ještě ukládány samostatně (s příponou 

.am, labels.am, .surf podle formátu dat) a program při ukládání projektu vyžaduje také uložení 
jednotlivých datových souborů. 
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4.2.1. Segmentace (prahování)

Jedná se o proces, jehož pomocí speci-
alizovaný software (viz výše) virtuálně 
odlišuje konkrétní strukturu od struktur 
sousedících. Po segmentaci lze s  touto 
strukturou nakládat jako se samostat-
nou jednotkou. Např. software Amira 
nabízí škálu segmentačních nástrojů, 
které umožňují automatizaci procesu na 
všech načtených řezech v sérii či segmen-
taci manuální v  jednotlivých snímcích 
postupně. Manuální segmentace je 
z důvodu obrovského objemu dat většinou 
neproveditelná, a plně-automatická 
segmentace z důvodů velké diverzity tkání 
lidského těla (a velké rozmanitosti struktur 
kostní tkáně při zpracování snímků, např. 
lidského skeletu v  antropologicko-ar-
cheologickém kontextu, případně kostní 
tkáně v kombinaci s měkkými tkáněmi při 
zpracování snímků mumií anebo snímků 
tkání živého člověka) není ideální, nejčas-
těji pracujeme metodou tzv. semi-auto-
matické segmentace. Velmi zjednodu-
šeně se dá říci, že většina softwarových 
nástrojů provádí proces prahování na 
základě následujících základních principů: 
kontrastního a barevného rozdílu (na 
úrovni jednotlivých pixelů) mezi nasní-
manými strukturami – tzv. histogram 
(pixel)- based procedury; identifikova-
telných přechodů mezi objekty – tzv. 
edge-based procedury; tzv. region-ori-
ented procedury vyhledávají propojené 
objekty ve velkém množství obrazových 
prvků; dále existují tzv. model-based 
a texture-based procedury. V  praxi se 

v  programovém prostředí např. software 
Amira proces nastavení pracovního prahu 
podobá práci v obrazových editorech typu 
Photoshop: iteračním procesem pomocí 
posuvníků nastavíme práh kontrastu  
a jasu snímaných struktur tak, aby byly co 
nejlépe zřetelné, a na základě takto nasta-
veného prahu potom software pomocí 
segmentačních nástrojů vyhledává  
a označuje struktury (např. kost).

Segmentační editory umožňují 
prahování objektů, které jsou tvořeny 
pouze jedním typem tkáně (např. z  CT 
skenů lidských kosterních pozůstatků) 
nebo více typy tkání (např. z CT skenu 
mumie, nebo z  CT skenu či MRI snímků 
těla živého člověka). Možnosti prahování 
v  segmentačním editoru se liší podle 
technologie, kterou byly pořízeny sériové 
snímky. CT snímky těla živého člověka 
umožňují jednoznačné odlišení kosti  
a měkkých tkání. Měkké tkáně jsou však 
na snímku uniformní a neumožní odlišení 
jednotlivých struktur. Využití CT snímků 
je v  tomto případě vhodné například 
při vizualizaci či tvorbě modelu podoby 
obličeje konkrétního jedince v závislos-
ti na kostním podkladu. Pokud máme 
k  dispozici snímky pořízené metodou 
magnetické rezonance – MRI, umožní nám 
detailní vykreslení jednotlivých tkáňových 
struktur. Konkrétní struktury jsou od sebe 
jednoznačně odlišitelné, ale snímky (tkáně, 
mimo tkání s vysokým obsahem vody) jsou 
málo kontrastní.  Sériové snímky z  MRI 
přístroje jsou vhodné jako vstupní materiál 
pro vizualizaci konkrétních orgánů či 
tělesných struktur.

4.2.1.1. Praktická ukázka – segmentace na základě 2D zdrojových dat 
ve formátu DICOM (data z CT snímkování lebky – objekt tvořený jedním 
typem tkáně)

Segmentation editor aktivujeme pomocí ikony vpravo 
na liště Okna správce dat. Jedná se o prostředí, v němž 
pomocí operací podobných práci v  grafických progra-
mech vybíráme (označujeme) oblasti dat, které budou 
segmentovány a na jejichž základě bude tvořen virtuální 
3D model. 

Popis prostředí segmentačního editoru SW AMIRA
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V okně editoru existuje možnost přepínání mezi primárním oknem 
v jednoduchém či segmentárním uspořádání, tak jako v primárním 
pracovním prostředí. Kromě toho je možné klikáním na ikonu zastu-
pující jednoduché zobrazení přepínat mezi zobrazeními dat v základ-
ních anatomických rovinách (transverzální, sagitální a frontální) a konečně i náhledem na data 
v 3D zobrazení.

Pro operace výběru oblastí dat pro segmen-
taci se v Segmentation editoru nachází řada 
nástrojů. V  okně Zoom and Data Window 
pomocí posuvníků nastavujeme zvětšení 
a kontrast a světelnost snímku. Dále zde 
můžeme nastavovat různé filtry pro zvýraznění požadované oblasti.
V okně Selection se nacházejí nástroje pro 
přidání, mazání, odstranění a přecházení 
mezi vybranými oblastmi pro segmentaci 
a také se zde provádí vlastní segmentace.
V  okně Display and Masking vytváříme 
hranice prahu, na jehož základě bude 
vybrána oblast snímků pro segmenta-
ci. Práh vyhledává obrazové body, proto 
je důležité provést odpovídající přizpů-
sobení snímku v  okně Zoom and Data Window. Nastavení prahu provádíme opět pomocí 
posuvníků způsobem podobným práci v grafických programech. Můžeme si zde opět nastavit 
různé filtry pro zvýrazněné požadované oblasti, nastavujeme si zde také vykreslení osové 
mřížky v  3D náhledovém zobrazení a také 
pomocí 3D Volume rendering vykreslení 
vstupních dat bez označení jakékoli oblasti.
V nejspodnějším okně se nacházejí nástroje 
pro výběr požadované oblasti. Nachází se zde 
nástroje Pick and Move, Brush, Lasso, Magic 
Wand, Threshold a Blow Tool (viz dále).
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Segmentace v SW AMIRA – pracovní postup

•	 Spustíme program AMIRA, objeví se vstupní obrazovka, nejsou načtena žádná data.
•	 Klikneme na zelenou ikonku Open data vlevo v  módu Pool a z  umístění DICOM souboru jej 

označíme a zahájíme nahrávání (Load); objeví se okno pomocníka DICOM Loader s informace-
mi o názvu, počtu, povaze a zdroji dat; kliknutím na OK data nahrajeme. Může se objevit okno 
s informacemi o surových datech (necháme beze změn).

•	 Data se pod svým původním názvem (Lebka-Detkovice) objeví jako zelená (datová) ikonka 
v módu Pool. Kliknutím ikonku aktivujeme, objeví se okénko Properties (informace o vlastnos-
tech dat). 

•	 Na příkazové liště klikneme na ikonku Segmentation Editor.

•	 V řádku Image data se objeví Lebka-Detkovice, v řádku Label data je označeno None. Klikneme 
na New a vytvoří se soubor označených dat Lebka-Detkovice.Labels, se kterým dále pracujeme 
(a jehož ikona se objeví v okně Pool). V tabulce Materials se nachází jedna modalita – Exterior. 
Nejlépe je vytvořit New – kliknutím na toto tlačítko, vznikne Material 2. Můžeme si pro něj 
vybrat barvu dle libosti (tak, aby byla dobře zřetelná na CT snímcích). Zaškrtneme u něj okénka 
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2D i 3D (pro náhled v pracovním okně). Dále pracujeme s tímto Material 2 (lze libovolně pojme-
novat a zvolit jakoukoli barvu), označíme kliknutím na Select. 

•	 Jednotlivé CT řezy se objeví v pracovním okně, šipkou nahoru a dolů na klávesnici, kolečkem na 
myši, případně posuvníkem na dolním okraji pracovního okna mezi těmito snímky přepínáme. 
Zvětšení či zmenšení se provede v  okénku vlevo pod názvy dat – Zoom and Data Window 
(označeno lupou).

•	 V posuvné liště v tomto okně si posuvníky vhodně nastavíme jas a kontrast a zvýrazníme viditel-
nost oblasti, kterou budeme chtít segmentovat – CT řez kostmi lebky.

•	 V  nejspodnějším okénku s  grafickými symboly šipky, štětce atd. provádíme označení, výběr, 
oblastí na jednotlivých či všech snímcích, oblastí, které budou v posledním kroku segmentová-
ny. Máme na výběr dvě obecné možnosti – automatický výběr či manuální výběr (bližší popis  
v následujících rámečcích). Oba přístupy mají svoje výhody a nevýhody. Automatický přístup 
je výrazně méně časově náročný při velkém počtu nasnímaných obrazů. Kostní tkáň však na CT 
snímcích nevytváří homogenní stín, navíc je často přítomen rušivý šum a automaticky vybrané 
oblasti vyžadují manuální kontrolu a odstranění či úpravu. Manuální přístup je časově náročněj-
ší, ale vhodnější pro nehomogenní struktury; máme pod přímou kontrolou, která oblast bude 
vybrána pro následnou segmentaci.
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Pro automatický výběr lze využít dvou nástrojů, zřejmě nejvhodnější je pomocí nástroje Práh 
– Threshold (symbol sloupcového grafu). 

Automatický výběr struktur pro segmentaci

Pomocí manipulace s posuvníky 
v  okénku Display and Masking 
nastavíme (prahujeme) oblast, která 
bude automaticky vybrána pro segmen-
taci.
Při vhodně nastaveném prahu se zabarví oblast, kterou chceme označit pro segmentaci 
(kostní tkáň). Nástroj Threshold vybere všechny oblasti snímku, které odpovídají nastavené-
mu prahu. Tyto oblasti jsou při zaškrtnutní All Slices vybrány na všech snímcích po kliknutí na 
tlačítko Action: Select. 
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Pro automatický výběr je také vhodný nástroj 
Magic Wand. Od nástroje Threshold se 
při  automatickém výběru takřka neliší, rozdíl 
se projeví při manuálním výběru (viz dále). 
Zvolené oblasti jsou při zaškrtnutí All slices 
vybrány na všech snímcích.

Manuální výběr struktur pro segmentaci

Pro manuální výběr je možné využít následu-
jících nástrojů:
Nástroj Threshold používáme stejným 
způsobem jako u automatického výběru, 
pouze nezaškrtneme volbu All slices. 
V  daném snímku si nastavíme požadova-
né hodnoty prahu a kliknutím na Select 
označíme vybranou oblast pouze pro daný 
snímek. V následujícím snímku můžeme zvolit 
jiný práh vhodný pro tento snímek a označit 
oblast odlišně od snímku předchozího.
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Nástroj Magic Wand se od nástroje Threshold 
(v manuálním módu) liší pouze tím, že v  daném 
prahovaném rozsahu (dle nastavení obrazu pomocí 
posuvníků v  okénku Display and Masking) po 
kliknutí vybere ohraničenou oblast na snímku, která 
odpovídá zmíněnému prahu. Pokud jsou na snímku 
jasně ohraničené struktury, po kliknutí nástrojem 
do jedné struktury se (opět dle nastavení prahu) 
většinou označí pouze tato jedna struktura uvnitř prahové hranice. Více struktur je možné 
označit pomocí stlačení tlačítka Shift a kliknutí myši. Používáme stejným způsobem jako  
u automatického výběru, pouze nezaškrtneme volbu All slices. V daném snímku si nastavíme 
požadované hodnoty prahu a kliknutím myší označíme vybranou oblast pouze pro daný snímek. 
V  následujícím snímku můžeme zvolit jiný práh vhodný pro tento snímek a označit oblast 
odlišně od snímku předchozího. Jak bylo uvedeno výše, Magic Wand vybírá (dle nastavení 
prahu) jednotlivé od sebe více či méně izolované struktury a umožňuje lepší kontrolu nad 
vybíraným materiálem.

Nástroj Brush (štětec) po kliknutí „vybarvuje“ obtaženou oblast, je vhodný pro oblasti, které 
obtížně zachytíme plošným prahováním snímku. Nástroj umožňuje nastavení tvaru a velikosti 
kurzoru, který vybarvením vybírá požadovanou oblast.
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Nástroj Lasso umožňuje vyplnit obtaženou 
oblast, zvláště se zvoleným nastavením Auto 
trace vyhledává zřetelné kontury (dle nastavení 
posuvníků v  Zoom and Data window; výběr 
usměrňujeme postupným klikáním kotevních 
bodů) a kopíruje je. Je vhodný pro segmentaci 
např. dutin. Umožňuje i zcela manuální obkres-
lování. 

Nástroj Blow Tool expanzně vyplňuje oblast 
ohraničenou prahem, je vhodný pro segmen-
taci např. dutin. Nástroj umožňuje nastavení 

„tvrdosti“ a tolerance. 
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•	 Zkontrolujeme, zda jsou vybrány požadované struktury (poté, co máme zvoleny oblasti pro 
segmentaci). Máme několik možností – první možnost je postupným prohlížením jednotlivých 
snímků. 
Další možnost je pomocí živého 3D náhledu. Náhled se zobrazí poklikáním na ikoně pro 
přepínání mezi jednotlivými pohledy na snímky nebo simultánně při zobrazení více oken – 
viz kap. Popis prostředí segmentačního editoru. (Existuje možnost prohlížet snímky v „3D“ 
zobrazení, a to sice po kliknutí na třetí ikonku vpravo v  úrovni Display and Masking - 3D 
volume rendering). Živý náhled je orientační, ale může ukázat největší artefakty či nevybrané 
oblasti, které můžeme následně manuálně upravit. AMIRA dokáže (při aktivovaném 3D 
volume rendering) vytvořit 3D náhled i bez jakéhokoli vybraného materiálu. Vychází ze snímků  
a nastavení kontrastu v oblasti Data Window.
Třetí možnost je provedení segmentace a vygenerování vlastního 3D modelu (viz níže). Model 
je možné detailně prohlédnout a po návratu zpět do segmentačního editoru upravit oblasti 
vybrané pro segmentaci.
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•	 Předtím než přistoupíme k manuální opravě, je vhodné odstranit šum pomocí funkce Remove 
Islands (na liště nástrojů zcela nahoře, klikneme na Segmentation a Remove Islands). Zadáme 
velikost ostrůvků, Select a Remove. 

V  případě, že výše popsanými způsoby zjistíme nesprávně označené struktury, můžeme je 
odznačit. Buďto je možné odstranit celý snímek, nebo jen určité nesprávně označené oblasti na 
snímku – např. artefakty (většinou na nejkraniálnějších či nejkaudálnějších snímcích, které jsou 
způsobeny rozptylem paprsků). 

•	 Odstranění celého snímku – vrátíme se zpět do 
segmentačního editoru či do 2D náhledu v tomto 
editoru. Pomocí šipek, kolečka na myši či posuvníku 
na dolním okraji pracovního okna najedeme na 
snímek, který jsme v  náhledu zhodnotili jako 
nevhodný. Zaklikneme Current slice a kliknutím na tlačítko – (mínus) jej odznačíme. 
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•	 Odstranění označené oblasti snímku, kterou 
nechceme segmentovat (artefakty, šum) – 
po návratu zpět do segmentačního editoru 
v  daném snímku pomocí nástroje Brush 
(štětec) při stisknuté klávese Ctrl odznačíme 
oblast, která nebude segmentována.

•	 Vlastní segmentaci provádíme po výběru, 
kontrole a případném vyčištění oblastí 
zájmu. V  okně Selection zaškrtneme All 
slices a tlačítkem + řezy segmentujeme. 
Segmentované oblasti jsou označeny linkou 
v  barvě Materiálu, se kterým pracujeme 
(Material 2).
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•	 Uložíme přes možnost uložení – File – Save Network (program vyzve i k  uložení souboru 
s příponou labels.am, což potvrdíme). Ukládáme pokud možno průběžně.

•	 Klikneme na ikonu na příkazové liště zcela vlevo a přepneme 
zpět do okna Pool.

4.2.2. Rendering (vykreslování) 3D 
modelu

Prostorové informace o konkrétních 
strukturách obsažených v souboru objemo-
vých dat (na snímcích – řezech) vybrané 
pomocí procesu prahování lze spojit a 
vykreslit virtuální model zobrazovaného 
objektu. Výsledný model je třídimenzionál-
ním popisem objektu a obsahuje informace 
o geometrii, úhlu pohledu, textuře, barvě a 
osvětlení. K dosažení výsledku je využívána 
celá řada postupů (např. rastrování, 
stínování, texturování atd.). V závislosti na 
tom, zda chceme zobrazit povrch či vztah 
vnitřních a překrývajících se struktur nebo 
rozdíly v hustotě tkáně, máme dvě základní 
vstupní volby – povrchové vykreslování 
(surface rendering) a objemové vykreslová-
ní (volume rendering). 

Povrchové vykreslování (rozumějme 
– na základě objemových dat) je většinou 
generováno ve formě isosurface, povrchu 
představujícího body se shodnými charak-
teristikami. U CT nebo MRI skenů se jedná 
o voxely, které se pohybují v  definova-
ném prahu stupňů šedi. Výsledný povrch 
se skládá z  polygonů, ve většině případů 
trojúhelníkových políček. Body, ve kterých 
se polygony stýkají, se nazývají vrcholy 
(vertex). 

Při objemovém vykreslování jsou 
hodnoty šedi jednotlivých voxelů odstup-
ňovány v  závislosti na hustotě tkáně. 
Podle tmavosti či světlosti konkrétních 
oblastí jednolitého objektu lze „vidět 

Obr. 30 3D model lebky vykreslený metodou povr-
chového vykreslování
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dovnitř“ a při převedení na barevné 
schéma umožňuje rozpoznávat překrýva-

jící se struktury či neočekávané zásahy do 
tkáně (např. novotvary).

4.2.2.1. Praktická ukázka – vykreslování modelu ze segmentovaných dat 
(data z CT snímkování lebky – objekt tvořený jedním typem tkáně)

•	 V okně Pool klikneme na soubor –„labels.am“, obsahující data segmentované lebky (z předchozí 
praktické ukázky); zobrazí se možnosti dalšího zpracování; pro spíše náhledové zobrazení 3D 
modelu vygenerujeme Isosurface. V  okénku Properties jsou možnosti úprav, které prozatím 
nevyužijeme, klikneme na Apply. V pracovním oknu se zobrazí vygenerovaný povrch.

•	 Segmentované struktury v souboru „labels.am“ umožňují i komplexnější vykreslení 3D modelu 
pomocí volby SurfaceGen. V okénku Properties zaškrtneme volbu None u Smoothing (vyhlazení), 
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tedy žádné vyhlazení (vyhlazování snižuje rozlišení modelu), klikneme na Apply a vytvoříme 
soubor s příponou .surf. Na tuto ikonu klikneme a zobrazí se možnosti dalšího postupu. Zvolíme 
SurfaceView. V pracovním okně se zobrazí 3D model vytvořený na základě segmentace objemo-
vých dat. 



117

Postup segmentace při tvorbě 3D modelu na základě CT snímků živého člověka se od segmentace 
snímků kosterních pozůstatků liší jen v detailech.
•	 Po načtení dat do pracovního prostředí softwaru Amira je pro úspěch dalšího postupu potřeba 

vytvořit v  segmentačním editoru samostatné soubory (labels) pro každý typ tkáně, který 
chceme segmentovat. V našem případě se jedná o dva soubory, jeden pro kostní tkáň, druhý 
pro zbývající (měkké) tkáně. Jednotlivé typy měkkých tkání od sebe na CT snímcích nejsou 
odlišitelné.

4.2.2.2. Praktická ukázka – specifika při segmentaci a vykreslování  
virtuálního modelu na základě dat z CT snímkování lidské hlavy – objekt 
tvořený více typy tkání
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•	 Postup prahování je shodný s postupem popsaným výše; vhodná je kombinace automatických 
či poloautomatických nástrojů s následnými manuálními úpravami.

•	 Rendering – vykreslení segmentovaných struktur je též shodné s  výše popsaným postupem. 
Pro každý z vygenerovaných souborů „labels“ vytvoříme vlastní 3D model (funkcí IsoSurface či 
SurfaceGen-SurfaceView; pro soubor „labels“ obsahující měkké tkáně zvolíme při generování 
modelu možnost „Transparent“ v políčku Draw Style) a v prostředí Pool obě vykreslení aktivu-
jeme.

Transparent

Dojde k  jejich překrytí a lze např. 
sledovat souvislost podoby obličeje 
s reliéfem skeletu splanchnokrania. 
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4.2.2.3. Praktická ukázka – specifika při segmentaci a vykreslování  
virtuálního modelu na základě dat z MRI snímkování lidské hlavy – 
objekt tvořený více typy tkání
Sériové snímky pořízené metodou magnetické rezonance poskytují detailní zobrazení jednotlivých 
tkáňových struktur, přičemž konkrétní struktury jsou od sebe jednoznačně odlišitelné. Pro postup 
prahování však představují jednu nevýhodu – nízká kontrastnost snímků (kromě tkání s vysokým 
obsahem vody) výrazně snižuje možnost využití plně automatického postupu prahování, což 
zvyšuje časovou náročnost přípravy modelu. Vysoká schopnost odlišení jednotlivých tkáňových 
struktur od sebe je výhodná zvláště při vizualizaci či tvorbě modelu konkrétního orgánu či jeho 
části. 
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•	 Postup segmentace při tvorbě 3D modelu na základě MRI snímků živého člověka se od segmen-
tace snímků kosterních pozůstatků liší jen v detailech, zvláště pak ve zvýšeném podílu manuální 
práce při prahování.

•	 Po načtení dat do pracovního prostředí SW Amira je pro úspěch dalšího postupu potřeba 
vytvořit v segmentačním editoru tolik samostatných souborů (labels), kolik typů tkáně chceme 
segmentovat. Postup prahování je shodný s postupem popsaným výše; vhodná je kombinace 
automatické segmentace s následným manuálním odstraněním struktur, které si ve výsledném 
souboru (labels) nepřejeme.

•	 Kromě izolovaných orgánů je možné segmentovat i komplexní objekt (lidskou hlavu) se všemi 
zobrazenými útvary. Takový model může mít využití při vizualizaci topografických vztahů.
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Publikace Záznam a analýza digitálních dat v antropologii se zabývá pro-
blematikou digitálního záznamu povrchových i objemových dat biologic-
kých i nebiologických objektů, tvorbou a editací digitálních 3D modelů a 
jejich základní analýzou.
Jedná se o praktického průvodce světem virtuální antropologie s konkrét-
ními příklady aplikace na kosterní pozůstatky, živého člověka i artefakty. 
Publikace vznikla s podporou projektu OPVK FITEAMP v Laboratoři morfo-
logie a forenzní antropologie (LAMORFA), která je součástí Ústavu antro-
pologie PřF MU.
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